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Reconstructor® 4.4 Manual
 Last edit: 2023/01/24

Reconstructor® is a software to combine 3D information from different sensors, prepare
intermediate representations and extract information. The main advantage is the independency
from a specific sensor and the comprehensive amount of tools and features that enable easy
extraction of quality results in many fields: mining, surveying, construction, architecture, cultural
heritage, forensics, BIM, tunneling, etc.

1. Reconstructor® imports all the most used laser scanner formats in the market. The workflow
begins with the LineUp® wizard that easily allows you to import, pre-process,
and automatically register any amount of data with state-of-the-art speed and precision. 

2. After that, your data are processed enough to easily extract results: basic measures and
notes, elevations and plans, cross sections, areas and volumes, geometrical check and
change detection, tunnel analyses, flythrough videos, and so on.

3. Furthermore, Reconstructor® has all the features needed to deliver more elaborated
results: tools for models positioning, editing of point clouds, fitting of geometric
primitives, model filtering and clustering, meshing, mesh editing, coloring with calibrated
photos, UAV images processing, etc.

Please click on one of the following sub-topics to proceed:

 Contents
 System Requirements
 Installation
 Licensing
 Disclaimer
 Stonex End User License and Maintenance Agreement
 Getting Started
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The following conventions have been used in this manual:
 Main processes and parameters will be bold 
 Commands will appear in italic, during explanations
 Clickable links will be blue colored. Use these links to consult other items in the manual or

external links.

   This icon indicates an important tip for you

 Pay attention to this information/suggestion

Reconstructor® is developed by GEXCEL

www.gexcel.it
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Contents

The present on-line help is organized as follows: 

i. An introduction about  the installation and the applying license procedures of the software 

ii. A Getting Started section to easily learn how to work with  Reconstructor®  and the main features
of its user interface.

iii.  An explanation of the functionalities of  Reconstructor®, according to the voices in the menu bar. 
These are therefore the main chapters of this section:

 File
 Navigation
 Data management
 Results & analyses
 Special tools
 Windows
 Add-ons
 Help

Note: some commands are not available in all software configuration, pay attention to your
license!
The Reconstructor® Viewer has only a few commands active, all of them are included in
Reconstructor®.

You can find all the Reconstructor® commands according to your active license in the Command
Dashboard (Ctrl+d).

See Help menu -> License Manager

In Add-ons menu you can chose Add-ons functionalities according to your license.
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Web references
Reconstructor® page in Stonex website.

https://www.stonex.it/project/reconstructor/
https://gexcel.it/it/SOFTWARE/reconstructor
https://www.stonex.it
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Reconstructor® System requirements

Minimal Requirements

 Processor: 64 bit x86_64 CPU
 Main memory (RAM): 8 GB
 Graphics card that supports OpenGL 3.3 with an up to date driver, still within its vendor's

support lifecycle
 Windows 10 or Windows 11
 Mouse with two buttons plus a clickable scroll wheel
 Screen resolution: 1440x960 or higher (see "Display scaling" below)

On computers with the minimal requirements, Reconstructor® will be able to work on projects with
limited amount of point clouds or meshes.
Compatibility with hardware, drivers or operating system software that is no longer actively
supported by its vendor cannot be guaranteed.

Recommended Requirements

 AMD Ryzen 7/Ryzen 9 or Intel Core i7/ Core i9/Xeon or equivalent, 4 or more physical cores,
on a single CPU socket (see "Multi-socket processors support" below)

 Main memory (RAM): 32 GB
 Graphics card that supports OpenGL 4.0 or higher, 6 GB dedicated GPU memory, single GPU,

with an up to date driver, still within its vendor's support lifecycle [1]

 Windows 10 or Windows 11
 Mouse with two buttons plus a clickable scroll wheel
 Screen resolution: 1920x1080 or higher (see "Display scaling" below)
 Hard disk: SSD or RAID10 HDD array, for optimal data read/write performance

MULTI-SOCKET PROCESSORS SUPPORT

Generally speaking, the more physical cores your processor has, the faster Reconstructor® runs.
However, this only applies to cores physically located on a single processor.
Systems with multiple processor socket, have dedicated RAM memory slots for each processor
socket or group of sockets (this is called a node). Access from a processor to its dedicated RAM is
fast, while access to the RAM dedicated to another node is slower. This type of architecture is called
NUMA (Non Uniform Memory Access).

Compatibility check
To verify how many NUMA nodes your system has, download the free Reconstructor Viewer, open
it, and select Help -> Hardware Info from the top menu. A dialog pops up with information about
your graphics card and your processor. Make sure that the value "Number of NUMA nodes" is 1.
The use of Reconstructor on systems with more than 1 NUMA node causes a notable slowdown with
most operations that rely on fast access to large amounts of data (importing scans, pre-processing,
etc).
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Workaround for unsupported multi-socket processors
When running on systems where the NUMA architecture cannot be disabled from the system BIOS,
it is possible to configure Reconstructor's thread affinity from the Windows Task Manager to run on
the cores of a single processor.
Using less cores with fast memory access is preferable to using more cores with slower memory
access.

Display scaling
Some displays have a high pixel density and require scaling for optimal visualization.
In such cases, the amount of usable logical screen space is calculated by dividing the physical display
resolution by the scaling factor.
For example, a 1920x1080 FHD 15.6" display with a 125% scaling factor has a logical resolution of
1920 / 1.25 x 1080 / 1.25 = 1536x864 pixels.

[1] GRAPHIC CARD SETTING FOR RECONSTRUCTOR
If your PC has more than one graphic card (i.e. integrated and dedicated graphic card) combine the
software with the better graphic card by using its control panel. Remember to update the graphic
card drivers before to installing Reconstructor®.

 See Cpu known issues chapter for details on CPU compatibility.

Reconstructor - CPU known issues

Systems with multiple sockets:
 NUMA is enforced by the hardware (each CPU socket is physically connected to a separate

memory controller, and inter-CPU memory access is possible but highly penalized.
 Not much can be done, other than set Rec affinity to a single NUMA node, and only use the cores

that belong to said node (minimal changes to our multithreading core count detection are
required).

 Using multiple CPUs (multiple NUMA nodes) efficiently would require changes to the
implementation of our algorithms, to be aware of that.

Systems with only one socket:
 Certain somewhat recent Xeon CPUs allow the creation of virtual NUMA nodes (clusters of

cores) within the same die.
 In some cases this is purely virtual, and can be disabled at the BIOS level. In some other cases

this is tied to the physical architecture of the die, and while it may be possible to disable it at the
BIOS level, it might or might not yield benefits to Rec (this would need to be tested with one such
computer, benchmarked under different configurations)

Known issues

Processors by family

Cannon Lake (2018)
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Mobile

Family Cores Models Known issues

Core i3 2/4 i3-8121U Low-end[1][2]

Whiskey Lake (2018)

Mobile

Family Cores Models Known issues

Core i7 4/8 i7-8565U

Core i5 4/8 i5-8265U Low-end[1]

Core i3 2/4 i5-8145U Low-end[1][2]

Coffee Lake (2017-2018)

Desktop

Family Cores Models Known issues

Core i7 6/12 i7-8086K, i7-8700K, i7-8700, i7-
8700T

Core i5 6
i5-8600K, i5-8600, i5-8500, i5-
8400, i5-8600T, i5-8500T, i5-
8400T

Low-end[1]

Core i3 4 i3-8350K, i3-8300, i3-8100, i3-
8300T, i3-8100T

Low-end[1]

Pentium Gold 2/4 G56##, G55##, G54##,
G55##T, G54##T

Low-end[1][2]

Celeron 2 G49##, G49##T Low-end[1][2]

Workstation
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Family Cores Models Known issues

Xeon E 6/12 E-2186G, E-2176G, E-2136

Xeon E 6 E-2126G

Xeon E 4/8 E-2174G, E-2144G, E-2134

Xeon E 4 E-2124G, E-2124

Mobile

Family Cores Models Known issues

Xeon E 6/12 E-2186M, E-2167M

Core i9 6/12 i9-8950HK

Core i7 6/12 i7-8850H, i7-8750H, i7-8700B

Core i7 4/8 i7-8559U

Core i5 6 i5-8500B, i5-8400B Low-end[1]

Core i5 4/8 i5-8400H, i5-8300H, i5-8269U,
i5-8259U

Low-end[1]

Core i3 4 i3-8100H Low-end[1]

Core i3 2/4 i3-8109U Low-end[1][2]

Desktop

Family Cores Models Known issues

Core i9 8/16 i9-9900K

Core i7 8 i7-9700K

Core i5 6 i5-9600K Low-end[1]
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Kaby Lake (2016-2017)

Desktop

Family Cores Models Known issues

Core i7 4/8 i7-77##X, i7-77##K, i7-77##, i7-
77##T

Core i5 4
i5-76##X, i5-76##K, i5-76##, i5-
75##, i5-74##, i5-76##T, i5-
75##T, i5-74##T

Low-end[1]

Core i3 2/4
i3-73##K, i3-73##, i3-71##, i3-
73##T, i3-71##T, i3-71##TE, i3-
71##E

Low-end[1][2]

Pentium 2/4 G46##, G45##, G46##T,
G45##T

Low-end[1][2]

Celeron 2 G39##, G39##T Low-end[1][2]

Mobile

Family Cores Models Known issues

Xeon E3 4/8 E3-1535M, E3-1505M

Core i7 4/8
i7-8809G, i7-8709G, i7-79##HQ,
i7-78##HQ, i7-78##HK, i7-
77##HQ, i7-8650U, i7-55##U

Core i7 2/4 i7-76##U, i7-75##U, 7Y7#, i7-
8500Y

Low-end[2]

Core i5 4/8 i5-8305G, i5-8350U, i5-8250U Low-end[1]

Core i5 4 i5-74##HQ, i5-73##HQ Low-end[1]

Core i5 2/4 i5-73##U, i5-72##U, 7Y5#, i5-
8210Y, i5-8200Y

Low-end[1][2]
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Core i3 2/4 i3-71##H, i3-8130U, i3-71##U Low-end[1][2]

Core m3 2/4 7Y3#, 8100Y Low-end[1][2]

Pentium 2/4 44##U, 44##Y Low-end[1][2]

Celeron 2 39##U, 38##U Low-end[1][2]

Server

Family Cores Models Known issues

Xeon E3 4/8
E3-1285v6, E3-1280v6, E3-
1275v6, E3-1270v6, E3-1245v6,
E3-1240v6, E3-1230v6

Xeon E3 4 E3-1225v6, E3-1220v6

Xeon E3
(embedded)

4/8 E3-1505Lv6

Skylake (2015)

Desktop

Family Cores Models Known issues

Core i9 18/36 i9-7980XE, i9-9980XE NUMA[4]; CoD[5];
Memory controller[6]

Core i9 16/32 i9-7960X, i9-9960X NUMA[4]; CoD[5];
Memory controller[6]

Core i9 14/28 i9-7940X, i9-9940X NUMA[4]; CoD[5];
Memory controller[6]

Core i9 12/24 i9-7920X, i9-9920X NUMA[4]; CoD[5]

Core i9 10/20 i9-7900X, i9-9900X, i9-9820X NUMA[4]; CoD[5]

Core i7 8/16 i7-7820X, i7-9800X
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Core i7 6/12 i7-7800X

Core i7 4/8 i7-67##K, i7-67##R, i7-67##,
i7-67##T

Core i5 4

i5-66##K, i5-66##R, i5-65##R,
i5-66##, i5-65##, i5-64##, i5-
66##T, i5-65##T, i5-64##T, i5-
64##P

Low-end[1]

Core i3 2/4 i3-63##, i3-61##, i3-63##T, i3-
61##T, i3-60##P

Low-end[1][2]

Pentium 2 G45##, G44##, G45##T,
G44##T, G44##TE

Low-end[1][2]

Celeron 2 G39##, G39##TE, G39##T Low-end[1][2]

Mobile

Family Cores Models Known issues

Xeon E3 4/8 E3-1575Mv5, E3-1545Mv5, E3-
1535Mv5, E3-1505Mv5

Core i7 4/8 i7-69##HQ, i7-68##HQ, i7-
68##HK, i7-67##HQ

Core i7 2/4 i7-66##U, i7-65##U Low-end[2]

Core i5 4 i5-64##HQ, i6-63##HQ Low-end[1]

Core i5 2/4 i5-63##U, i5-62##U Low-end[1][2]

Core i3 2/4 i3-61##U, i3-60##U, i3-61##H Low-end[1][2]

Core m7 2/4 6Y7# Low-end[1][2]

Core m5 2/4 6Y5# Low-end[1][2]

Core m3 2/4 6Y3# Low-end[1][2]

Pentium 2/4 44##U, 44##Y Low-end[1][2]
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Celeron 2 G39##E, 39##U Low-end[1][2]

Workstation

Family Cores Models Known issues

Xeon W 18/36 W-2195 NUMA[4]; CoD[5];
Memory controller[6]

Xeon W 14/28 W-2175 NUMA[4]; CoD[5];
Memory controller[6]

Xeon W 10/20 W-2150B, W-2155 NUMA[4]; CoD[5]

Xeon W 8/16 W-2140B, W-2145

Xeon W 6/12 W-2133, W-2135

Xeon W 4/8 W-2123, W-2125

Xeon W 4 W-2102, W-2104

Server

Family Cores Models Known issues

Xeon
Platinum

28/56 8180, 8180M, 8176, 8176F,
8176M, 8173M

Multi-CPU[3]; NUMA[4];
Memory Controller[6]

Xeon
Platinum

26/52 8170, 8170M, 8164, 8167M Multi-CPU[3]; NUMA[4];
Memory Controller[6]

Xeon
Platinum

24/48 8168, 8163, 8160, 8160F,
8160M, 8160T

Multi-CPU[3]; NUMA[4];
Memory Controller[6]

Xeon Gold 22/44 6161, 6152 Multi-CPU[3]; NUMA[4];
Memory Controller[6]

Xeon Gold 20/40 6148, 6148F, 6145, 6138,
6138T, 6138F

Multi-CPU[3]; NUMA[4];
Memory Controller[6]

Xeon Gold 18/36 6154, 6150, 6140, 6140M Multi-CPU[3]; NUMA[4];
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Memory Controller[6]

Xeon
Platinum

16/32 8153 Multi-CPU[3]; NUMA[4];
Memory Controller[6]

Xeon Gold 16/32 6142, 6142F, 6142M, 6130,
6130F, 6130T

Multi-CPU[3]; NUMA[4];
Memory Controller[6]

Xeon Gold 14/28 6132 Multi-CPU[3]; NUMA[4];
Memory Controller[6]

Xeon Gold 14/28 5120, 5120T, 5119T, 5117,
5117F

Multi-CPU[3]; NUMA[4];
Memory Controller[6]

Xeon
Platinum

12/24 8158 Multi-CPU[3]; NUMA[4]

Xeon Gold 12/24 6146, 6136, 6126, 6126F,
6126T

Multi-CPU[3]; NUMA[4]

Xeon Gold 12/24 5118 Multi-CPU[3]; NUMA[4]

Xeon Silver 12/24 4116, 4116T Multi-CPU[3]; NUMA[4]

Xeon Gold 10/20 5115 Multi-CPU[3]; NUMA[4]

Xeon Silver 10/20 4114, 4114T Multi-CPU[3]; NUMA[4]

Xeon Gold 8/16 6144, 6134, 6134M Multi-CPU[3]; NUMA[4]

Xeon Silver 8/16 4110, 4109T, 4108 Multi-CPU[3]; NUMA[4]

Xeon Gold 6/12 6128 Multi-CPU[3]; NUMA[4]

Xeon Bronze 8 3106 Multi-CPU[3]; NUMA[4]

Xeon
Platinum

4/8 8156 Multi-CPU[3]; NUMA[4]

Xeon Gold 4/8 5122 Multi-CPU[3]; NUMA[4]

Xeon Silver 4/8 4112 Multi-CPU[3]; NUMA[4]

Xeon Bronze 6 3104 Multi-CPU[3]; NUMA[4]

Xeon E3 4/8 E3-1280v5, E3-1275v5, E3-
1270v5, E3-1260v5, E3-1245v5,
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E3-1240v5, E3-1240Lv5, E3-
1230v5

Xeon E3
(embedded)

4/8 E3-1505Lv5

Xeon E3 4 E3-1235Lv5, E3-1225v5, E3-
1220v5

Broadwell (2014-2015)

Desktop

Family Cores Models Known issues

Core i7 10 i7-69##X NUMA[4]; CoD[5]

Core i7 8 i7-69##K

Core i7 6 i7-68##K

Core i7 4/8 i7-57##C

Core i5 4 i5-56##C Low-end[1]

Embedded

Family Cores Models Known issues

Core i7 4/8 i7-57##R

Core i5 4 i5-56##R, i5-55##R Low-end[1]

Mobile

Family Cores Models Known issues

Core i7 4/8 i7-59##HQ, i7-58##HQ, i7-
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57##HQ

Core i7 2/4 i7-56##U, i7-55##U Low-end[2]

Core i5 2/4 i5-53##H, i5-53##U, i5-52##U Low-end[1][2]

Core i3 2/4 i3-51##U, i3-50##U Low-end[1][2]

Pentium 2/4 382#U Low-end[1][2]

Core M 2/4 5Y## Low-end[1][2]

Pentium 2 380#U Low-end[1][2]

Celeron 2 37##U, 32##U Low-end[1][2]

Server

Family Cores Models Known issues

Xeon E5 22/44 E5-2699v4
Multi-CPU[3]; NUMA[4];
CoD[5]; Memory
controller[6]

Xeon E5 20/40 E5-2698v4
Multi-CPU[3]; NUMA[4];
CoD[5]; Memory
controller[6]

Xeon E5 18/36 E5-2697v4, E5-2695v4
Multi-CPU[3]; NUMA[4];
CoD[5]; Memory
controller[6]

Xeon E5 16/32 E5-2697Av4, E5-2683v4
Multi-CPU[3]; NUMA[4];
CoD[5]; Memory
controller[6]

Xeon E5 14/28
E5-2690v4, E5-2680v4, E5-
2660v4, E5-2658v4, E5-
2650Lv4, E5-2648Lv4

Multi-CPU[3]; NUMA[4];
CoD[5]; Memory
controller[6]

Xeon E5 12/24 E5-2687Wv4, E5-2650v4, E5-
2628Lv4

Multi-CPU[3]; NUMA[4];
CoD[5]

Xeon E5 10/20 E5-2689v4, E5-2640v4, E5-
2630v4, E5-2630Lv4, E5-

Multi-CPU[3]; NUMA[4];
CoD[5]
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2618Lv4

Xeon E5 8/16 E5-2667v4, E5-2620v4, E5-
2608Lv4

Multi-CPU[3]; NUMA[4]

Xeon E5 8 E5-2609v4 Multi-CPU[3]; NUMA[4]

Xeon E5 6/12 E5-2643v4 Multi-CPU[3]; NUMA[4]

Xeon E5 6 E5-2603v4 Multi-CPU[3]; NUMA[4]

Xeon E5 4/8 E5-2637v4, E5-2623v4 Multi-CPU[3]; NUMA[4]

Xeon E5 8/16 E5-1680v4, E5-1660v4 NUMA[4]; CoD[5]

Xeon E5 6/12 E5-1650v4 NUMA[4]; CoD[5]

Xeon E5 4/8 E5-1630v4, E5-1620v4 NUMA[4]; CoD[5]

Xeon E3 4/8 E3-1285v4, E3-1285Lv4, E3-
1265Lv4

Xeon E3 4/8 E3-1284Lv4, E3-1278Lv4, E3-
1258Lv4

Xeon D 16/32 D-1587, D-1577, D-1571
Low-end[1]; NUMA[4];
CoD[5]; Memory
Controller[6]

Xeon D 12/24 D-1567, D-1559, D-1557 Low-end[1]; NUMA[4];
CoD[5]

Xeon D 8/16 D-1553N, D-1548, D-1543N, D-
1541, D-1540, D-1539, D-1537

Low-end[1]

Xeon D 6/12 D-1533N, D-1531, D-1528 Low-end[1]

Xeon D 4/8 D-1529, D-1527, D-1523N, D-
1521, D-1520, D-1518, D-1513N

Low-end[1]

Pentium D 4/8 D1519, D1517 Low-end[1]

Pentium D 2/4 D1508 Low-end[1][2]

Pentium D 2 D1509, D1507 Low-end[1][2]
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Haswell (2013)

Desktop

Family Cores Models Known issues

Core i7
Extreme

8/16 i7-59##X

Core i7 6/12 i7-59##K, i7-58##K

Core i7 4/8 i7-47##, i7-47##K, i7-47##S, i7-
47##T, i7-47##TE, i7-47##R

Core i5 4

i5-46##, i5-45##, i5-44##, i5-
46##K, i5-46##S, i5-45##S, i5-
44##S, i5-46##T, i5-459#T, i5-
44##T, i5-46##R, i5-45##R

Low-end[1]

Core i5 2/4 i5-457#T, i5-457#TE Low-end[1][2]

Core i3 2/4 i3-43##, i3-41##, i3-43##T, i3-
43##TE, i3-41##T

Low-end[1][2]

Pentium 2 G34##, G32##, G34##T,
G33##TE, G32##T

Low-end[1][2]

Celeron 2 G18##, G18##T, G18##TE Low-end[1][2]

Server

Family Cores Models Known issues

Xeon E7 18/36 E7-8890v3, E7-8880v3, E7-
8880Lv3, E7-8870v3

Multi-CPU[3]; NUMA[4];
Memory controller[6]

Xeon E7 16/32 E7-8867v3, E7-8860v3 Multi-CPU[3]; NUMA[4];
Memory controller[6]

Xeon E7 10/20 E7-8891v3 Multi-CPU[3]; NUMA[4]

Xeon E7 4/8 E7-8893v3 Multi-CPU[3]; NUMA[4]
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Xeon E7 14/28 E7-4850v3 Multi-CPU[3]; NUMA[4];
Memory controller[6]

Xeon E7 12/24 E7-4830v3 Multi-CPU[3]; NUMA[4]

Xeon E7 10/20 E7-4820v3 Multi-CPU[3]; NUMA[4]

Xeon E7 8/16 E7-4809v3 Multi-CPU[3]; NUMA[4]

Xeon E5 18/36 E5-2699v3
Multi-CPU[3]; NUMA[4];
CoD[5]; Memory
controller[6]

Xeon E5 16/32 E5-2698v3, E5-2698Av3
Multi-CPU[3]; NUMA[4];
CoD[5]; Memory
controller[6]

Xeon E5 14/28
E5-2697v3, E5-2695v3, E5-
2683v3

Multi-CPU[3]; NUMA[4];
CoD[5]; Memory
controller[6]

Xeon E5 12/24
E5-2690v3, E5-2680v3, E5-
2673v3, E5-2670v3, E5-2650Lv3,
E5-2658v3, E5-2648Lv3

Multi-CPU[3]; NUMA[4];
CoD[5]

Xeon E5 10/20 E5-2660v3, E5-2650v3, E5-
2628Lv3

Multi-CPU[3]; NUMA[4];
CoD[5]

Xeon E5 8/16 E5-2667v3, E5-2640v3, E5-
2630v3, E5-2630Lv3, E5-2618Lv3

Multi-CPU[3]; NUMA[4];
CoD[5]

Xeon E5 6/12 E5-2643v3, E5-2620v3, E5-
2608Lv3

Multi-CPU[3]; NUMA[4];
CoD[5]

Xeon E5 6 E5-2609v3, E5-2603v3 Multi-CPU[3]; NUMA[4];
CoD[5]

Xeon E5 4/8 E5-2637v3, E5-2623v3 Multi-CPU[3]; NUMA[4];
CoD[5]

Xeon E3 4/8

E3-1286v3, E3-1286Lv3, E3-
1285v3, E3-1285Lv3, E3-
1284Lv3, E3-1281v3, E3-1280v3,
E3-1276v3, E3-1275v3, E3-
1275Lv3, E3-1271v3, E3-1270v3,
E3-1268Lv3, E3-1265Lv3, E3-
1246v3, E3-1245v3, E3-1241v3,
E3-1240v3, E3-1240Lv3, E3-
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1231v3, E3-1230v3, E3-1230Lv3

Xeon E3 4 E3-1226v3, E3-1225v3, E3-
1220v3

Xeon E3 2/4 E3-1220Lv3 Low-end[2]

Workstation

Family Cores Models Known issues

Xeon E5 10/20 E5-2687Wv3 Multi-CPU[3]; NUMA[4];
CoD[5]

Xeon E5 8/16 E5-1680v3, E5-1660v3 NUMA[4]; CoD[5]

Xeon E5 6/12 E5-1650v3 NUMA[4]; CoD[5]

Xeon E5 4/8 E5-1630v3, E5-1620v3 NUMA[4]; CoD[5]

Xeon E5 4 E5-1607v3, E5-1603v3 NUMA[4]; CoD[5]

Mobile

Family Cores Models Known issues

Core i7 4/8

i7-49##MX, i7-49##HQ, i7-
48##HQ, i7-47##HQ, i7-
49##MQ, i7-48##MQ, i7-
47##MQ, i7-48##EQ, i7-47##EQ,
i7-47##EC

Core i7 2/4 i7-46##U, i7-45##U, i7-46##Y, i7-
46##M

Low-end[2]

Core i5 2/4
i5-44##EC, i5-44##E, i5-43##U,
i5-42##U, i5-43##M, i5-42##M,
i5-43##Y, i5-42##Y, i5-42##H

Low-end[1][2]

Core i3 2/4 i3-41##U, i3-40##U, i3-41##E, i3-
41##M, i3-40##M, i3-40##Y

Low-end[1][2]
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Pentium 2 35##Y, 35##U, 35##M Low-end[1][2]

Celeron 2 29##U, 29##M, 29##Y Low-end[1][2]

Ivy Bridge (2012)

Desktop

Family Cores Models Known issues

Core i7
Extreme

6/12 i7-4960X

Core i7 6/12 i7-4930K

Core i7 4/8 i7-48##K, i7-37##K, i7-37##, i7-
37##S, i7-37##T

Core i5 4/8 i5-35##K, i5-35##, i5-35##S, i5-
35##T, i5-347#S, i5-347#

Low-end[1]

Core i5 4 i5-345#, i5-345#S, i5-33##P, i5-
33##, i5-33##S

Low-end[1]

Core i5 2/4 i5-347#T Low-end[1][2]

Core i3 2/4 i3-32##, i3-32##T Low-end[1][2]

Pentium 2 G21##, G21##T, G20##, G20##T Low-end[1][2]

Celeron 2 G16##, G16##T Low-end[1][2]

Server

Family Cores Models Known issues

Xeon E7 15/30 E7-8895v2, E7-8890v2, E7-
8880Lv2, E7-8880v2, E7-8870v2

Multi-CPU[3]; NUMA[4]

Xeon E7 15/30 E7-4890v2, E7-4880v2, E7-4870v2 Multi-CPU[3]; NUMA[4]
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Xeon E7 15/30 E7-2890v2, E7-2880v2, E7-2870v2 Multi-CPU[3]; NUMA[4]

Xeon E7 12/24 E7-4860v2, E7-4850v2 Multi-CPU[3]; NUMA[4]

Xeon E7 12/24 E7-8850v2 Multi-CPU[3]; NUMA[4]

Xeon E7 12/24 E7-2850v2 Multi-CPU[3]; NUMA[4]

Xeon E7 12 E7-8857v2 Multi-CPU[3]; NUMA[4]

Xeon E7 10/20 E7-8891v2 Multi-CPU[3]; NUMA[4]

Xeon E7 10/20 E7-4830v2 Multi-CPU[3]; NUMA[4]

Xeon E7 8/16 E7-4820v2 Multi-CPU[3]; NUMA[4]

Xeon E7 6/12 E7-8893v2 Multi-CPU[3]; NUMA[4]

Xeon E7 6/12 E7-4809v2 Multi-CPU[3]; NUMA[4]

Xeon E5 12/24 E5-4657Lv2 Multi-CPU[3]; NUMA[4]

Xeon E5 12/24 E5-2697v2, E5-2696v2, E5-
2695v2, E5-2692v2, E5-2651v2

Multi-CPU[3]; NUMA[4]

Xeon E5 10/20 E5-4650v2, E5-4640v2, E5-
4624Lv2

Multi-CPU[3]; NUMA[4]

Xeon E5 10/20
E5-2690v2, E5-2680v2, E5-
2670v2, E5-2660v2, E5-2658v2,
E5-2650Lv2, E5-2648Lv2

Multi-CPU[3]; NUMA[4]

Xeon E5 10/20 E5-2470v2, E5-2448Lv2, E5-
2450Lv2

Multi-CPU[3]; NUMA[4]

Xeon E5 8/16 E5-4620v2, E5-4610v2 Multi-CPU[3]; NUMA[4]

Xeon E5 8/16 E5-2687Wv2, E5-2667v2, E5-
2650v2, E5-2640v2, E5-2628Lv2

Multi-CPU[3]; NUMA[4]

Xeon E5 8/16 E5-2450v2, E5-2440v2, E5-2428v2 Multi-CPU[3]; NUMA[4]

Xeon E5 8/16 E5-1680v2

Xeon E5 8 E5-4627v2 Multi-CPU[3]; NUMA[4]

Xeon E5 6/12 E5-4607v2 Multi-CPU[3]; NUMA[4]
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Xeon E5 6/12 E5-2643v2, E5-2630v2, E5-
2630Lv2, E5-2620v2, E5-2618Lv2

Multi-CPU[3]; NUMA[4]

Xeon E5 6/12 E5-2430v2, E5-2420v2, E5-
2430Lv2, E5-2418Lv2

Multi-CPU[3]; NUMA[4]

Xeon E5 6/12 E5-1660v2, E5-1650v2

Xeon E5 6/12 E5-1428Lv2

Xeon E5 4/8 E5-4603v2 Multi-CPU[3]; NUMA[4]

Xeon E5 4/8 E5-2637v2 Multi-CPU[3]; NUMA[4]

Xeon E5 4/8 E5-1620v2

Xeon E5 4/8 E5-1410v2

Xeon E5 4 E5-2609v2, E5-2603v2 Multi-CPU[3]; NUMA[4]

Xeon E5 4 E5-2407v2, E5-2403v2 Multi-CPU[3]; NUMA[4]

Xeon E5 4 E5-1607v2

Xeon E3 4/8
E3-1290v2, E3-1280v2, E3-
1275v2, E3-1270v2, E3-1265Lv2,
E3-1245v2, E3-1240v2, E3-1230v2

Xeon E3 4/8 E3-1135Cv2, E3-1125Cv2, E3-
1105Cv2

Xeon E3 4 E3-1225v2, E3-1220v2

Xeon E3 2/4 E3-1220Lv2 Low-end[2]

Pentium 2 1403v2, 1405v2 Low-end[1][2]

Mobile processors

Family Cores Models Known issues

Core i7 4/8 i7-39##XM, i7-38##QM, i7-
37##QM, i7-36##QM
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Core i7 2/4 i7-3689Y, i7-36##U, i7-35##U, i7-
35##LE, i7-35##M

Low-end[2]

Core i5 2/4
i5-36##ME, i5-34##Y, i5-34##U,
i5-33##M, i5-33##Y, i5-33##U, i5-
32##M

Low-end[1][2]

Core i3 2/4 i3-32##Y, i3-32##U, i3-32##UE,
i3-31##M, i3-31##ME, i3-31##C

Low-end[1][2]

Pentium 2/4 B925C Low-end[1][2]

Pentium 2 A1018, 20##M, 21##U, 21##Y Low-end[1][2]

Celeron 2 10##Y, 10##E, 10##M, 10##U,
10##UE, 9##UE

Low-end[1][2]

Sandy Bridge (2011)

Desktop

Family Cores Models Known issues

Core i7
Extreme

6/12 i7-3970X

Core i7
Extreme

6/12 i7-3960X

Core i7 6/12 i7-3930K

Core i7 4/8 i7-3820

Core i7 4/8 i7-27##K, i7-26##K, i7-26##, i7-
26##S

Core i5 4
i5-25##K, i5-25##, i5-25##S, i5-
25##T, i5-24##P, i5-24##, i5-
24##S, i5-23##P, i5-23##

Low-end[1]

Core i5 2/4 i5-23##T Low-end[1][2]

Core i3 2/4 i3-21##T, i3-21##C, i3-21## Low-end[1][2]
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Pentium 2 G8##, G8##T, G6##, G6##T Low-end[1][2]

Celeron 2 G5##, G5##T Low-end[1][2]

Celeron 1/2 G47#, G46# Low-end[1][2]

Celeron 1 G44# Low-end[1][2]

Server

Family Cores Models Known issues

Xeon E5 8/16 E5-4650, E5-4650L, E5-4640, E5-
4620

Multi-CPU[3]; NUMA[4]

Xeon E5 8/16

E5-2687W, E5-2690, E5-2680, E5-
2689, E5-2670, E5-2665, E5-2660,
E5-2658, E5-2650, E5-2650L, E5-
2648L

Multi-CPU[3]; NUMA[4]

Xeon E5 8/16 E5-2470, E5-2450, E5-2450L, E5-
2448L, E5-2449L

Multi-CPU[3]; NUMA[4]

Xeon E5 6/12 E5-4610, E5-4607 Multi-CPU[3]; NUMA[4]

Xeon E5 6/12 E5-2667, E5-2640, E5-2630, E5-
2620, E5-2630L, E5-2628L

Multi-CPU[3]; NUMA[4]

Xeon E5 6/12 E5-2440, E5-2430, E5-2420, E5-
2430L, E5-2428L

Multi-CPU[3]; NUMA[4]

Xeon E5 6/12 E5-1660, E5-1650

Xeon E5 6/12 E5-1356

Xeon E5 6 E5-4617 Multi-CPU[3]; NUMA[4]

Xeon E5 4/8 E5-4603 Multi-CPU[3]; NUMA[4]

Xeon E5 4/8 E5-2643, E5-2618L Multi-CPU[3]; NUMA[4]

Xeon E5 4/8 E5-2418L Multi-CPU[3]; NUMA[4]

Xeon E5 4/8 E5-1620
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Xeon E5 4/8 E5-1410

Xeon E3 4/8 E3-1290

Xeon E5 4 E5-2609, E5-2603 Multi-CPU[3]; NUMA[4]

Xeon E5 4 E5-2407, E5-2403 Multi-CPU[3]; NUMA[4]

Xeon E5 4 E5-1607, E5-1603

Xeon E5 2/4 E5-2637 Low-end[2]; Multi-CPU[3];
NUMA[4]

Xeon E3 4/8
E3-1280, E3-1275, E3-1270, E3-
1260L, E3-1245, E3-1240, E3-
1235, E3-1230

Xeon E3 4 E3-1225, E3-1220

Xeon E3 4/8 E3-1125C, E3-1105C

Xeon E3 2/4 E3-1220L

Pentium 2/4 350 Low-end[1][2]

Pentium 2 1407, 1405, 1403 Low-end[1][2]

Mobile

Family Cores Models Known issues

Core i7
Extreme

4/8 i7-29##XM

Core i7 4/8 i7-28##QM, i7-27##QM, i7-
27##QE, i7-26##QM, i7-26##QM

Core i7 2/4 i7-26##M, i7-26##LE, i7-26##UE Low-end[2]

Core i5 2/4 i5-25##M, i5-24##M, i5-25##E Low-end[1][2]

Core i3 2/4 i3-23##M, i3-23##E, i3-23##UE Low-end[1][2]

Pentium 2/4 B9##C Low-end[1][2]



Online Help Reconstructor 4.4

33 / 361

Pentium 2 9##, B9## Low-end[1][2]

Celeron 2 B8##, B8##E, 88#, 87#, 86#, 85#,
84#, 84#E

Low-end[1][2]

Celeron 1/2 80#, 7##C Low-end[1][2]

Celeron 1 82#E, 7##, B7##, 80#UE Low-end[1][2]

[1]. The system is below the recommended hardware requirements
This system is below the recommended hardware requirements.
The recommended CPU families are Intel Core i7, Intel Core i9, Intel Xeon.

[2]. The system is below the recommended hardware requirements
This system is below the recommended hardware requirements.
The recommended minimum amount of physical cores is 4.

[3]. Multi-CPU usage
Systems with multiple CPUs aren't supported by Reconstructor. In order to use the software with no
performance penalty on such systems, the process affinity must be configured, so that it runs on all
the cores of one single CPU. This will limit the amount of CPU cores and memory available to
Reconstructor, but will allow multiple copies of the program to run on separate CPUs.

[4]. NUMA configuration
Systems that expose their CPU as multiple NUMA nodes aren't optimal for the heavy workloads
Reconstructor is capable of. In order to run Reconstructor with no performance penalty caused by
the memory partitioning, NUMA must be disabled on the computer's BIOS. Please contact your
hardware manufacturer for details.

[5]. Cluster-on-die configuration
This family of CPUs offers the Cluster-on-Die functionality, that can split the CPU into multiple logical
CPUs as clusters of cores, with separate RAM partitions. If this feature is enabled, the performance
of applications requiring to share large memory allocation between multiple threads is negatively
affected. In order to run Reconstructor without performance loss, it is recommended that the
Cluster-on-Die functionality is disabled in the computer's BIOS. Please contact your hardware
manufacturer for details.

[6]. Internal die topology
This family of CPUs provides several cores in the same package, with multiple memory controllers
shared by them. Access to memory across different CPU cores might suffer increased latency in
some cases, and has not been benchmarked. On CPUs that support the Cluster-on-Die functionality,
this can likely be mitigated by disabling such functionality, but further tests may be necessary.
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Installation
It’s highly recommended both to deactivate all the antivirus and antispyware software and
to keep closed any Reconstructor® application before starting the installation. Windows®

default antivirus and firewall can remain active.

1. Run Reconstructor_4.x.x.xxx_STONEX.exe, press YES at the Windows alert message and follow

the steps.

2. The Reconstructor Setup Wizard starts, press Next to continue...

3. Choose the type of installation. 



Online Help Reconstructor 4.4

35 / 361

4. Accept the License Agreement terms and follow the steps.
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5. Choose Start Menu Folder shortcut and follow the steps.
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6. Choose Install Location (Default path is C:\Program Files\Stonex\Reconstructor).

If a version of Reconstructor has already been installed, the installation procedure will

uninstall the old one and then install the new one.

Press Next...
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7. Installation starting ...
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8. At the end press Next and Finish.

9. This shortcut icon  will appear on your desktop.

See also Help → About Reconstructor® to find all the information about the license, expiration date

included.

Multi-licensing (USB server licenses)
To use the multi-seat licenses: 
1. Install the same version of Reconstructor® on all computers to be used by selecting the type of
installation  "I want to try Reconstructor for 30 days". After installing the software reboot the PC
before to continue.
The computers can be positioned in different locations, but they must be connected to the same
network (same IP address and subnet mask).
2. Insert the USB key into one of the computers. 
3. Once opened Reconstructor on a computer, the license will be deducted from the multi-seat
license.

Reconstructor® automatically check new updates when available.
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Licensing
Activation and updating software are performed in two different ways, depending on the kind of
license.

USB (hardware) LICENSE
The Reconstructor® license is stored in a USB hardware key (dongle).
A USB license permits to move the dongle between several computers on which the
software is installed. 

COMPUTER BASED (digital) LICENSE
The Reconstructor® digital license key is closely linked to the computer used to generate
the activation request file.

The first activation and the updating of a Reconstructor® license follow the same procedure:

Step 1 - Generating a .c2v file (to send to Stonex)

Step 2 -  Applying a .v2c file (got from Stonex)

USB LICENSE

If you have a Reconstructor® USB dongle, how can you activate/update a license on it?

First of all, remember that each
dongle is identified by its own ID,
written on a label (see in the image
GX0000 as example).
Please use this code when
communicating with Stonex.

Step 1 - Request

1. Plug in the USB dongle
2. Open Reconstructor® and select Help → License Manager in order to create a .c2v request file.
3. Click on Generate license activation request (C2V).
4. Choose the type of license key: → USB license (1 found)

The USB dongle is found, checked, and used to generate the request file .c2v.
5. Type the desired file name (for example YYMMDD_DongleID_CompanyName ) and Save the .c2v 

file.
6. Send the .c2v file opening a ticket on MyStonex, or asking to your local reseller to do it for you.
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 Generating the activation file is possible from any PC.

Step 2 - Activation

After receiving the .C2V file, Stonex will send an activation .V2C file in reply.

Please, follow these instructions to apply it.
1. Plug in the USB dongle
2. Open Reconstructor® and select Help → License Manager.
3. Click on Apply license activation file (V2C).
4. Select the .v2c file and Open it.
5. A successful message should appear at the end of the license activation process.
6. Reboot Reconstructor®.

Multi-licensing (only for USB licenses)
To activate a Multi- seats license on a USB server dongle remember to install Reconstructor ® on all
computers to be used by selecting the type of installation  " I want to try Reconstructor for 30 days".
After installing the software reboot the PC before to continue.
See more details at Installation.

COMPUTER BASED LICENSE

If you want to activate/update a Reconstructor®  license on your PC, how can you do?

Step 1 - Request

1. Install Reconstructor® on your PC, open it, and select Help → License Manager in order to create 
a .c2v request file.

2. Click on Generate license activation request (C2V).
3. Choose the type of license key: → New computer based license/Computer based license (1 or more 

found) [1]

4. Type the desired file name (for example YYMMDD_CompanyName) and Save the .c2v file.
5. Send the .c2v file opening a ticket on MyStonex, or asking to your local reseller to do it for you.

[1] New computer based license appears when no digital licenses were previously activated on the 
current computer and you need to request a digital key license for the first time

Computer based license (1 found) appears when a digital license was previously activated on
the current computer
Computer based license (2 or more found) appears when  more than one digital license was
previously activated on the current computer. In this case select the first SL (software license)
of the list to select the most recent

 The digital license key is dependent on the computer used to generate the request activation
file.

Step 2 - Activation

After receiving the .C2V file, Stonex will send an activation .V2C file in reply.

Please, follow these instructions to apply it.
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1. Open Reconstructor® and select Help →  License Manager.
2. Click on Apply license activation file (V2C).
3. Select the .v2c file and Open it.
4. A successful message should appear at the end of the license activation process.
5. Reboot Reconstructor®.

 For license transfer from one computer to another, please contact directly Stonex.
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Disclaimer

GEXCEL rights reserved
All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic,
electronic, or mechanical, including photocopying, recording, taping, or information storage and
retrieval systems - without the written permission of the publisher.
Products that are referred to in this document may be either trademarks and/or registered
trademarks of the respective owners. The publisher and the author make no claim to these
trademarks.
While every precaution has been taken in the preparation of this document, the publisher and the
author assume no responsibility for errors or omissions, or for damages resulting from the use of
information contained in this document or from the use of programs and source code that may
accompany it. In no event shall the publisher and the author be liable for any loss of profit or any
other commercial damage caused or alleged to have been caused directly or indirectly by this
document.

All information and content (text, graphics and images) reported no sources are, to the best of our
knowledge, in the public domain; if, unintentionally, copyrighted or infringing material has been
published to the law please inform us and we will immediately remove it.

See also End User License Agreement.

Other right reserved
All trademarks shown belong to their legitimate owners; third party brands, product names, trade
names, names corporations and companies ( ex. Autodesk® , AutoCAD® , Revit® , ReCap® , Orbit® ,
Orbit GS® ...) mentioned may be trademarks of their respective owners or registered trademarks of
other companies and they have been used for the sole purpose of explanation and for the benefit of
the owner, without any purpose of violating the rights of Copyright in force.

Stonex End User License and Maintenance Agreement 

IMPORTANT, READ CAREFULLY. 

THIS END USER LICENSE AGREEMENT ("AGREEMENT") IS A LEGAL AGREEMENT BETWEEN YOU

("You", the licensee, either an individual person or a single legal entity)

AND STONEX EUROPE Srl ("Stonex") and applies to the computer software with

which this Agreement is provided, and includes any accompanying printed

materials and any "online" or electronic documentation ("Software"). 

Stonex distribute the computer software under the agreement with GEXCEL srl

("Gexcel") who own all the right on the computer software. 

All the conditions in agreement are dependent from agreement between Gexcel

and Stonex. 

This Agreement will also apply to any Software error corrections, updates and

upgrades subsequently furnished by Stonex, unless such are accompanied by

different license terms and conditions which will govern their use. 

BY CLICKING THE "I ACCEPT" BUTTON, OR BY INSTALLING, COPYING OR OTHERWISE

USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF

YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, YOU MAY NOT USE THIS

SOFTWARE. 
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Stonex, previous Gexcel agreement may change the terms of this Agreement from

time to time (such updated terms shall be uploaded onto Gexcel website at

www.gexcel.it). Your continued access to and use of the Software will be

deemed acceptance of the updated or amended terms. If you do not agree to the

changes, you should cease using the Software. 

This Software is protected by copyright laws and international copyright

treaties, as well as other intellectual property laws and treaties. The

Software is licensed, not sold. 

1. SOFTWARE LICENSE. 

1.1. License Grant. Subject to Your compliance with the terms of this

Agreement, and any applicable restrictions set forth on the Purchase Order,

Stonex grants You a non-exclusive, non-transferable license, without right of

sublicense, to install, use and display the Software in a machine-readable

form solely for Your internal purposes, and solely in connection with Your use

of the Software. The Software installation is provided on a digital media (CD,

DVD) or as a downloadable file (ISO image or executable file) from the Stonex

online repository, whose link is communicated by e-mail. You may reasonably

copy the Software to the extent necessary to enable Your permitted internal

use of the Software, but You may not copy or distribute the Software to any

third parties. 

1.2. Other Rights and Limitations. (1) The Software contains valuable trade

secrets proprietary to Gexcel and its suppliers or licensors. To the extent

permitted by relevant law, You shall not, nor allow any third party to modify,

adapt, translate, prepare derivative works from, copy, decompile, disassemble

or otherwise reverse engineer the Software or any internal data files

generated by the Software, or attempt to do so, provided, however, that to the

extent any applicable mandatory laws give You the right to perform any of the

aforementioned activities without Stonex's consent, You hereby agree that,

before exercising any such rights, You shall first request such information

from Stonex in writing detailing the purpose for which You need the

information. Only if and after Stonex, under Gexcel agreement, at Gexcel's

sole discretion, partly or completely denies Your request, may You exercise

such statutory rights. (2) This Software is licensed as a single product. You

may not separate its component parts for use on more than one computer or

device. (3) You may not rent, lease, lend, or otherwise transfer rights to the

Software or the use thereof to any third party. (4) Concurrent use of the

Software is not permitted if not included in the license type. 

1.3. Ownership Notices. (1) All right, title and interest (including but not

limited to copyright, patent, trade secret and all other intellectual property

and proprietary rights worldwide) in and to the Software (including but not

limited to any images, photographs, animations, video, and text incorporated

into the Software), the accompanying printed materials, and any copies of the

Software are owned by Stonex and its suppliers or licensors. You shall not

remove, cover or alter any of Gexcel's (or its designated suppliers' and

licensors') copyright, trademark or other proprietary notices placed upon,

embedded in or displayed by the Software or on its packaging and related

materials. (2) You acknowledge that the Software is designed to work with, and

contains, certain third party software, including without limitation, certain

software licensed by its owners under open source software license

(collectively, the "Third Party Software"). Any Third Party Software, whether

distributed with the Software or otherwise obtained by You, is subject to the

terms of the third party software license accompanying or otherwise applicable

to that Third Party Software ("Third Party License"). The terms of the

applicable Third Party License will apply to the Third Party Software
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independent of the terms of this Agreement. Nothing in this Agreement limits

Your rights under, or grants rights to You that supersede the terms of any

applicable Third Party License. 

1.4. U.S. Government Restricted Rights. The software and documentation are

"commercial items" as that term is defined at 48 C.F.R.2.101, consisting of

"commercial computer software" and "commercial computer software

documentation" as such terms are used in 48 C.F.R. 12.212. Consistent with 48

C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4, all U.S. Government

end users acquire the software and documentation with only those restricted

rights as set forth herein.

2. TERM.

2.1. Effectiveness. "Effective Date" means the date upon which You purchase a

license Key from Stonex, or issues to Stonex a valid purchase order for a

license Key. This Agreement is effective upon the Effective Date or, in any

event, upon Your installation of the Software and continues unless terminated

by Section 8 below. 

2.2. Software Activation. The Software activation is provided by software-

based protection keys ("Software Key") or hardware-based protection keys ("USB

Dongle Key"). Following the receipt by Stonex of the applicable Fees for the

relevant license, Stonex will issue to You a key to activate the Software for

the license (a "Key"). You will be responsible for installing the Key to

activate the Software. The Key shall be considered Confidential Information of

Stonex, as that term is defined herein. Stonex shall provide temporal

activation depending to purchase and payment conditions. 

2.3. Evaluation Term. You are granted a limited right to use the Software, in

compliance with this Agreement, free of charge for a period of evaluation

commencing upon the date on which You install the Software. For details about

the evaluation time please contact Laser.Team@stonex.it. Within the Evaluation

Period, the Software runs as fully functional Trial except for the ability in

exporting items. 

3. FEES AND PAYMENT.

3.1. Fees. In consideration for the rights granted hereunder, You shall pay

all the license Fees to Stonex in the amounts set forth on the Purchase Order

on or before the Effective Date specified on the Purchase Order. 

3.2. Terms of Payment. All payments are non-refundable You shall be

responsible for all sales taxes, use taxes, withholding taxes, value added

taxes and any other similar taxes imposed by any federal, state, provincial or

local governmental entity on the transactions contemplated by this Agreement,

excluding taxes based upon Stonex's net income. When Stonex has the legal

obligation to pay or collect such taxes, the appropriate amount shall be

invoiced to and paid by You unless You provide Stonex with a valid tax

exemption certificate authorized by the appropriate taxing authority. 

4. SOFTWARE MAINTENANCE.

4.1. Software Maintenance Services. During the maintenance term and subject to

the terms and conditions hereafter specified, Stonex shall provide Software

Maintenance Services, including both technical support services and software

releases. (1) Technical Support Service is provided through Customer Support

(2) As part of its maintenance services, Stonex may provide periodic Software
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Releases, including Updates (generally available releases of Software that

provide Bug Fixes, Error Corrections and Enhancements designated minor by

Gexcel) and Upgrades (generally available releases of Software that provide

enhancements designated major by Gexcel as well as minor new Enhancements and

Error Corrections). Available Software releases, periodically issued by

Gexcel, may either be downloaded from Stonex’s web site or delivered on

digital support upon written request to Stonex. 

4.2. Software Maintenance Limitations. (1) Stonex shall have no obligation to

provide Releases or Support for the Software except as set forth hereafter.

Stonex shall not have any responsibility to develop subsequent components for

the Software or additional processes for You, except as explicitly set forth

herein. (2) Stonex shall have no obligation to fix errors in the Software

within a specific time duration. Stonex will use commercially reasonable best

efforts to fix bugs and other Software defects (but not including viruses or

other defects not inherent in the Software when delivered By Stonex) in a

timely manner during its normal business hours and upon reasonable notice,

other than any bugs or defects caused by unauthorized use or modification of

the Software, accident, abuse, misuse or misapplication of the Software or the

magnetic or electronic media containing the Software. (3) You acknowledge that

Stonex, after using all reasonable efforts, may not be able to resolve an

Error and that such inability shall not be considered a breach or event of

default under this Agreement, nor be the cause of any liability to Stonex. In

the event that Stonex notifies to You its inability in fixing an Error in the

Software, You may at your option and as your sole and exclusive remedy,

terminate the Software Maintenance for the applicable Software. Upon such

termination, neither party shall have any obligation or liability to the other

in connection with such Software Maintenance. (4) Stonex shall have no

obligation to fix Errors in any version of the Software other than the latest

official release. (5) Your rights and obligations concerning the use of any

Releases (Error Corrections, Enhancements, or any other programming provided

by Stonex relating to the Software) shall be as provided under this End User

License Agreement. (6) Maintenance Services do not include: (a) development of

custom computer programs, (b) repairs or service relating to any Third Party

Software or hardware, or (c) hardware modifications or changes to existing

hardware configurations, outside the scope of warranty support. (7) Gexcel

may, at its discretion, upon notice to You and with no additional charge, make

modifications to the Software. Such modifications shall not jeopardize the

basic functionality of the Software or invalidate this Agreement. 

4.3. USB Dongle Key and Software Key Replacement. (1) For USB Dongle

activation, within a period of ten (10) days from the date of acquisition,

Stonex warrants that the USB Dongle Key will be free from defects in materials

and faulty workmanship under normal use and service. If a defect in the USB

Dongle Key should occur during such 10 days period, the USB Dongle Key may be

returned to Stonex who will replace the USB Dongle Key without any charge for

You, provided that the You have properly used the USB Dongle. After this

period and if the failure of the USB Dongle Key has resulted from unauthorized

use, accident, abuse, misuse or misapplication of the USB Dongle Key, You

shall return toStonex the damaged dongle and pay to Stonex a Replacement Fee

of 250,00 Euro (delivery charges excluded), as advised by Stonex. In case of

USB Dongle Key loss, or stolen, You shall provide Stonex with a written and

signed declaration and contact Stonex at Laser.Team@stonex.it. (2) The

Software Key may be activated on a single computer system. In case of damages

occurred to the installation computer system that do compromise the installed

Software Key, You shall provide Stonex with a written and signed declaration

and contact Stonex at Laser.Team@stonex.it. 

4.4. Software Maintenance Term. The Software Maintenance Services provided

under this Agreement shall run from the date of First License Activation for a
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time period of twelve (12) months or until the term in years for which the

Maintenance Services have been purchased by You. 

4.5. Software Maintenance Fee. The first Software Maintenance period of twelve

(12) months after the First License Activation is available at a price

included in the Software License Fee. The Renewal of Software Maintenance for

the subsequent twelve (12) months may be available at a Renewal Fee of 15% of

the full price of the purchased Software License, unless otherwise advised by

Stonex. 

5. NO WARRANTIES. 

THE SOFTWARE IS BEING DELIVERED TO YOU "AS IS" AND STONEX MAKES NO WARRANTY AS

TO ITS USE OR PERFORMANCE. STONEX AND ITS SUPPLIERS AND LICENSORS DO NOT

WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE. YOU

ASSUME THE ENTIRE RISK AS TO RESULTS AND PERFORMANCE OF THE SOFTWARE. TO THE

MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, STONEX AND ITS SUPPLIERS AND

LICENSORS DISCLAIM ALL WARRANTIES, TERMS, AND CONDITIONS, EITHER EXPRESS OR

IMPLIED, BY STATUTE, COMMON LAW OR OTHERWISE, INCLUDING BUT NOT LIMITED TO,

IMPLIED WARRANTIES, TERMS, AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A

PARTICULAR PURPOSE, TITLE, AND NONINFRINGEMENT WITH REGARD TO THE SOFTWARE,

ITS SATISFACTORY QUALITY, AND THE PROVISION OF OR FAILURE TO PROVIDE

MAINTENANCE SERVICES. 

STONEX IS NOT RESPONSIBLE FOR THE OPERATION OR FAILURE OF OPERATION OF THE

LASER SCANNER OR ANY OTHER HARDWARE INCLUDED WITH OR RELATED TO THE

INSTALLATION. 

6. LIMITATION OF LIABILITY. 

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL STONEX OR

ITS SUPPLIERS OR LICENSORS BE LIABLE FOR ANY LOST PROFITS OR COSTS OF

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, OR FOR ANY SPECIAL, INCIDENTAL,

INDIRECT OR CONSEQUENTIAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS

OF THE THEORY OF LIABILITY (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF

BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY

OTHER PECUNIARY LOSS), ARISING OUT OF THE USE OR INABILITY TO USE THE

SOFTWARE, OR THE PROVISION OF OR FAILURE TO PROVIDE MAINTENANCE SERVICES, EVEN

IF STONEX OR AN AUTHORISED STONEX'S REPRESENTATIVE HAS BEEN ADVISED OF THE

POSSIBILITY OF SUCH DAMAGES, AND NOTWITHSTANDING ANY FAILURE OF ESSENTIAL

PURPOSE OF ANY EXCLUSIVE REMEDY PROVIDED IN THIS AGREEMENT. 

IN NO EVENT SHALL STONEX'S TOTAL LIABILITY IN CONNECTION WITH THIS AGREEMENT

AND THE SOFTWARE, WHETHER BASED ON CONTRACT, WARRANTY, TORT (INCLUDING

NEGLIGENCE), STRICT LIABILITY OR OTHERWISE, EXCEED THE AMOUNT PAID TO STONEX

FOR USE OF THE SOFTWARE GIVING RISE TO THE CLAIM, IF ANY. BECAUSE SOME STATES

AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR

CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO

YOU. 

STONEX SHALL HAVE NO LIABILITY TO YOU FOR ACTUAL DAMAGES FOR ANY CAUSE

WHATSOEVER, REGARDLESS OF THE FORM OF THE ACTION. 

7. CONFIDENTIALITY. 

The term "Confidential Information" shall mean any information disclosed by

either party (the "Disclosing Party") to the other party (the "Receiving

Party") in connection with this EULA which is disclosed in writing, orally or

by inspection and is identified as "Confidential" or "Proprietary."

Notwithstanding the foregoing, the following is "Confidential Information" of

Stonex: (a) any information, in whatever form, disclosed by Stonex that
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relates to the Software and that is not publicly known; (b) any benchmark

tests pertaining to the Software; and the Software license Key provided by

Stonex to You hereunder. The Receiving Party shall treat as confidential all

Confidential Information received from the Disclosing Party, shall not use

such Confidential Information except as expressly permitted under this

Agreement, and shall not disclose such Confidential Information to any third

party without the Disclosing Party's prior written consent. The Receiving

Party shall use the same degree of care to protect the Confidential

Information of the Disclosing Party against unauthorized use or disclosure

that it takes with its own confidential information of like nature, but in no

event less than a reasonable degree of care. Notwithstanding the above, the

restrictions of this Section shall not apply to information that: (a) was

independently developed by the Receiving Party without any use of the

Confidential Information of the Disclosing Party; (b) becomes known to the

Receiving Party, without restriction, from a third party without breach of

this Agreement and who had a right to disclose it; (c) was in the public

domain at the time it was disclosed or becomes in the public domain through no

act or omission of the Receiving Party; or (d) was rightfully known to the

Receiving Party, without restriction, at the time of disclosure. Without

terminating any restrictions or obligations of this Section, a Receiving Party

is not prohibited hereunder from disclosing Confidential Information of the

other party if such information is disclosed pursuant to the valid order or

requirement of a court, administrative agency, or other governmental body of

competent jurisdiction; provided, however, that the disclosure is strictly

limited to the extent necessary to comply with such order and, provided

further that, the Receiving Party shall provide prompt notice thereof to the

Disclosing Party and shall use commercially reasonable efforts to obtain a

protective order or otherwise prevent public disclosure of such information. 

8. TERMINATION. 

This Agreement is effective until terminated. Without prejudice as to any

other of its rights, Stonex may terminate this Agreement immediately and

without notice if You breach any provision of this Agreement or of any other

agreement between You and Stonex. Upon termination or expiration of this

Agreement: (a) any fees owed to Stonex under this Agreement before such

termination or expiration will be immediately due and payable; (b) all

licenses granted to You in this Agreement will immediately cease; and (c) You

must promptly discontinue all use of the Software, uninstall and erase all

copies of the Software from Your computers, and return or, at the option of

Stonex, destroy all copies of the Software in Your possession or control.

Sections 1.3, 1.4, 4, 5, 6, 7, 8 and 9 will survive termination or expiration

of this Agreement for any reason. 

9. EXPORT RESTRICTIONS. 

You shall not export, directly or indirectly, the Software (or any component

part or output thereof) to any country in violation of any law or regulation,

including without limitation any law or regulation of the U.S. Government or

any agency. You are solely responsible for complying with all applicable

export and import regulations and obtaining all necessary export and import

licenses or permits for the Software. You agree to defend, indemnify and hold

Stonex harmless against any liability (including attorneys' fees) arising out

of Your failure to comply with the terms of this paragraph. 

10. USE OF CUSTOMER'S NAME. 
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You acknowledge that Stonex may use Your company name on Stonex's customer

list provided to third parties. 

11. GENERAL. 

This Agreement shall be governed by the laws of Italy without regard to

conflicts of law principles. The Courts of Italy will have exclusive

jurisdiction over any disputes arising under this Agreement and the parties

hereby irrevocably consent to the personal jurisdiction of such courts. In the

event any proceeding or lawsuit is brought by the parties in connection with

this Agreement, the prevailing party in such proceeding or lawsuit will be

entitled to receive its costs and reasonable attorneys' fees. If any provision

of this Agreement is held to be unenforceable, that provision will be modified

so as to be enforceable, or if such modification is not possible, will be

removed and the remaining provisions will remain in full force. 

No failure or delay by either party in exercising any right, power, or remedy

under this Agreement, except as specifically provided herein, shall operate as

a waiver of any such right, power or remedy. Without limiting the foregoing,

terms and conditions on any purchase orders or similar materials submitted by

You to Stonex shall be of no force or effect. Neither this Agreement nor any

rights or Your obligations under this Agreement may be assigned by You in

whole or in part without the prior written consent of Stonex (except in

connection with a merger or acquisition, or the sale of all or substantially

all of such party's assets), and any attempted assignment or transfer by You

in violation of the foregoing will be null and void. This Agreement, is the

complete and exclusive statement of the agreement between the parties and

supersedes any proposal or prior agreement, oral or written, and any other

communications between the parties in relation to the subject matter of this

Agreement. The parties agree that the United Nations Convention on Contracts

for the International Sale of Goods is specifically excluded from application

to this Agreement. This Agreement is in the English language only, which

language will be controlling in all respects. 

(C) 2019 All rights reserved.
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Getting Started
The aim of this section is to suggest a simply and fast workflow to work with Reconstructor®.

Before to use Reconstructor® you have to install the
software.
After the installation the licensing permits must be verified
and set. 
See Licensing to learn how to request and apply your
license. 

At the opening of the software you need to Create a New
project or Open an existing project (*).

Each project has its own folder called with the same name.
Reconstructor® projects contains at least some of the
following subfolders: Documents/ Results/ Imports/ Exports/
Unstructs/ Grids/ Meshes/ Polylines/ Trash/ Images/ Movies/.
These folders are automatically created when the project
gets populated.

(*) Note: For major software releases, backward compatibility of Reconstructor projects is
supported; forward compatibility is not supported.

Then, starting  from importing, preprocessing, registering and georeferencing steps you can
navigate through point clouds editing, meshing, coloring tools until the main features extraction.

The main Workflow 

F1AD35D390A64FFAA4F248BA528F5429
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Most of the operations in the first part of the main workflow can be

performed with LineUp® toolbar commands. 

See at the below voices for all just mentioned processes:

1. Import
2. Register
3. Georeference
4. Edit Point Clouds
5. Create & Edit Meshes
6. Photo & Color
7. Results & Analyses

You can find all the Reconstructor commands in the Command Dashboard (Ctrl+d).
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User Interface Layout

The Reconstructor® interface is simple and user-friendly, so most of the main commands are in  the
Top Toolbar.

The user interface is composed by:

1. The menu bar on the uppermost part of the window: contains all the command and software
functions

2. The toolbox bar with the main topics
3. The top toolbar with shortcuts to the most useful and relevant commands for each of topic

toolbox
4. The view and select tools with current view, rendering parameters and points select options
5. The main rendering window where you can view in 3D the project objects
6. The project window (dockable), which lists the objects that make the 3D scene (imported or

created during the processing)
7. The property browser (dockable), which allows to view and edit the properties of the selected

objects
8. The bottom toolbar composed by the log line, that shows what is happening (the button opens

the log window), and the units of measure space (current shown, edit by button)

Furthermore, by right-clicking on an item in the project window, a context menu is displayed where
only the commands that apply to the given item type are shown. Commands can therefore also be
issued from that context menu: this is useful in particular to load/unload a model, to set an hyperlink
to an item or to open the hyperlink, to move the item to another group in the project.

There are also short sentences (tooltips) that describe each project command; they can be shown
simply by focusing on the chosen icon.
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You can find all the Reconstructor commands in the Command Dashboard [Ctrl+D].

The Reconstructor® language can be managed from the GUI options tool.

Menu bar

The menu bar is located on top of Reconstructor®'s main window, and contains the commands and
tools. Some of the commands are also accessible from the top toolbar and the contextual menu. 

The menu bar features the following main voices:

 File: to import/export, load and save data and to manage the project
 Navigation: to interact with the 3D scene and manage rendering settings
 Data management: to register, process, edit your data
 Result & analyses: to extract results from the project data
 Special tools: auxiliary tools to process the data
 Windows: to manage the dockable windows
 Add-ons: to activate further specific functions
 Help: to access the online help, the license manager and to display information on the

software version in use.

Please click on the blue words here above to study them in deep.

Toolbox Bar and Top Toolbar
Toolbox Bar and Top Toolbar allow fast access to frequently used commands from the File menu,
Navigation menu and Outputs menu.
The top toolbar changes when the user changes the current Toolbox.

The tabs of the toolbox change according to the active Add-on:
 LineUp, Mesh, Measures and CAD output tabs are available in the Reconstructor basic version;
 Color and Mining tabs are available (and displayed) only if the related add-ons has been

purchased.

The tools included in each tab are organized in order to group all the commands useful to process
data in a particular field of application.
So don't be surprised if you find some commands present in more than one tab, because they are re-
proposed to facilitate the workflow.
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LineUp
To Import, Preprocess, Register and Georeference any set of points clouds (both
unstructured and structured -grid- point clouds).

Mesh
To extract different kind of triangular mesh models and manage them. Also creation
and management of geometric shapes are included.

Measures
To take measurements (distances, areas, volumes), annotations, to record videos and
to run mesh-cloud comparison (inspection).

CAD output
To extract outputs that can be exported in CAD environment, as cross sections, quick
profiles, orthophotos and X-ray orthophotos.

Color (only available with COLOR MAPPING add-on)
To manage all the levels of colorization processes, including colorization of  point
clouds with external high-resolution pictures, creation of textured meshes,
management of projectors.

Mining (only available with MINING add-on)
To extract topographic meshes and DEM models, to compute volumes/cut&fill
volumes and extract contours. Special tools for tunneling applications are included.

Custom Toolbox
It's also possible to activate the Custom Toolbox with custom tools chosen by the user.

View, Navigation and Select points tools

    

View tools
On the right of the Top Toolbar there are three commands containing the main functions related to
the possible views, the screen settings and the parameters of the current view.

Predefined Views
Several 3D and 2D views are here available to visualize the models in the most
functional way.
Screen Settings
To set different screen and display options.
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View Params
To choose and manage Perspective or Orthographic views.

Navigation tools

Pivot Mode

Different Navigation modes are available; between them the Pivot Mode is the default and most
used.

Pivot mode
Default navigation mode based on translating and rotating around a chosen point of the 3D
scene

In this mode a point can be selected as a rotation pivot. The pivot is set by a left button click on a
valid point of an object. 

Keyboard/mouse
movement

Effect 

LMB + move mouse 
Camera rotation
around the pivot
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CMB + move mouse
Camera sideways
translation, pan

RMB + move mouse
back/forth

Camera dollying,
forward and backward
along the current focal
axis

Mouse wheel rotation
Translation towards
point indicated by the
mouse pointer

Shift + LMB + move
mouse left/right

Camera rolling

LMB click on a model's
point

Selection of rotation
pivot

Shift + mouse wheel
rotation

Zoom in and out
(change of field of
view)

Alt + LMB double click
Selection of points for
point list window

Shift + CMB + mouse
move

Draw rectangle to
move into

LMB double click Select the item

The Bubble mode may instead be useful to put yourself in the laser scan's point of view.

Bubble mode
Navigation mode in which only rotations around yourself are allowed

See the Navigation chapter for details and other navigation modes.

Select Points tools

The last command on the right of the Top Toolbar is dedicated to:

Select Points
This tool opens a recipe window to select, delete, hide and classify points.
A set of captured points can also be saved as a point cloud.

The 3D Viewport (or Main Rendering Window)
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This window is located in the center of Reconstructor®'s GUI and it renders the 3D scene with all
your project items.

In the screenshot above, you can see that the 3D window shows in the bottom left corner a triplet of
coordinate axes. This triplet shows how the current UCS is oriented with respect to your current
viewing direction.

On the right of the axes triplet, a small avatar is shown. If this avatar is present, it means that the
system for human movements while rotating is on. This system is controlled through the Navigation
options dialog, and it is explained also in that help page.

Tip: to easily add models to the scene, drag and drop your files onto the Reconstructor® window.

Navigation
Reconstructor® provides many interaction styles to navigate in the 3D scene. 
See in Navigation menu to learn how to navigate in Reconstructor® environment.

Interaction with models
You can select models in this window by left-double-mouse-click. Use it with Ctrl key pressed to
easily select more items! 
The contextual menu is available by right-double-mouse-click on the item in the 3D viewport.
This is an alternative mode to select items in the Project Window.

Points Selection
By pressing the space bar, the 3D window goes from Navigation mode to Points Selection mode and
back. You can enter the selection mode by clicking Tools->Selection&Fitting tools->Select or by toggling
the corresponding button on the top toolbar.
See Selection&Fitting tools for details.

Coordinate system
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The renderer draws with a right-handed Cartesian coordinate system; see the XYZ badge in the
bottom-left window corner, it represents the current UCS (User Coordinate System).

Dockable Windows

Reconstructor® GUI (Graphical User Interface) is composed also of many dockable windows. Each of
these windows has a default docking place. However, the user can change it, move the windows and
even leave them floating above the main GUI.

 Project window

 Property window

 Log window

 Information window

 Recipe windows

To reset the GUI to the default status open the Windows menu -> GUI Options and click on the Reset
dock widgets position button.

The Recipe Window
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This window is a particular dockable window, and its default docking area is on the right side. This
window is automatically shown and hidden by Reconstructor® at need. It is shown for the time
needed by a particular procedure to interact with the user.

Therefore, the recipe window doesn't have a fixed content, but hosts a particular dialog for the time
that this is needed to the users. Here is a list of dialogs that are hosted in the recipe window:

 Points selection with polyline

 Mesh from predefined view

 Volume calculation

 Area of cloud portion

 Area of mesh portion

 2D mesh selection

 3D mesh selection

 Cut and fill calculation

 Topographic meshing

 Plane creator and editor

 Create Orthophoto

 Create X-Ray Orthophoto

Project Items
Reconstructor®'s 3D world can be populated with several kinds of items. Items are listed in a tree
view in the project window.

 Point Clouds: a a list of Point Clouds (both structured and unstructured)
 Triangle Meshes: a list of meshes, where each mesh is a collection of triangles with adjacency

information
 Geometric shapes

Primitives (planes, cones, cylinders, spheres, circles, segments) created by a robust fitting
algorithms, polylines (created by contour algorithms or cross sections), picked on 3D scene or
imported points

 Survey tools
Cameras (preferred view points saved by the user with a definable projection among
orthographic, perspective, cylindrical and spherical)

 Annotations: user comments attached to valid 3D points in the scene. Distance and angle
quotations are considered as annotations

 Distances: obtained by distance measurements
 Flythroughs: spline trajectories defined by the user in order to create animations and movies
 User Coordinate Systems: the user can create different coordinate systems with special

purposes
 Project: useful to organize and merge in a single location all the items of a sub-project
 Results: Orthophotos, Cross Sections , Quick profiles, Contours an Tunneling results are here

listed.

Section from plane, Contours, Quick profile and Tunnel cross sections tools give as output a
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group item composed by one orthophoto, one polyline and one slice of point cloud for each
extracted section. See more details in Cross sections structure overview.

The Project Window
All the item groups are yet listed in this Project Window of a new clean project:

Load model:
select a model (cloud of points or mesh) from the project window tree and press this
button, the model will be loaded in PC RAM and if it is also checked , it will appear in the
3D  viewport.
Unload model:
this button unloads from the RAM an from the main window the selected item(s).

Export model as:
depending on the type of object selected, an export window will appear; there are many
formats available, see here.
Search project item:
searches through the items of the project.
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Contextual menu functions
The contextual menu contains, among other functions:
 Load/Unload model: each model can be loaded or unloaded to free main memory
 Save: this command is available only if the data or properties has been modified
 Save copy as: save a copy of the model or export to another file format. The following dialog

allows to browse for the file location and format (Files of type combo box)
 Go to: center the 3D window to the bounding box of the model. The view point is computed so

that to contain the whole bounding box in the viewport. Warning: this could place sometimes the
model far away, with the effect that it seems not visible. Therefore increase the max depth in
the Options.

 Center to local origin: the view point is aligned to local coordinate frame of the model, with X
rightwards, Y upwards and Z going out of the screen.

 Align to bounding box: the view point is aligned to the desired face of the bounding box of the
model

 Pose: open the pose dialog to view and modify the transformation matrix and geo-referentiation
of the model

 {Model specific operations}: list of specific processing functions.

See also project window dedicated chapter.
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Import

To quickly import data, just drag and drop the files you want to import anywhere in the 3D scene.
A wizard will appear to ask you for import options, depending on kind of data. 

a. If you're importing a point cloud the LineUp® Scan Processing Wizard will be opened.
b. If you're importing meshes and CAD models a specific window will appear to guide you
through importing steps.
b. If you're importing a different file format (as polylines, scan projects, etc…) a specific window
will appear to guide you through importing steps.

a. Importing Point Clouds… & Preprocessing

If you're opening one or more point clouds

by drag&drop (or by Import Point
Clouds command) a LineUp® Scan
Processing Wizard will appear. 
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By default you can follow wizard instructions step by step, in order to import, preprocess and
register the scans, but if you only want import raw data you have to uncheck Preprocessing,
Automatic preregistration and Fine registration. 

More information about point clouds import formats here. 
More information about LineUp® Scan Processing Wizard here. 

b. Importing Meshes and CAD Models
 If you’re importing one or more of these objects:

o Triangle meshes
o CAD Models

a specific window will guide you in the importing step (advanced settings are used for IFC files).

c. Importing “Other Formats”
If you’re importing one or more of these objects:

o Polylines
o Trajectories
o Specific images 

a specific window will guide you in the importing step (advanced settings are used for IFC files).

At the end of both of these import phases, your models will be loaded in your project and saved in
Reconstructor® internal format.

See details in File > Import section. 

See also the Registration step to know how align scans and meshes.
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LineUp®

LineUp® toolbox easily allows you to:
 Import 
 Preprocess
 Register 
 Georeference 
any set of points clouds (both unstructured and structured -grid- point clouds).

Import Point Clouds
To import any point cloud format.

Wizard
Import, preprocess, preregister (with or without targets) and fine register single or
multiple scans together.

Wizard Settings
Define advanced settings for the scans processing workflow.

Cloud-to-cloud Registration
Manual and Automatic preregistration and registration commands

Target-based Registration
Manage a register using targets

Georeferencing

UCS & positioning

Cloud processing

See complete guide here: LineUp.

See Register step to know how align the scans.

Import Point Clouds

To quickly import data, just drag and drop the files you want to import anywhere in the 3D scene.
A wizard will appear to ask you for import options.

Otherwise you can use the Import Point Clouds button in the LineUp top toolbar.
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If you're
opening
one or
more point
clouds by
drag&drop

(or by 
Import
Point
Clouds
command)
a LineUp®

Scan
Processing
Wizard will
appear. 

By default you can follow wizard instructions step by step, in order to import, preprocess and
register the scans, but if you only want import raw data you have to uncheck Preprocessing,
Automatic preregistration and Fine registration. 

More information about point clouds import formats here. 
More information about LineUp® Scan Processing Wizard here. 

Clicking on More Settings button a LineUp Settings Dialog will appear.

In this phase you have to pay attention to Importing and Preprocessing folders:
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You have simply  to choose
the subsampling rate.
Depending on your data
format you can evaluate
several import options, as
color or multi echoes. 

Start
LEVEL

You have only to
identify your data
import format
(look at your
sensor) and use
the default
parameters to
preprocess (clean
and filter) the
scans. 

Advanc
ed

LEVEL

Depending on
your data format
and on your
survey you can
evaluate several
options.

After closing this setting dialog click on Next and then on Process button.
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Import formats
Several formats for Unstructured and gridded point clouds can be imported:

Comma Separated Values (*.csv)
DEM ASCII header+matrix (*.asc)
E57 grid point cloud (*.e57)
Generic binary traster (*.*)
Grid Point Cloud Text File (*.txt)
PTX (*.ptx)
Stonex multiple scans (*.x3m)
Stonex point cloud (*.x3s)
E57 unstructured point cloud (*.e57)
LAS format (*.las)
LAZ format (*.laz)
PLY point cloud (*.ply)
Unstructured Point Cloud Text File (*.txt)
PTS (*.pts)

Registration

The LineUp® toolbox includes a comprehensive suite of tools for coarse and fine registration of any
amount of scans (and not only). The registration process is composed by several steps, depending
on adopted survey techniques.

The general flow, here illustrated

starts from a  preregistration step that allows you to compute a rough alignment between the
imported models. The alignment can be later refined using ICP registration and Bundle Adjustment
to choose and refine the good ICPs and discard the wrong ones, in order to reduce the global
registration error. 
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Star
t

LEVE
L

You can simply use the Scan
Processing Wizard (also
simultaneously with the import
phase) and check all the steps,
using default parameters.

Adv
ance

d
LEVE

L

You can manage the registration
parameters for your purpose in
the LineUp Setting Dialog or you
can separately carry out the
processes (with Register
commands in the LineUp® main
window). 

In the following paragraph several customized workflows are illustrated. The user can choose the
way, depending both on survey techniques adopted and on desired output accuracy. Then the main
processes (algorithms) are briefly illustrated.

WF1 After importation of a pre-registered project

If you pre-registered your scans with a third part software (as the owner laser scan) you
can import the just aligned scans and simply make a fine registration, in order to further
reduce the registration error. 
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WF2 Automatic registration without targets
If you made a survey not using targets or markers, with a good overlapping (the
minimum overlap of two scans is 20-30% of their surface), the automatic preregistration
algorithm permits you to register all the point clouds you want. 
Then you can decide if you want only to make a cloud to cloud registration 

or also a bundle adjustment

WF3 Automatic registration using targets
If you made a survey using Stonex’s targets, a special function
automatically register a set of scans by detecting and matching
targets. 

Then you can decide if you want only to make a cloud to cloud
registration 

or also a bundle adjustment
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WF4 Automatic preregistration failed? Make a manual preregistration
If you don’t achieve a good error of alignment using automatic techniques, the manual
registration helps you to align two scans (or two generic models) by finding 3 couples of
corresponding points among the models.  
Then you can decide if you want only to make a cloud to cloud registration 

or also a bundle adjustment

You can also choose to follow an alignment per groups procedure.

See in the following links how to implement: 
1. Preregistration
2. Fine registration

See Georeference step to know how georeference the registered models.

1. Preregistration
1a. Automatic Preregistration

Target-free

This function is a very effective and fast procedure that preregisters a set of scans
automatically, without using targets or markers.
Target-based

This function automatically registers a set of scans by detecting and matching targets. The
user can start the automatic target detection, otherwise can manually add, move and
remove targets. 

1b. Manual Preregistration (among models)

This function allows you to manually compute a rough alignment between two generic
models. The procedure works by finding three couples of corresponding points among the
reference and moving models.
A particular case of this command is the registration between two  grid point clouds (see
Manual Pre-registration among grid point clouds).
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Note: in the target-free automatic
preregistration process there's a
possibility to use a sketch to aid the
computation, suggesting the relative
position of the scans (see Sketch
Window)

2. Fine registration

2a. ICP Registration (cloud to cloud)
ICP Registration is an algorithm to automatically perform fine registration of a moving point
cloud against one or more reference clouds. The moving cloud must be roughly close to
the reference cloud.

2b. Bundle Adjustment
This algorithm allows to register many point clouds, distributing evenly the registration
error. The user specifies which point clouds are reference clouds (they are locked during
the registration) and which are moving; the moving clouds will move and align on the
reference clouds and between them during alignment.

At the end of the processes you should see your scans well aligned.

Georeferencing

The LineUp® toolbox includes a procedure to geo-reference the imported point clouds,
through reference points

Point clouds georeferencing

Point list registration
To georeference any items or entire projects using two point lists

This process allows you to georeference multiple scans using both targets (or other points) and the
centers of the scans (if geo-referred).



Online Help Reconstructor 4.4

73 / 361

You can georeference one or more scans by selecting at least 3 points from different scans, known
also in another reference system (for example from topography). In the same way a
georeferentiation of  generic 3D models (i.e mesh models from BIM) is possible (see 3D Model
georeferencing).

These steps will be illustrated in the following:
1. Reference points selection
2. Scans georeferencing
3. 3D Model georeferencing

To find and manage reference points on the point clouds in the project, you can use the commands:
Manage control points
To manually pick points on a generic object in the point cloud and to manage them

Manage circular targets
To automatically find the center of  planar circular target or manually pick points on a
generic object in the point cloud 

Manage spherical targets
To automatically find the sphere center

1. Reference points selection 
When you select the Point clouds georeferencing command and at least one point cloud (grid or
unstructured) the Reference points Selection window appears. This dialog allows the selection of
multiple reference points from the point clouds target and center points. Target points can be
automatically or manually set using the targets editor dialog.
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The reference points taken with Manage control points and Manage circular targets procedures will
be automatically loaded in the Reference Points Selection window.

 See all the details in Target-based pre-registration.

2. Scans geo-referencing
After the reference points selection, using Georeferencing from point list dialog allows you to Load
external points (or Georeferenced Centers of the scans) to geo-reference scans by using previous
selected target points. 
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The Compute Registration command automatically finds the best matching points from the right and
left list and computes the alignment between them. 

3. 3D Model georeferencing

Using the Point list registration command in Reconstructor® environment, you can register a list of
points, named moving points, against another list of points that you consider as reference (these last
points can be geo-referenced). So you can take some points on the model and register it using geo-
referenced coordinates of the same points.

Here the process:
 Moving points (in the left half of the dialog):  you can load a text file with listed points or you

can copy the points listed in the project 
 Reference points: (in the right  half of the dialog): you can load the reference points from a

text file
 press Compute  to register the points by coupling them. A dialog appears, asking whether

you want to register the points by coupling them according to their labels, or by trying out all
the possible pair combinations to find the best. The first option is much faster but it assumes
that you are sure about how to match your points. After you have selected either Match
names or Best fit, you can refine and make use of the results of the registration, in the
Registration report dialog.
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Note: to start the registration, it is not necessary for the left table to contain as many points as the
right table.

It’s suggested to save the scans position before to move them in the 3D space, so it will be easy to
recover the previous position in case of a bad displacement or alignment (see also Restore a Pose).

For more details see Georeferencing from point list page.

Points Filtering and Clustering
This category of tools includes functions dedicated to work with point clouds, to enable other
processes and further results. Most of these tools work on any point clouds, some of them work
only on grid point clouds.
The filtering tools include also the point cloud Pre-process filters: Reconstructor® applies  a set of
algorithms to the scans which extract information that is needed during further processing of the
data.
All the commands can be activate also through the point clouds contextual menu.

Processes
On Grid

Point

Clouds

On

Unstructure

d

Point

Clouds

Filtering Pre-process
clouds

 Noise Removal (Range &
Reflectance Gate, Outlier
Removal, Median Filter, Mixed
Point Filter, Noise Remover)

 Compute Normals
 Edge Detection (Depth &

Orientation Discontinuity)
 Compute Confidence

ü

 Noise Removal (Outlier
Removal, Noise Remover)

 Compute Normals
 Compute Confidence

ü
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Restore raw
data

To undo any operation
of preprocessing, deletion and
editing that may have been
performed on the clouds.

ü ü

Restore
deleted points  

To undelete all the points earlier
deleted. ü ü

Edit 2D A grid point cloud is shown in its 2D
representation. Here you can select,
delete and undelete points with
several functions.

ü

Fill holes To replace any invalid point in the
cloud with a value averaged from the
point's neighbourhood in the cloud's
structure.

ü

Hide black
points

To invalidate all the points in the
cloud that are colored in full black. ü ü

Remove
duplicated

points

To invalidate any point that has
exactly the same coordinates of
another point in the cloud.

ü ü

Resample To resample a point cloud,
subsampling it. ü ü

Simplify points To determine the most relevant
points from a point of view of shape
description, and save them into the
new unstructured point cloud. These
resulting clouds work as compact
representations of the original
structured ones.

ü

Extract edges To extract the edges of a grid point
cloud, in form of polylines. ü

Level 3D
density of

clouds

To cluster clouds excluding
duplicated or unneeded points. The
resulting cloud, however, will not
contain all points from the input
clouds, but only those needed to
guarantee a fixed 3D density of the
points.

ü ü

Clustering
Level 3D
density of

clouds

To cluster clouds excluding
duplicated or unneeded points. The
resulting cloud, however, will not
contain all points from the input
clouds, but only those needed to
guarantee a fixed 3D density of the
points.

ü ü

Make single
cloud

To lump together in an unstructured
point cloud an arbitrary set of point
clouds.

ü ü
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Virtual scan To resample the scene and generate
a new clustered grid point cloud. ü ü

See Cloud Processing for details.
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Meshes

Manage meshes
A triangle mesh is a 3D model represented by a set of triangles connected by common edges and
common vertices. A triangle mesh therefore defines a surface in the 3D space.
In this section an overview of the techniques to create and edit meshes will be presented.

Manage Points and Shapes
In Reconstructor® you can also create, manage and edit some geometric shapes.
In this section an overview of how to create and manage them will be presented.

Manage Meshes
Several tools, starting from the mesh import to the mesh creation and manipulation are available.

In the next paragraphs a short overview. 

Import Meshes
Reconstructor can import various type of mesh files; below all of them are listed.

Some type of mesh need specific interface to be imported, you'll see it at the import start.

Mesh creation
Reconstructor® provides 4 typologies of mesh techniques. Different number and type of point
clouds can be used as a basis to create a mesh, depending on the meshing technique:

On
Grid
Point

Clouds

On
Unstructur

ed Point
Clouds

Suggested for…
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Multiresolution Mesh
Fast meshing technique that give back
light meshes that may have holes in
some situations. ü

(one or
more)

To obtain a well
defined and fast

mesh from a
single structured
point cloud, with a

good
quality/computati

onal time ratio
Mesh from predefined view
Relatively slow meshing technique that
gives back convex meshes without holes.
It’s a view dependent, high defined  mesh
(each point is a vertex)

ü
(one)

ü
(one –

single or
clustered

point
cloud)

Useful for façades
(using
orthocamera) and
tunneling (using
cylindrical
camera)

3D Mesh
Approximative 3D meshing not view-
dependent and taking as constraints the
points' positions and orientations
(normals)

ü
(one)

ü
(one –

single or
clustered

point
cloud)

Useful for convex
surfaces. 

Topographic Mesh
Fast meshing algorithm designed for DTM
models. It gives back a watertight, light,
smoothed mesh useful for isolines and
volumes calculation.

ü
(one or
more)

ü
(one or
more)

Useful for land
survey and mining

Mesh manipulation
Mesh Editor
An editing environment to perform advanced operations such as hole-filling, borders
detection, editing triangles and vertexes, smoothing surfaces, decimating, crests and
toes extraction.

Merge meshes into one
This dialog allows to lump together in a single mesh an arbitrary set of triangle meshes

Convert mesh to point cloud
To create an unstructured point cloud from mesh.

Get mesh borders as polyline
To create a new polyline containing the mesh's borders and add it to the project

Mesh selection from current view point
To cut a portion of a mesh using 2D video selection tools on the current view.

Reconstructor® provides many other functions for editing meshes.
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Manage points and shapes

Manage points

By Alt + Left Double Mouse clicking you can pick a point on a model and save it in the "Picked Point"
list.
It is possible to import a point list from a text file: File menu -> Import a list of points...
Collected points can be also used to fit primitives, draw polylines or convert point to targets.

Manage Points
 Edit point list
 Export point list
 Polyline from point list
 Fit shape to point list

Primitives (planes, cones, cylinders, spheres, circles) can be created by a robust fitting algorithms. An
accurate fitting reports is also provided.

Basic Shapes
 Create/edit plane
 Create/edit segment
 Create/edit polyline

Second Order Shapes
 Create/edit circle
 Create/edit sphere
 Create/edit cylinder
 Create/edit cone

Shapes Interactions
Minimum distance between fitting primitives can be quickly calculated; bridge clearance, building
heights, poles/pillars inter-distances, tank diameters can be easily extracted.
Fitting primitives can be intersected providing precise polylines.
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 Distance between shapes
 Intersect geometric shapes
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Measures

Reconstructor® provides different tools to take measurements in the 3D space, as annotation,
distances, angles, area and volume computations.

In Reconstructor® some basic measuring features are available:

Readout window
The readout window allows you to see the 3D coordinates of the points you are
hovering the mouse on in the 3D rendering window.
Annotation
This function allows you to create annotation of 3D points of models in your project.

Distance
This button allows you to measure a distance between any two points in the 3D scene. 

Open Angle Tool
This button enables you to measure and angle between three points in your 3D scene. 

Area and Volume
To take measures as:
 Area
 Volume from plane
 Compute cut&fill volume

Inspection
It is a procedure to compare two different shapes and to measure their differences.

Save snapshot
This function allows you to capture a snapshot of the main viewport with its rendered
models. You can save the captured snapshot in a variety of image formats, including
Bitmap, Jpeg and PNG.
Video record
To acquire and save video navigating in the 3D window.

More details at Measures & Notes.
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CAD Outputs

CAD Output
Cross sections, Quick profiles, Orthophotos and X-Ray Orthophotos can be created, edited, and used
to take measurements in the 2D space.
All these outputs can be extracted from point clouds (both grid and unstructured) and meshes.

Points and polylines can be picked and created  in the 3D space, but you can constraint them on a
plane (to create a 2D entity) by using Drawing tools.

All these items can be exported into CAD software.

Cross Section Tools
It contains commands and features to create cross sections and isolines of point clouds
(grid or unstructured) and meshes, starting from cutting planes and other constraints:
 Create/edit plane
 Cross section
 Section from plane
Quick profile
Creates vertical cross sections of  models by simply picking two points in the 3D
window you can access the relative command in the top toolbars.

The following commands are used to create, manage and visualize precise, high-resolution
elevations and plans of your models:

Create Orthophoto
Creates an Orthophoto and defines its position, size and field of view based on different
parameters and methods.
Create X-Ray Orthophoto
Creates an X-Ray Orthophoto from a set of selected point clouds. Main edges and borders
are emphasized and displayed in the final Ortho view.
Orthophoto viewer
Opens an orthophoto in the viewer to measure distances, angles and areas.
From the viewer, the orthographic image can be exported in AutoCAD.

The following tools are used to extract cameras and run virtual scans by using them.

Create Camera
Creates four types of camera (perspective, ortho, cylindrical and spherical).

Place here survey point
Creates a perspective camera placed in the current view point.
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Virtual scan
Computes a Virtual Scan of the models in the 3D scene from a selected camera. The virtual
scan can be saved as a 2D image, or as a grid point cloud, and exported to AutoCAD as a
scaled Orthophoto.
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Color

Reconstructor® provides several coloring tools to effectively manage the colorization of point
clouds and meshes. 
These tools can be classified according to the objects you want to color and the procedures you need
to apply: 

 Some color information is item intrinsic of point clouds and saved as a color layer (see
Cloud coloring). 

 A mapping (on point clouds and meshes) of an image from external cameras is possible
(see Camera calibration, projectors and colorization). 

To look at point clouds’ color layers,
select the point cloud from the project
window and set the Color Mapped
option in the Property Browser. 

Open the Photo & Color detailed page.

Cloud coloring
The following commands help the user to manage the color layers of point clouds.

Histogram
To optimize the point clouds color's contrast by histogram stretching. Only single channel
layer can be used (reflectance, gray scale layers...).
This command is available in the Property browser dialog.



Online Help Reconstructor 4.4

87 / 361

Colors mapping
To manage an artificial colorization for a given color layer of a point cloud. Color information
can be scalar (e.g. reflectance, range, confidence) or vectorial (e.g. inclination). It’s also
possible to add layers from external images.
Color with altitudes
To add to the selected point cloud(s) an extra color layer, representing the altitude of the
points with respect to one of the tree axes of the current UCS. 

Inclination from plane
To add to the selected point cloud(s) an extra color layer, representing the inclination of the
points' normals with respect to a given plane that exists in the project.

Use it to classify points for a further vegetation removal.

Color with range
To add a layer coloring the distance from the relative observation point.

Color with ambient light
To add to the selected point cloud(s) an extra color layer, 

Visualization of outdoor large mapped areas can be enhanced with this layer.

Compute 3D reflectance
To add to the selected point cloud(s) a special color layer, named 3D Reflectance, that mixes
LiDAR intensity and point normals (inclination) to enhance both geometrical and surface
characteristics.
Add color layer from image
To apply an image on the point cloud (e.g. a 2Dview after a color editing).

Merge or split layers
To combine RGB and scalar layers to obtain a customized new layer of color for point
clouds.

See Photo & Color for more details.

Camera calibration, projectors and colorization
Among the coloring tools, there are some dedicated to colors related to photos.

Images & calibration
To calibrate images on point clouds and meshes and determine the intrinsic parameters of
a camera (if necessary):
 Camera calibration on a model
 Camera calibration using 3D points
 Calibrate camera intrinsic
Texture mapping
To color point clouds and meshes by using external images (and also extracted panoramic
cameras from perspective picture in Reconstructor®)
 Color clouds with photos
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 Create panorama
 Create texture map
Create projector
To create a Perspective, Orthographic, Spherical, Cylindrical projector or from a calibration
(by importing a Reconstructor® camera calibration file) using a valid image.

Load projector
To load (light on) the image on the 3D model.

Unload projector
To unload the image from the 3D model.

UAV and imaging
These tool is used to Import GeoTIFF as an orthographic camera.
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Mining

In this toolbar there are many different tools to extract information and geometrically analyze the
3D models in mining and tunneling environments.

Topographic meshing
To transform a mesh or an unstructured point cloud into a structured one from
provided cameras.
DEM points
To extract simplified models of your models (grid or unstructured point clouds and
meshes).

Crest and toe
To extract discontinuities from mesh models.

Contours
To create isolines (contour lines) of your models (grid or unstructured point clouds and
meshes)

Quick profile
To create vertical cross sections of your models (grid or unstructured point clouds and
meshes) by simply picking two points in the 3D window.

Volume
To compute volumes between a surface and one or more reference surfaces (mesh or
planes)

Orthophotos
To create orthophotos and X-ray orthophotos and visualize them.

Tunnel survey
To extract cross sections and cylindrical projection along a trajectory.

Inspection
To compare two different shapes and to measure their differences.
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Export

This menu contains a number of options to export Reconstructor®'s entities in various formats, to be
imported in third-party software or CAD tools for further elaboration.

 Export model as
 Export polyline as
 Export cross section as
 Export UCS to AutoCAD
 Export annotations
 Export pose
 Export to Autodesk ReCap®

 Export point list

See Export for further details.
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File menu

This menu is mainly organised in three main parts:

PROJECT
MANAGEME

NT

 New project: every project is organized in a folder that groups data by model
structure and object type, thus the following dialog allows to create and select a
folder for the project

 Open project: opens an existing project (*.recprj format)
 Save project [Ctrl+S]: saves the current project
 Save project as [Ctrl+Shift+S]: saves a copy of the project with a different

name
 Open current project folder [1]: opens the folder including the current

Reconstructor® project
 Purge project: can empty the "Trash" project's folder, erase the temporary

files, the orphaned item files (badly connected with the project) and backup
data.

IMPORT  Import Reconstructor Project
 Load item
 Import a list of points: imports a .txt file as a list of points inside the project
 Import external data: imports data from third party formats

o Grid Point Clouds
o Triangle Meshes
o Unstructured Point Clouds
o Polylines/trajectories
o CAD Models
o F6 handheld scans (.mvx)

EXPORT  Export model as
 Export polyline as
 Export cross section as
 Export UCS to AutoCAD
 Export annotations
 Export pose
 Export to Autodesk ReCap®
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 Export point list

Exit: quits Reconstructor®. If you have unsaved changes to your projects, Reconstructor® asks you
if you what to save the changes or not before exiting.

 [1] Each project has its own folder called withthe same name. Reconstructor® projects contains at
least some of the following subfolders:
Documents / Exports / Grids / Images / Imports / Meshes / Polylines / Results / Settings / Trash /
Unstructs. 
These folders are automatically created when the project gets populated. 

 Items removed from the Reconstructor ® project are moved from their initial location to Trash
folder.
To recover space on your hard drive, it is really advisable to periodically empty this folder if the
contents are no longer useful.

The Purge project data tool can help you to save space on disk, detecting and deleting the
useless huge data.  
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Project Management

In this section you can learn how to efficiently manage your Reconstructor® project.

New project
Run Reconstructor®, a splash screen is shown and this interface appears:

Press New project button and fill in the gap:
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Each project has its own folder called with the project name. Reconstructor® projects contains at
least some of the following subfolders:

These folders are automatically created when the project gets populated. 
The option to create a new project appears also in Reconstructor® file menu, and has the same
functionality.

Open project
This function opens a Reconstructor® project (*.recprj, *.r2s). Before opening a new project,
Reconstructor® asks whether you want to save the current one (if you left unsaved changes).
The opening of the same project by two different instances of Reconstructor is not allowed; a lock
file is created in the project folder.

Compatibility across different Reconstructor® versions
Reconstructor® projects are backwards compatible. For Reconstructor® to be able to open a project,
the project must have been created/saved with a Reconstructor® version with the two most
important version numbers are smaller or equal. For example, Reconstructor® 4.0 can open
projects saved with versions 3.x; however it cannot open projects saved with Reconstructor® 4.1.
However, Reconstructor® 4.0.0 can open projects saved with Reconstructor® 4.0.1.
Persistence of camera pose
When opening a project, Reconstructor® loads all the project items in the project window, and sets
the 3D scene's current viewpoint to the position and orientation that it had when the project was
saved.
Moving/copying a project
When transferring or copying a project, the whole project folder with all its subfolders must be
copied, and not only the project file (*.recprj).

Save project
This function saves the current project, safely storing all the project items, their load/unload state,
their properties, the current 3D camera pose, etc.
It is advised to save the project frequently, especially before long processing operations.
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Save project as
This function saves only the project file (*.recprj) with another name. It is useful for projects with
many items, it is possible to have a project with the clouds, and another with the clouds and more
accessory items like camera, planes or polylines.
It is also useful to create a copy of the project, by using this function to create another project file in
another directory, and then copy all the source project subfolders in the destination project folder.

Open current project folder
This function allows you to quickly open the folder where the current Reconstructor® project is
stored.

Purge project
This tool can help you to save space on disk, detecting and deleting the useless huge data, as "Trash"
project's folder contents, temporary files, orphaned item files (badly connected with the project) and
backup data.

Project tree structure
All the Reconstructor® items are subdivided by groups, down here a view of an empty project.
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You can cut&paste or drag&drop items into groups.
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Import

To quickly import data, just drag and drop the files (or folders) you want to import anywhere in the
3D scene. A wizard will appear to ask you for import options, depending on kind of data. 

a. If you’re importing a point cloud the LineUp® Wizard will be opened.
b. If you’re importing a different file format (as meshes, polylines, etc…) a wizard window will
appear to guide you through importing steps.

All imported models' coordinates will be interpreted as referred to the current UCS (User
Coordinate System).

See Getting Started > Import to learn the fast way to import your data.

Below the main families to importable data:

 Import Rec Project
 Load Item
 Import a list of points
 Import external data (file formats)

Import Reconstructor Project

These function imports items from another Reconstructor® project (*.recprj, *.r2s formats are
available). The items data can be copied or moved from the project to be imported.

 Pay attention to the current UCS of the project you are importing into.

Load item

This function allows you to import in the current project a pre-existing item saved in Reconstructor
internal format. The item is not duplicated, copied or moved from its location. It is just listed as
belonging to the project.

With this function, you can load any of the following item types:

 Unstructured point clouds (*.rup)
 Grid point clouds (*.rgp)
 Triangle meshes (*.rtm)
 Cross sections (*.rcs)
 Polylines (*.rpl)
 Trajectories (*.rtr)
 XML item file (*.xml)

These are all Reconstructor® internal formats for items; they are stored in sub-folders of
Reconstructor® main project folder.

 Do not move or delete these files from their own folders, the project may be corrupted
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by this action (items are displayed in grey, in the project tree).

Import a list of points

This function imports a list of points (in *.txt, *.csv, *.tsv formats) with labels and 3D coordinates.

Three formats are available:

 Comma Separated Value (*.csv)
Comma "," is used as separator.
Pt000,-13.9153,-15.7213,11.9317
Pt001,-36.6361,15.7372,6.3014
Pt002,-15.1782,6.6534,8.5348

 Tab Separated Value (*.tsv)
Tab "Space" is used as separator.
Pt000 -13.9153 -15.7213 11.9317
Pt001 -36.6361 15.7372 6.3014
Pt002 -15.1782 6.6534 8.5348

 Text (*.txt)
Tab "Space" is used as separator.
Pt000 -13.9153 -15.7213 11.9317
Pt001 -36.6361 15.7372 6.3014
Pt002 -15.1782 6.6534 8.5348

Parse point list dialog

This dialog implements a general-purpose tool for parsing a text file (*.txt) with a list of points.

The assumption is that each row of the text file contains one point. The dialog allows you to define
how you want to interpret the columns of the text file. In the example above, the first column
contains the label of the point, the three next columns contain the 3D coordinates of the point, and
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columns five and six contain the X and Y coordinates of the point in the range image (or in any
image). 
You can customize the role of each column of the file by clicking on a column and dragging &
dropping it

 In some cases it is useful to invert X and Y columns to adapt the importing reference system to the
project one, when regional conventions are different, by dragging&dropping the column (not selecting
the title row) you want to move in the right order.

 The preview of the list of ponts is limited to the first 5 lines to but the file may contain more.

At the end of the import process, the points are merged in the Points group of the Project Window. 

Import external data (file formats)

To import data from third party formats. The formats are grouped by the way adjacency structure is
preserved, so first select the structure of the data that must be imported. The following dialog allows
to browse and filter the directories by file type. The “Files of type” combo box lists the available
import filters. Since the format filters are based on a plug-in system, this list is extensible and
depends on your software distribution. After the model structure is chosen, a dialog asks you which
files would you like to import. Please filter the files by the desired format type. Multi selection is
possible with shift and control keys.

Import Grid Point
Cloud...
Imports grid point
cloud from disk. Scan
data, organized in
regular row and
columns, from third
parties laser scanner
are supported

Comma Separated Values (*.csv)
DEM ASCII header+matrix (*.asc)
E57 grid point cloud (*.e57) [1]

Generic binary traster (*.*)
Grid Point Cloud Text File (*.txt)
PTX (*.ptx) [1]

Stonex multiple scans (*.x3m)
Stonex point cloud (*.x3s)

Import Triangle
mesh...

3DS (*.3ds)
AutoCAD data exchange format (*.dxf)
COLLADA (*.dae)
PLY mesh (*.ply)
STL mesh (*.stl)
Triangle Meshes Text File (*.txt)
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VRML (*.wrl, *.vrml)
Wavefront OBJ (*.obj)

Import
Unstructured
Point Cloud...

E57 unstructured point cloud (*.e57)
LAS format (*.las)
LAZ format (*.laz)
PLY point cloud (*.ply)
Unstructured Point Cloud Text File (*.txt)
PTS (*.pts)

Import polyline /
trajectory...

AutoCAD data exchange format (*.dxf)
DXF trajectory (*.dxf)
Polyline from point list (*.txt)
Trajectory from point list (*.txt)

Import CAD
Models...

AutoCAD data exchange format (*.dxf)
STL mesh (*.stl)
VRML (*.wrl, *.vrml)
IFC (Industrial Foundation Classes) .ifc

Import F6
handheld scans

F6 handheld scans (.mvx)

 [1]  When importing .e57, .ptg and .ptx structured point clouds formats, you need to choose the grid
layout, in order to correctly import the structure and the 2D image. 

  Different options are available:
o Left to right, bottom to top

This is the most common format and it is suggested to use it for most of the cases. 
o Left to right, top to bottom (vertically flipped), Right to left, bottom to top (Horizontally

mirrored), Right to left, top to bottom (upside down)
Use one of these options only when the data is not standard and the 2D image is upside
down or horizontally flipped.

A preview helps you to easily find the correct option for your data.
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Import CAD models

This function allows you to import in Reconstructor® models from CAD softwares, in order to do
structural analyses or to compare the models with the point clouds.

List of supported CAD formats
You can import CAD models in any of the following formats:

AutoCAD data exchange
format(* .dxf)

You can import meshes written in DXF format, Reconstructor® will
also read their colors and textures.

IFC (Industrial Foundation
Classes) (*.ifc)

You can import models e.g. from Autodesk Revit via the IFC format.
Reconstructor® preserves the model colors (except for the
transparency)

STL Mesh (*.stl) When importing STL files, Reconstructor® asks you the unit of
measure in which the STL vertices are written. Supported units of
measure are: meters, centimeters, millimeters, inches, feet, yards

If the STL file is binary, and if the string “COLOR=” is present in the
first 80 bytes, then Reconstructor® tries also to import the colors of
the STL solid. If not, no color is imported. The standard STL format
does not support colors neither textures. This is only one of the non-
standard formats to write color into STL files
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VRML (*.wrl, .vrml) When you import vrml models as meshes, Reconstructor® will
maintain their colors and textures. Reconstructor® will also ask you
for a scale factor

IFC Import Dialog

Interoperability with Autodesk Revit®

This import tool allows you to import your BIM project realized with Autodesk Revit® inside
Reconstructor®. The BIM entities are converted into meshes and can be compared with point clouds
via the inspection functionality, to get accurate deformation and structural analyses.
From Revit®, just export your project in the IFC format, and then simply drag&drop your IFC file
inside Reconstructor®. The above dialog opens up.

Exclude unneeded entities
BIM projects can be very large and detailed, including furniture elements, railings, windows, etc. For
the sake of inspection, you may want to exclude some project entities because, for example, they
are simply not yet in place in reality. To exclude some entity types, just mark them among the check
buttons that represent the most commonly used IFC entity types. In the screenshot above, for
example, all furnishing elements, railings, ramp flights, sites and “BuildingElementProxy” 's will be
excluded from the import procedure. You can also specify which entity types to include , by selecting
the Include only selected entities radio button. In this case, you have to check at least one entity type
to proceed importing.
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Entities grouping
In the bottom box of the dialog, you have two grouping options: Group everything in a single
mesh and Separate entities by type into different meshes. The first option will merge all your IFC
entities in a single mesh, resulting in a faster inspection procedure. The second option will split your
IFC entities among many meshes, one by entity type. If you choose the second option,
Reconstructor® will create many meshes and put them under the same parent group in the project.
The meshes will be called with the following convention: < IFC file basename>_<IFC entity type>. For
example: “MyBuilding_IfcWall”, “MyBuilding_IfcRoof”, “MyBuilding_IfcWindow”, etc.
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Export

This menu contains a number of options to export Reconstructor® entities in various formats, to be
imported in third-party software or CAD tools for further elaboration.

 Export model as
 Export polyline as
 Export cross section as
 Export UCS to AutoCAD
 Export annotations
 Export pose
 Export to Autodesk ReCap®

 Export point list

Note that when exporting models or other entities, the coordinates are exported as they appear in
the current UCS, if not required by an export settings window.

Export Model as...
This function allows to export a model (models are all point clouds and triangle meshes) in a third-
party format or in an intermediate format, for further processing in external software tools.

Export workflow
If you want to export a given list of models (clouds or meshes) to the same third-party format, after
selecting this function you are presented with a dialog where you can set format-specific options.
Below you find a table with the supported options by format, and with the known limitations of each
format. You can choose whether to specify different export options for each model, or to adopt the
same export options for all models. In the latter case, select Do not ask again in the subsequent save
filename dialog.

Format limitations when exporting global coordinates
Generally speaking, when exporting a model to an external format, Reconstructor® tries to store as
much information as the format allows. Therefore, models are always exported in global
coordinates, meaning the coordinates that the model has in the current UCS. However, some
format do not allow big coordinates for the models' points. Such formats are STL meshes and PLY
meshes. Because of intrinsic limitations of these formats, models exported in these formats are
saved in local coordinates, losing their global position in Reconstructor project.

Export formats options and limitations

Grid Point Clouds
Export format Supported options Limitations

E57 grid point cloud (*.e57)

E57 unstructured point cloud
(*.e57)

Choosing local or UCS
coordinates.
Choosing whether to export the
reflectance, also in a way
compatible with Autodesk
ReCap.
Choosing whether to export a
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color layer and which one.

See more details at Export E57

Generic binary raster (*.*) Choosing which scalar layer to
export.

Grid Point Cloud (*.rgp)

Grid Point Cloud Text File (*.txt)
Grid Point Cloud CSV File (*.csv)
Grid Point Cloud TSV File (*.tsv)

Unstructured Point Cloud Text
File (*.txt)
Unstructured Point Cloud CSV
File (*.csv)
Unstructured Point Cloud TSV
File (*.tsv)

Choosing object or UCS
coordinates.
Setting a subsampling factor for
the exported cloud.
Choosing the saved number of
decimals.
Choosing whether to export a
color layer and which one.
Skipping the depth
discontinuities or not.
Skipping the orientation
discontinuities or not.

LAS/LAZ format point cloud
(*.las, .laz)
[unstructured]

Choosing local or UCS
coordinates.
Choosing whether to export the
reflectance, also in a way
compatible with Autodesk
ReCap.
Choosing whether to export a
color layer and which one.

PLY point cloud (*.ply)
[unstructured]

Selecting whether to export
local or UCS coordinates.
Selecting whether to export a
color layer and which one.
Selecting whether to export
point normals or not.
Selecting the storage mode
among ascii, binary little endian,
binary big endian.
Selecting the coordinate
precision between float and
double.

If the model to be exported has
too big UCS coordinates (more
than 100 km), Reconstructor will
not export it in UCS coordinates,
because of PLY format
limitations.

PTX point cloud (*.ptx)
[structured]

Choosing a subsampling factor.
Choosing which color layer to
export.
Choosing whether to skip depth
discontinuities.
Choosing whether to skip
orientation discontinuities.
Choosing whether to export a
PNG image of the selected
color.
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PTS point cloud (*.pts) Choosing object or UCS
coordinates.
Setting a subsampling factor for
the exported cloud.
Choosing the saved number of
decimals.
Choosing whether to export a
color layer and which one.
Skipping the depth
discontinuities or not.
Skipping the orientation
discontinuities or not.

Unstructured Point Clouds
All the exported point clouds will be in an unstructured format.

Export format Supported options Limitations

E57 unstructured point cloud
(*.e57)

Choosing local or global
coordinates.
Choosing whether to export the
reflectance, also in a way
compatible with Autodesk
ReCap.
Choosing whether to export a
color layer and which one.

LAS/LAZ format point cloud
(*.las, .laz)
[unstructured]

Choosing local or UCS
coordinates.
Choosing whether to export the
reflectance, also in a way
compatible with Autodesk
ReCap.
Choosing whether to export a
color and which one.

PLY point cloud (*.ply) Selecting whether to export
local or UCS coordinates.
Selecting whether to export a
color layer and which one.
Selecting whether to export
point normals or not.
Selecting the storage mode
among ascii, binary little endian,
binary big endian.
Selecting the coordinate
precision between float and
double.

If the model to be exported has
too big UCS coordinates (more
than 100 km), Reconstructor will
not export it in UCS coordinates,
because of PLY format
limitations.

Unstructured  Point Cloud (*
.rup)

Unstructured Point Cloud Text
File (*.txt)

Choosing object or UCS
coordinates.
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Unstructured Point Cloud CSV
File (*.csv)
Unstructured Point Cloud TSV
File (*.tsv)

Setting a subsampling factor for
the exported cloud.
Choosing the saved number of
decimals.
Choosing whether to export a
color layer and which one.
Skipping the depth
discontinuities or not.
Skipping the orientation
discontinuities or not.

PTS point cloud (*.pts) Choosing object or UCS
coordinates.
Setting a subsampling factor for
the exported cloud.
Choosing the saved number of
decimals.
Choosing whether to export a
color layer and which one.
Skipping the depth
discontinuities or not.
Skipping the orientation
discontinuities or not.

Meshes
Export format Supported options Limitations

3DS (*.3ds) Supports mesh textures. It is not possible to save meshes
with more than 65536 vertices
or more than 65536 triangles.

AutoCAD data exchange format
(*.dxf)

Does not support mesh color or
mesh textures.

COLLADA (*.dae) Supports mesh textures.

PLY mesh (*.ply) Selecting whether to export a
color layer and which one.
Selecting whether to export
local or UCS coordinates.
Selecting whether to export
point normals or not.
Selecting the storage mode
among ascii, binary little endian,
binary big endian.
Selecting the coordinate
precision between float and
double.

If the model to be exported has
too big UCS coordinates (more
than 100 km), Reconstructor®

will not export it in UCS
coordinates, because of PLY
format limitations.
Does not support mesh color or
mesh textures.

STL mesh (*.stl) Does not support mesh color or
mesh textures.
Only local coordinates are
saved, the model global
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positioning is lost.

Triangle Meshes (*.rtm)

Triangle Meshes Text File (*.txt) Selecting whether to export
local or global coordinates.
Choosing the saved number of
decimals.

VRML (*.wrl, *.vrml) Supports mesh textures.

Wavefront OBJ (*.obj)

Export E57 point cloud format
The E57 point cloud format allow you to add some useful  information to the exported object.

First of all, it's possible to export the point cloud as 
 E57 grid point cloud (*.e57)
 E57 unstructured point cloud (*.e57)
according to the original data in the project.

Export data layers
There is the  possibility to export the the Reflectance color layer and another layer chosen by the
user from those available. Also the color for invalid points can be exported, if desired.

Point normals
A surface normal vector is added to each point to indicate the surface orientation.

Compared to other export format one main feature is added.

Export Projectors
 Export Projectors: by flagging this option you can export panoramic projectors that are

"children" of the point cloud, as equirectangular 2D image embedded in the .e57 point cloud,
keeping the same relative position cloud-camera as in the Reconstructor project.
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Export polyline

This option allows you to export a set of polylines to the DXF format, to be read for example in
AutoCAD. When selecting this function, you are asked to select the output filename. After that, you
are asked to provide the decimal precision that the polyline's points should have.
You can specify a distinct output filename and decimal precision for each polyline. Otherwise, in the
select file dialog you can check Do not ask again and you will set the decimal precision only once for
all the polylines. The filename will be also assigned automatically.

Export cross section as
This option allows you to export a set of cross sections to the DXF format, to be read for example in
AutoCAD. When selecting this function, you are asked to select the output filename. After that, you
are asked to provide the decimal precision that the cross sections' points should have.
You can specify a distinct output filename and decimal precision for each cross section. Otherwise, in
the select file dialog you can check Do not ask anymore and you will set the decimal precision only
once for all the cross sections. The filename will be also assigned automatically.

Export UCS to AutoCAD

This function exports an User Coordinate System to AutoCAD. The UCS is saved as a .SCR file, a
script that can be loaded in AutoCAD.
To import an UCS in AutoCAD, type _script, enter, select the script file and open it. The imported UCS
is set as current and the top view is applied.
Or drag'n'drop the *.scr file into the cad drawing to recreate the UCS.
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Export annotations

This function exports a set of point annotations obtained with the Annotation tool.

After selecting one or more Annotations in the Project Window, use the Export > Export Annotations
command to  exports a list of points (in *.txt, *.csv, *.tsv formats) including labels and coordinates (in
the current UCS).

In the exported file, your annotation will be organized as the example below.

Annotatio
n ID

Annotation
Name

X Y Z Color
mapped
layer

Value (*) Comm
ent

Hyperlink

880 Reflectance:
0.380

6.257 3.56
8

2.697 Reflectance 0.380 880 Grids/test_1000_1_s
ub2.rgp

881 Reflectance:
0.428

6.473 1.08
4

2.232 Reflectance 0.428 881 Grids/test_1001_1_s
ub2.rgp

882 Reflectance:
0.382

6.496 6.41
1

2.690 Reflectance 0.382 882 Grids/test_1000_1_s
ub2.rgp

883 Annotation (1) 5.797 4.30
9

2.694 Inclination 0.023 0.026 -
0.999

883 Grids/test_1000_1_s
ub2.rgp

884 Annotation (2) 7.745 3.63
0

2.698 Inclination -0.026 -0.002
-1

884 Grids/test_1000_1_s
ub2.rgp

885 Annotation (3) 7.682 6.20
4

2.694 Inclination 0.001 -0.037
-0.999

885 Grids/test_1000_1_s
ub2.rgp

(*) one value for scalar color layers (e.g. reflectance), three RGB components for not scalar layers
(e.g. color, inclination).

Export pose

This is a very useful function for registration workflows. It allows to safely store in a separate folder
positions and orientations of your project items, in order to recover them if and when needed.

When pre-registering, registering, geo-referencing or moving around your models, you may want to
backup the model's positions and orientations (poses) before changing them. If something doesn't
work in the registration algorithm, or in changing the models' poses, you can safely restore the
poses as they were before the action.

When you activate this function, the poses of the selected items are saved in the Results/poses
folder, in a folder called with the name pattern PoseFiles_aaaa.mm.dd_hh.mm.ss_xxx. This way, you
can easily read the precise date and time of creation of the poses, for future use.
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To restore any item's pose, use the pose transform dialog.

Export to Autodesk® ReCap®

Reconstructor® can directly export point clouds in a .rcp project format for a more complete and
faster integration with the Autodesk® ReCap® software.

After selecting the point clouds in the Project Window, you can directly select the Export > Export to
Autodesk® ReCap® command from the contextual menu (or from File > Export menu) .
The following dialog displays the list of selected point clouds.
For each of them you can select the point cloud's Color layer to export which will be exported as
"RGB" of the "Color Mode" of ReCap®. "Reflectance" and "Inclination" color layers, if present, will be
automatically exported in the respective "Intensity" and "Normal" color modes of ReCap®.
After confirmation, you have to select the destination directory where the project files
"recap_project.rcp" and a "recap_project Support" subfolder (including .rcs files of the individual
clouds) will be saved.
When export process is finished, a successful message will appear, giving you the possibility to
directly open the export folder.

 There is no limit on the number of exported clouds.

 When exporting structured clouds with/without associated camera, the RealView visualization is
available; take note that you cannot see the invalid points colorization.

 No ReCap® license is required on the same PC.

 The command is not available for Trial and Viewer versions of Reconstructor®, as all export
commands are prevented.



Online Help Reconstructor 4.4

112 / 361

Navigation menu
Reconstructor® provides many interaction styles to navigate in the 3D scene.
The navigation modes are selectable through the Navigation toolbar (placed on the right, most used
commands) or by Navigation command in the top menu and are grouped by type:

 Predefined views
 Navigation modes
 Screen settings
 Create UCS from point list

In the contextual menu of items other commands are available:

Go to
To center the 3D window to the bounding box of the model. The view point is computed so
that to contain the whole bounding box in the viewport. Warning: this could place
sometimes the model far away, with the effect that it seems not visible. Therefore increase
the max depth in the Options.
This tool is very useful when you have loaded many objects and want to go quickly and
easily to a specific one.

Center to local origin
The view point is aligned to local coordinate frame of the model, with X rightwards, Y
upwards and Z going out of the screen.

Align to bounding box
The view point is aligned to the desired face of the bounding box of the model.

In View Parameters dialog you can customize advanced parameters of the current view by
controlling how the “virtual eye” sees the 3D scene with all your models. 

After creating an item, it is highlighted and focused in the Project window and in the 3D
window. If the item is included in a group, the group will be automatically opened. (e.g. after point
creation with Alt+double-click LMB the point is inserted and automatically focused in Project
window).

Shortcuts

To focus and zoom in on a particular item you can:
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 select the item in the Project Window and use the GoTo command in the
contextual menu

 select the item in the Project Window and double click with the scroll wheel
anywhere in the 3D window

 select the item in the Project Window and use the  Predefined Views>Default
View command

Double-clicking with LMB (primary button) on a point in the 3D window, the item
to which the selected point belongs is highlighted in the 3D window and in the
Project window. If included in a group, the parent groups are automatically
opened.

Ctrl + Holding Ctrl + double-clicking with LMB (primary button) on a point in the 3D
window, the item to which the selected point belongs is added in a multiple
selection, highlighted in the 3D window and in the Project window. The 3D view is
focused on the last selected item.  If included in groups, the groups are
automatically opened.

Double-clicking with RMB (secondary button) on a point in the 3D window, the
item to which the selected point belongs is highlighted  in the 3D window and in the
Project window, while the context menu appears.          

Ctrl + Holding Ctrl + double-clicking with RMB (secondary button) on a point in the 3D
window, the item to which the selected point belongs is added in a multiple
selection, highlighted in the 3D window and in the Project window. The 3D view is
focused on the last selected item , while a common context menu appears.

Predefined views

Default view
This navigation mode allows the user change the current view so that all the selected items

are completely visible in the 3D scene.

Bubble view
This navigation mode allows the user to place the current view to the center of an item.
Only camera rotations are allowed in this mode.
See also Bubble mode. 
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2D view
This navigation mode opens the Edit 2D Grid Window. Note that this view is supported for

grid point clouds only.

Map view
This navigation mode places the view so that all the selected items can be seen from a top

view.

Slice view
This navigation mode automatically switches the view to orthographic mode and alignes it to
the selected items bounding box vertical plane.

This mode can be used to check the correct alignment along a vertical section of the displayed items.
The depth of the slice can be changed from the Display and navigation Options dialog.
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Keyboard/mouse
movement

Effect

LMB + move mouse
Rotate the around the
selected items vertical (z)
axis

CMB + move mouse Translate sideways

 Mouse wheel rotation
Translation towards point
indicated by the mouse

Horizontal Section View
This navigation mode automatically switches the view  to orthographic mode and alignes it to
the selected items bounding box horizontal plane.

This mode can be used to check the correct alignment along an horizontal section of the displayed
items.
The depth of the horizontal slice can be changed from the Display and navigation Options dialog.

Keyboard/mouse
movement

Effect

LMB + move mouse
Rotation the around the
selected items vertical (z)
axis

CMB + move mouse Translation sideways

 Mouse wheel rotation
Translation towards point
indicated by the mouse
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UCS views
This navigation mode places the view so that all the selected items can be seen from an

according to UCS view:

Navigation modes

Pivot mode
Default navigation mode based on translating and rotating around a chosen point of the 3D
scene
Walk mode
Navigation mode that allows you to translate and rotate around yourself, independently of
the models
Bubble mode
Navigation mode in which only rotations around yourself are allowed

Zoom
Narrows down the virtual camera's field of view to concentrate on a particular viewport. It
doesn't move the virtual camera
Move to viewport
Moves the virtual camera so that a particular viewport is in sight, without changing the field
of view
Recent camera positions
Recovers up to 30 steps you went through during your navigation

Pivot Mode

In this mode a point can be selected as a rotation pivot. The pivot is set by a left button click on a valid
point of an object.
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Keyboard/mouse
movement

Effect 

LMB + move mouse 
Camera rotation around
the pivot

CMB + move mouse
Camera sideways
translation, pan

RMB + move mouse
back/forth

Camera dollying, forward
and backward along the
current focal axis

Mouse wheel rotation
Translation towards point
indicated by the mouse
pointer

Shift + LMB + move mouse
left/right

Camera rolling

LMB click on a model's
point

Selection of rotation pivot

Shift + mouse wheel
rotation

Zoom in and out (change
of field of view)

Alt + LMB double click
Selection of points for
point list window

Shift + CMB + mouse
move

Draw rectangle to move
into
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Walk mode

This mode is designed to simulate a human being walking around the 3D scene. The user can make
translation movements with the keyboard and mouse movements with the mouse.

Keyboard/mouse
movement

Effect

LMB + move mouse Camera rotation

w, x, a, d keys
Move forward, backward,
left, right

q, z or +, - keys Move up, down

Bubble mode

This mode is designed to simulate a human being walking around the 3D scene. The user can make
translation movements with the keyboard and mouse movements with the mouse.
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Keyboard/mouse
movement

Effect

LMB + move mouse
Camera rotation (pan and
tilt)

Mouse wheel rotation
Zoom in and out (change
of field of view)

Shift + LMB + move mouse
left/right

Camera rolling

Alt + LMB double click
Selection of points for
point list window

Key 'c'
Copy readout window's
contents to clipboard

Zoom Tool

This tool allows the user to zoom on a specific part of the scene.

The tool can be used by following these steps:
 Press the "zoom" command under the Navigation menu.
 Drag the mouse while pressing the left mouse button to draw a rectangle in the 3D view.
 Release the mouse: the camera zooms into the new defined viewport. The system then changes

back to the last navigation mode used.

Difference with respect to the Move to viewport tool
With the zoom tool the camera is zoomed-in a detail of the scene. Only the field of view (in
perspective mode), or the projection size (in orthographic mode) is changed.
With move to viewport, the camera is translated closer to the detail indicated by the rectangle,
leaving the field of view unchanged.

Move to viewport

This tool moves the viewport to a specific part of the scene.

The tool can be used by following these steps:
 Press the "move to viewport" command under the Navigation menu.
 Drag the mouse while pressing the left mouse button to draw a rectangle in the 3D view.
 Release the mouse: the camera translates the new defined viewport. The system then changes

back to the last navigation mode used.

Difference with respect to the Zoom tool
With the zoom tool the camera is zoomed-in a detail of the scene. Only the field of view (in
perspective mode), or the projection size (in orthographic mode) is changed.
With move to viewport, the camera is translated closer to the detail indicated by the rectangle,
leaving the field of view unchanged.

Recent camera positions
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When navigating your models in the 3D scene, it can happen that your make mistakes, you lose your
models, or you lose the position you reached. You can use this function to “go back to your steps”.

Reconstructor® keeps in memory the last 1000 camera positions through which you navigated.
Through this dialog, you can browse them and go back to your previous steps, restoring useful views
on your models when you lost them.

Screen settings

Show axis
To show/hide the coordinate system frame of the current camera global reference (CCGR)
in the bottom left corner of the 3D scene.
Show bounding box
To show/hide the bounding boxes of all items in the 3D scene.

Color by ID
To render all the project entities with their identifying color ID. The color ID of a point cloud
can be changed from the property window.
This option is useful to distinguish the models from each other and to know which model is
which in the 3D scene.
(Display and navigation) Options
To modify current navigation and rendering parameters.

Light settings
To set shadow and lightening options.

Display and navigation options
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Max points to load to GPU (millions)
This option is used to set a maximum number of point to be rendered in the 3D scene. The limit is
cumulative for all the loaded point clouds. It depends on the characteristics of the graphics card.

 Each loaded cloud is divided into 200,000 points buffers and, based on the user points budget,
the number of buffers to be rendered is calculated.
It is always ensured that at least one buffer for each cloud is rendered. So it never happens that the
user does not see clouds loaded, but, on the other hand, it is possible that the maximum budget set
by the user (Max points to load to GPU) is exceeded.

Limit points for Orthophoto to ... (millions)
Check this option and set a value to limit the maximum number of points (belonging to the flagged
and loaded point clouds) used snapping an orthophoto (or Virtual Scan). It depends on the
characteristics of the graphics card. This limit is not concerning the X-ray orthophotos and
Blueprints. 

Movement speed
This option sets the translation speed when panning in pivot mode. It is an adaptive parameter, for
the most part the default value (1) should be fine.



Online Help Reconstructor 4.4

122 / 361

Slice views thickness
This option sets depth of a single slice when using the Slice view or the Horizontal section view.

Set  background gradient
Change the uppermost and lowermost color of the background of the 3D rendering window.

Object reference frame size
All models and cameras can draw their local coordinate frame by enabling Draw coordinate frame
property in the Property Window. Here the frame size (in meters) is specified to improve its visibility
accordingly to the extent of the scene.

Pivot mode controls
Here you can select two options: “Reconstructor” and “3-button mouse”. These options are two sets
of controls for the Pivot Mode. The second one is the default and is described here.
If you  select “Reconstructor”, then in pivot mode the following controls apply:

 Rotate: To rotate the model around the pre-defined center of rotation (pivot), move the
mouse within the 3D window while keeping the left button pressed.

 Pan:  To pan the model in X and Y, move within the 3D window while keeping the left
button and the Shift key pressed.

 Zoom: To translate the model along the Z-axis, move the mouse within the 3D window
while keeping the left button and the [Ctrl] key pressed or use [Ctrl + mouse wheel] to
zoom in and out along the Z-axis. In the latter case, if the mouse pointer hovers a valid 3D
point, the zoom converges to that point.

 Change pivot: double-click the left mouse button plus [Ctrl+Shift ] on a valid 3D point.

Bounding box colored with colorID
When this option is checked, the bounding boxes of the project items are colored based on the
item's colorID. If this option is unchecked, the bounding boxes are colored with the default (yellow)
color.

Enable human movements while rotating
When this options is checked, a small human avatar appears in the bottom-left corner of the 3D
rendering window. While you navigate in the 3D scene, you will experience that after doing many
rotations, your viewing direction will still be oriented according to the vertical axis and to the
horizontal plane defined by the current UCS. This is like a human being that, after rotating his head
around his neck in many directions, when relaxing the head will go back into the natural position,
which is in line with the spinal chord.
When this option is unchecked, while navigating the 3D scene you will experience that after some
rotations the reference to the UCS's horizontal plane is lost, and that you are floating in the space
like an astronaut floats among meteors, without gravity force.

Draw Annotations to 3D scene sides
Annotations will be arranged on the sides of the render window, at the exact insertion point.

Render models' normals
View vectors that describe the normals directions for point clouds and meshes, if they have been
computed.

Blend models' Color ID on their current color
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It blends the color layer (reflectance, confidence...) whit the Color ID. This two features are available
in the Property Window.

Hide backfacing points
This setting hides the points that are oriented in the opposite direction to the current point of view.
The orientation is calculated according to the point normal. The surfaces scanned from a point
opposite to the current point of view will be hidden. 
For example, if you scan a room, the ceiling seen from above (therefore from outside) is made
transparent and you can see the inside of the room.

The effect is equivalent to the Cull face of meshes, but applied to point clouds.

 This setting has no effect if the clouds do not have the normals.

Splat rendering
This setting enables / disables the rendering of point clouds through circular elements (splats) with
the aim of reconstructing the surface of the point clouds,  covering the "holes" given by discrete
sampling.

 The point cloud normals must be calculated for splat rendering to take effect. It is also possible
to make the rendering more precise by calculating the radius of influence of each point using the
Point RadiusExtraction filter. The radius of the splat also depends on the percentage of points
rendered.

Click on Reset to default button to reset to default parameters.

See also Light Settings options.

Light settings

The 3D visualization of point clouds and meshes can be modified changing the Light effects settings.
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Scene Light

Enable light 
This setting enables / disables all light effects in 3D scene. Disabling light effects also lets the
application to use less graphics and memory resources.

Reflections
This setting enables / disables the specular components of the projected light. This setting can be
useful to enhance some fine details while navigating the rendered models.

Rear surfaces lighting
This setting enables / disables  the lighting of surfaces that have normals opposite to the point of
view direction.
The Intensity changes the overall strength of the 3D scene light.

Ambient occlusion effect

Enable ambient occlusion
This setting enables / disables a special rendering effect which attempts to simulate the shading
effect of a light coming from the user perspective by computing light attenuation due to
occluded volumes. The resulting model shading is a blend between the model current color



Online Help Reconstructor 4.4

125 / 361

layer and the computed light attenuation factor.

Show ambient occlusion only
This setting renders only the computed ambient occlusion factor (light attenuation). The
resulting model color is not blended with its current color layer. This setting is only available if
ambient occlusion is enabled.

Shadow contrast
This setting changes the ambient occlusion computing parameters to make the resulting shadow
more (or less) intense. This setting is only available if ambient occlusion is enabled.

Eye Dome Lighting (EDL) effect

Enable EDL
This setting enables the EDL, a lighting technique that highlights the discontinuities of the
surfaces making the edges of the displayed surface more or less dark depending on how far the
foreground surface is from the background one.
As you increase the Intensity, the edges will be more marked.

Click on Reset to default button to reset to default parameters.

View Parameters
This window appears when the user hovers the mouse on the View parameters button in the top
toolbar. If you click on the button the little window remain visible.
Here the user can customize advanced parameters of the current view.

   

This window allows you to control how the “virtual eye” sees the 3D scene with all your models.
There are two viewing mode: the perspective mode (shown on the left image) and the orthographic
mode (on the right image).

Perspective projection
In perspective mode, the virtual eye uses a perspective projection to see the scene, and you can set
the amplitude of the projection by specifying the “Vertical FOV” (field of view) in degrees. Decreasing
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(increasing) the field of view is equivalent to zooming in (out) with the objective lens of a camera.

Orthographic projection
In orthographic mode, you see the 3D scene through an orthographic projection, and you can specify
the “vertical size” in meters of your projection.

Cut planes
Near plane: distance of near clipping plane in meters. Specifies the minimum rendered depth. In
perspective mode only values greater than zero are allowed.
Far plane: distance of far clipping plane in meters. Specifies the maximum rendered depth. Must be
greater than Near plane.

To optimize the depth accuracy try to keep these values as close as possible to the desired scene
depth range. If your model's bounding box is 100 x 100 x 100 m, it is not useful to adopt a far plane
of hundreds of kilometers.

Auto Adjust
If flagged, near and far plane are automatically computed, based on the distance between camera
and pivot: the near plane is set at 1/100 and the far plane is set at 50 times the camera-pivot
distance. It only applies to perspective mode.

You can save the current settings by the Place here a survey point function.



Online Help Reconstructor 4.4

127 / 361

Data management 
In Reconstructor® several processing tools are achievable and grouped by:

 LineUp
 Selection & Editing
 Cloud processing
 Meshing
 Geometric shapes
 Photo & Color

You can find most used tools also in the Top Toolbar.

LineUp®

LineUp® is a tool in Reconstructor® that easily allow you to:
 Import 
 Preprocess
 Register 
 Georeference 

any set of points clouds (both unstructured and structured -grid- point clouds) and meshes.

In general, your workflow is assisted by following the steps here illustrated:

In the Top toolbar you can find the most used commands, grouped by main processes:

Save Project 
This function saves the current project, safley storing all the project items, their
load/unload state, their properties, the current 3D camera pose, etc.
It is advised to save the project frequently, especially before long processing operations.
Import point clouds
To import every point clouds format supported by  Reconstructor®.

Wizard
To open the Scan Processing Wizard  and import, preprocess, preregister and register any
set of scans you are importing in LineUp® tool.
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Cloud-to-cloud (and mesh) registration
To register the imported scans. This command includes both pre-registration process and
fine registration

Target-based registration
To register the imported scans by using targets and control points, flat circular targets or
spheres.

Georeferencing
To georeference the models by using known control points.

UCS & positioning
To create and edit User Coordinate Systems and the position of the 3D models in it.

Cloud processing
To filter and manage point clouds by merging, simplifying and modifying them. 

Targets, annotations and points conversion

Scans Processing Wizard

You can access it at the beginning of your work, by dragging&dropping the point clouds (you want to
import and process) in the 3D window or in a second time, by clicking the LineUp>Wizard command.

This wizard allows you to:
 Import
 Preprocess
 Preregister 
 Register 

any set of scans in LineUp® tool.
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You must simply follow the subsequential instruction to import, preprocess and register point
clouds.
By clicking on More Settings the Wizard Settings will appear.

Scans Processing Wizard

By opening it you can directly change the settings used to import, process and register the
clouds.
These settings are subdivided in tabs, related to the following processes:

 Importing
 Preprocessing
 Preregistration 
 ICP registration
 Bundle Adjustment 

These processes are managed by properly setting the parameters for each analysis step.

Importing
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Preprocessing
Reconstructor® recognizes the file format and applies default parameters for preprocessing. 
If you performed your scans using a Stonex laser scanner, you can leave "Stonex" as scanner model.
The filters are detailed in Pre-processing page.
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Preregistration 
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ICP registration
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Bundle Adjustment 
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Manage settings
Through the buttons in the lower part of the Wizard window the parameters settings can be
managed.
 Save settings/Save all tab's settings: to save current settings in a .xml format ( by default in

Settings folder);
 Load settings/Load all tab's settings: to load previously saved (even by a third party) settings in a

.xml format ( by default the upload folder is the Settings one);
 Reset to default/Reset all to default: to reset the current settings to the default ones;
 Options
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1. Not flagging options: the settings of the current Reconstructor® session are kept and they are
temporarily saved in registry keys. Closing and reopening Reconstructor® the parameters return
to default values.
2. Flagging only the first option: the settings of the current Reconstructor® session are kept and
the parameters are saved in the Settings folder (.xml) at each modification. Closing and
reopening Reconstructor® the parameters return to default values, but keeping the possibility to
load previously saved settings. Specific parameters can so be saved for each project.
3. Flagging only the second option: the same parameters are used for all the projects; the
settings are saved in the registry keys and I cannot keep track of them in the .xml files as
selecting the first option. The parameters are global and persistent inside Reconstructor®.
4. Flagging  both options the sum of the effects is obtained: the parameters are global and
persistent and you can keep track of their modification and use them as needed.

Cloud-to-cloud (and mesh) registration
The LineUp® tool includes a comprehensive suite of tools for coarse and fine registration of any
amount of scans (and not only). The registration process is composed by several steps,
depending on adopted survey techniques.

The general flow, here illustrated

starts from a  preregistration step that allows you to compute a rough alignment between the
imported models. The alignment can be later refined using ICP registration and Bundle
Adjustment to choose and refine the good ICPs and discard the wrong ones, in order to reduce
the global registration error. 

See Getting Started -> Register to learn how to use the The LineUp® registration tools.
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See Getting Started -> Georeference to learn how to use the The LineUp® georeferentiation tool.

Registration
 Automatic, target-free preregistration
 Automatic, target-based registration
 Manual pre-registration
 ICP registration
 Bundle Adjustment
 Scan alignment per groups

Georeferencing
 Point cloud georeferencing
 Manage control points
 Manage circular targets

Positioning
 Pose transform
 Determine the cloud's vertical direction
 Manual positioning (adjust Pose)

Automatic Target-free Pre-registration
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This dialog enables a very
effective and fast procedure
that preregisters a set of
scans automatically, without
using targets or markers.

This dialog enables a very
effective and fast procedure
that preregisters a set of
scans automatically, without
using targets or markers.

Here you can select the
unique Reference scan that
will be fixed.

Show more options >>

Features
 No limits on the number of scans to preregister. You can preregister 200 scans at the

same time, the software will load at most two of them at a time.
 Easy convergence with automatic search of best overlap. To be registered together,

the minimum overlap of two scans is 20-30% of their surface. However, in most cases you
don't have to care about it, because of the following: given a set of N scans, the algorithm is
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guaranteed to find all the scan pairs that match together, and to use the best overlapping
N-1 scan pairs to preregister your dataset. You can customize this behavior via the
"Maximum distance in scan sequence" option.

 No point density requirements. The algorithm adapts to the specific datasets, being it
close-range indoor, or long range territorial data.

 No complicated parameters to input such as cell size or fitting strategy. You only
specify if your dataset contains "construction" or "territorial" data: the algorithm will
change accordingly the surface elements to look for and to match.

 Very fast because of parallel computing: the algorithm is guaranteed to do all
computations in parallel, using all the cores your CPU has (unless you don't tell Windows to
assign less cores to Reconstructor®).

 Robust against symmetric datasets. In case of rectangular empty rooms, stairs, or other
symmetric datasets, Line Up Pro is guaranteed to quickly let you browse multiple
preregistration solutions, and therefore to help you quickly find the right preregistration of
your scans.

 Easy to set constraints. You can easily set constraints on the scan vertical. If you know
that the scans are already on their vertical (with a confidence of 2-3°), you can tell the
algorithm to leave the scans' vertical unchanged. If you don't, LineUp Pro will also esteem
the scans' vertical, with the guarantee to correct angles between the given vertical and the
correct one of max. 30°. As additional constraint, you can select which of the input scans is
the reference scan during the preregistration.

 It works for virtually all datasets. This automatic preregistration technique has been
tested with hundreds of different datasets containing from 10 to 200 scans per dataset. It
gets your scans in a state of coarse registration without your intervention, or with very few
easy corrections at the end.

Parameters
Here we give a top-to-bottom description of the parameters that you can set in the dialog.

 Data Type: here you can specify if your datasets relates more to a construction scene,
with many planar surfaces, or if it relates more to a mining/terrain scene, with many
irregular surfaces. This will greatly help the algorithm.

 Speed vs precision: this algorithm is designed to be fast in first place, and to deliver a
solution in minutes or tens of minutes. We advice to leave this option to “Fastest” and to
switch to the other two options only when the first does not work. The other two options
indicate the algorithm to search for more matches between smaller surface elements.
This leads in general to better results, but in some cases it can also spoil the results
because it introduces more candidate matches for the final solution and therefore more
ambiguities.

 Preregistration from sketch. By flagging this option, you tell the algorithm that you want
to help it by creating a “sketch”, or a drawing with the approximate relative positions of the
scans. To create or load a sketch, press the Create/Load sketch button. The Sketch
Window opens for you to create the sketch.

 Assume vertical is correct. Some laser scanners feature an internal inclinometer, and
therefore they are able to create raw scan data where the vertical is already correct, with
an error of 2-3 degrees. If this is the case, then you can flag this option and the algorithm
will match the scans without changing their initial vertical. If this is not the case, the the
algorithm will also esteem the correct vertical before matching the scans. Please take into
account that the maximum error in the vertical that can be corrected is 30 or 40 degrees.

 Save poses before preregistration. If you flag this option, Reconstructor® will
automatically save the scans' poses in the Export/ project folder before starting the
automatic preregistration. In this way, you will be able to easily go back to those poses
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before the preregistration, with the function Tools→Pose and registration → Pose transform
→ Apply pose from file.

 All scans are tripod (no hand-held or mobile). Flag this command if you're using tripond
laser scans

 Maximum distance in scan sequence. This parameter determines how many scan pairs
the algorithm will try to match. It specifies the maximum distance in the scan sequence
that two matchable scans may have, and it defaults to 10. For example: given an input
sequence of 30 scans, Reconstructor® will try to match scan 5 with all the following
[nearest], until scan 15. Scan 5 and scan 16 will not be matched because Reconstructor®

will assume that they are too far away in 3D, being far away in the sequence. Generally
speaking, given an input sequence of N scans and this parameter set to M, then
Reconstructor® will try to match scan s only with the M preceeding and the M following it in
the input sequence, considered as a circular sequence (scanN matches scan 1).

Sketch Window

This dialog enables a very effective and fast procedure that preregisters a set of scans automatically,
without using targets or markers.

This window enables creation, editing and handling of preregistration sketches, created in
Reconstructor®. Preregistration sketches are needed to describe the approximate relative positions
of a set of scans, to give an initial hint to Line Up's automatic target-free preregistration. However, it
is not compulsory to create a preregistration sketch to run the automatic target-free preregistration.
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Usefulness
Creating or loading a preregistration sketch is useful mainly to speed up the automatic target-free
preregistration : in fact, if the scans' approximate relative positions are known, the automatic
preregistration algorithm will match only the scan pairs that belong to the registration graph: the
blue polyline connecting the scans in the upper picture. Therefore, to preregister N scans the
algorithm will match only N – 1 scan pairs instead of trying all the combinations, which can result
in N ( N – 1) maches. Therefore, automatic preregistration will be faster and will aim at the right
solution more directly, avoiding matching the wrong scans with the subsequent ambiguity and
confusion.
Another usefulness lies in keeping a sketch of your scans' positions. Yet another advantage of this
window lies in the possibility of setting which scan is the reference scan, and optionally which scans
should not be used during the registration.

How it works
In the main area of the sketch window, the sketch is shown. The scans are represented as icons on
the sketch related to the scanner model. Below each icon, the scan name and the scan registration
role are found. The registration role can be selected among three:

 Reference scan. The scan is not moved during the automatic preregistration.
 Moving scan. The scan will be preregistered against the others during the preregistration.
 Scan not used. The scan will not be preregistered. This is useful if you acquired scans that

are not useful for the preregistration, like hi-resolution scans of small targets, or test scans.
Just drag the scan icons around the sketch to change their position. You can change the scans'
registration roles via the Edit registration roles  button on the left.
On the left, some buttons are present.

 Open sketch, save sketch, save sketch as. These buttons manage your sketch files,
which have a “.sketch” suffix. You can create a preregistration sketch from scrath and then
save it.

 Show registration graph. Toggle this button to show or hide the blue polyline that
represents the best registration open sequence for your scans. Move the scans so that the
registration graph is the best possible.

 Edit registration roles. Click this button to change the registration roles for each scan, as
explained before.

 Sketch is Ok. Select this option to close the sketch window and to go back to the control
dialog for starting the automatic preregistration taking as input the edited sketch.

 Cancel. Select this option to close the sketch window and go back to the automatic
preregistration dialog without using the sketch.

Manual Pre-registration

 Manual Pre-registration (among grid point clouds)
 Manual Pre-registration (among models)

Manual Pre-registration (among grid point clouds)
The pre-registration technique allows you to manually compute a rough alignment between two grid
point clouds. The alignment can be later refined automatically, using ICP registration.

Accessing the preregistration dialog
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You can access this dialog from the button Registration in Reconstructor®'s top toolbar.

Defining the reference and the moving grid
From the list of grids in the dialog, choose the reference model and press Set reference grid, then
select the grid to move and press Set moving grid. The two grids appear as range images on the
right and left panel of the dialog respectively.

Finding corresponding points
The preregistration procedure works by finding three couples of corresponding points among the
reference and moving grids. If needed, you can register one moving grid to more reference grids: to
do so, change the reference grid to another from the loaded ones, the image-grid point pairs are
stored for each grid, and are accumulated.

Keyboard/mouse event Effect

LMB double click Selects a point. Selected points are listed in the
tables moving grid and reference grid at bottom
of the dialog

Mouse wheel rotates Zooms the range image in/out centering on the
hovered point

Key 'z' Toggles the Zoom views shown at the bottom of
the screenshot

Ctrl + LMB + move mouse Moves the zoomed region inside the global view

Space bar Rotates the range image of 90°

Shift + LMB + move mouse Translates the range image

RMB on a selected point Deletes the point

LMB on a point + move mouse Moves the point around

Alt + central mouse button Fit image to window

Alt + RMB Reset image to original size

When three or more couples of points are selected, the table error per point shows the alignment
error per point couple. The mean registration error is instead shown at bottom left of the dialog. In
general a pre-registration error of 2 cm is acceptable. However, this depends on the scale of your
project and of the final output you want to get. If a point couple introduces too much error, you may
try to move slightly around the points after zooming on them, to improve that couple's error.
Try to change the color type of the grid on top of the window to improve the contrast of features.
Press the right arrow to show a menu of available commands for the current color type for better
adjustment.
The list of points is shown in the table, where every cell is manually editable to force the values, like
for geo-referentiation.

Finishing the preregistration
When at least 3 point correspondences are found the Mean error value appears in the bottom of the
dialog. When the acceptable value is reached, press Compute. A dialog shows you the mean
registration error and gives you the options to immediately apply the registration to the moving grid,
to copy the registration transform to clipboard to apply it later, or to cancel if you don't accept the
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error. You may want to copy the transform to the clipboard if you want to move more grids
according to the same transform. This is useful for example if you have a group of say 10 grids
already registered among them, to be registered against other 10 already registered among them.
To apply “later” a registration transform stored in the clipboard, select in the project window the
grids you want to apply the transform to, right-click on them and select Registration->matrix
transform from the context menu. Then select Apply registration transform in the Matrix transform
dialog.
 When the pre-registration is finished, the grids are unloaded from the project to free memory.
Please reload them to see them rendered.

Manual Pre-registration (among models)
Manual preregistration
The manual preregistration can be performed not only between point clouds (structured or not) but
also between mesh models and point clouds and models.

1. Select at least two models from Reconstructor®'s project view.
2. Select “Manual preregistration” among the registration tools. The dialog above appears.
3. In the list on the bottom right, select the reference model and the moving model. These two

models are shown in the respective 3D views.
4. Navigate as usual in the 3D views, and
5. Find at least three pairs of corresponding points between the reference and the moving models.

Double-click with the left mouse button on a model to select a point.
Right-click with the mouse on a point to remove it.
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6. Press the Compute button on bottom right, and select  Apply transform if the registration error is
satisfactory. The registration error doesn't need to be good, because it can be refined via the ICP
registration.

Introduction
This function is part of LineUp's registration techniques. This pre-registration technique allows you to
manually compute a rough alignment between two models (unstructured point clouds, structured
point clouds, or triangle meshes). The alignment can be later refined automatically, using ICP
registration. This function is useful in the rare cases when the Automatic preregistration function
fails.

Reference and moving models
To use this function, please select from the project view at least two models. The models can be of
any type: point clouds (structured or not) and/or triangle meshes.
When the preregistration dialog opens up, the selected models appear in the Models to register list
on the bottom right. Please select a model as reference and a model to be preregistered against the
reference. When you select a model either as reference or as moving, the model is rendered in the
corresponding 3D window. Please use the buttons above each 3D window to switch between
a default view and a bubble view of the model.
You can change the reference and moving models at any time.

Picking pairs of homologous points
To preregister the models, you indicate to Reconstructor® features that the models have in
common, such as building edges, window corners, etc. Double-click with the mouse on a model to
select a specific feature point. The point gets displayed in the 3D view with its label, and gets listed in
one of the point tables on the bottom of the dialog, with its label and its cartesian coordinates shown
in the current unit of measure. Right-click with the mouse on a point in the 3D scene to remove it
from the list.
When you have at least three point correspondences, the error table on the bottom of the window
displays the registration error associated with each point, to offer you a way to remove the worst
point pair and select another one to improve the registration.

Finishing the preregistration
When at least 3 point correspondences are found press Compute. A dialog shows you the mean
registration error and gives you the options to immediately apply the registration to the moving
model, to copy the registration transform to clipboard to apply it later, or to cancel if you don't
accept the error. You may want to copy the transform to the clipboard if you want to move more
models according to the same transform. This is useful for example if you have a group of say 10
grids already registered among them, to be registered against other 10 already registered among
them.
To apply “later” a registration transform stored in the clipboard, select in the project window the
grids you want to apply the transform to, right-click on them and select Registration->matrix
transform from the context menu. Then select Apply registration transform in the Matrix transform
dialog.
 When the pre-registration is finished, the models are unloaded from the project to free memory.
Please reload them to see them aligned.

Registration constraints
On the bottom right of the dialog, you can also add some registration constraints. You can specify
whether or not the vertical of the moving model is fixed. If you do so, you only need to specify at
least two point correspondences instead of three to compute the preregistration. Additionally, you
can specify the precision of the moving model origin's position, among four levels. If you specify that
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the moving model's origin is fixed, then you only need one pair of corresponding points to get a
preregistration.

Computing mutual rotation among models
There are cases in which two models just need to be rotated around the vertical by some angle each,
to get into a state of coarse registration. Many laser scanners embark GPS and inclinometers,
therefore in some situation you may already possess the approximate values of the scans' vertical
and origin. If that is the case, you can set the following registration constrains: fixed vertical, fixed
center and de-flag the option reference orientation is correct. If you do so, you only need to select at
least one pair of corresponding points, and Reconstructor® will compute the rotation angles around
the vertical for both the reference and the moving model (the reference model will be moved as
well).

ICP Registration

ICP Registration is an algorithm to automatically perform fine registration of a moving point cloud
against one or more reference clouds. The moving cloud must be roughly close to the reference
cloud. It is possible to roughly align the moving cloud by pre-registering it.
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ICP parameters
Below all the details.
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Accessing the ICP Registration dialog
You can access this dialog from the button Registration in LineUp's top toolbar. 
The ICP algorithm works on both structured and unstructured point clouds. The requirement is that
the point clouds have the normals calculated, i.e. have the Inclination among their colors. If a point
cloud doesn't have the inclination, during processing ICP will issue an error message. Inclination can
be computed for grid point clouds during preprocessing.
Just drag and drop point clouds from the project window to the ICP dialog to register them. The
clouds will appear in the top-left list in the dialog.

Setting the clouds' registration roles
In the top-left list, each cloud is listed with its name and its registration role. By clicking the button at
the right of any cloud's name, you can select its registration role among three: each cloud can in fact
be a reference scan, or a moving scan, or simply not used.
A reference scan will remain still in its position during registration, while a moving scan will be moved
to align it better to the reference clouds. You can have as many reference scans as you want, but
you must have exactly one moving scan to run ICP.
Example:  suppose you need to register 10 clouds together. You may want to drag and drop them
all onto the ICP dialog, then register the first two, then register the third using the first two as
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reference, and so on, gradually registering the point clouds on the ones already registered.

Using a preregistration report to finely register a set of clouds
If you have a set of clouds already preregistered using automatic preregistration, you can
automatically run in batch a sequence of ICPs that will register your clouds. Press the button Start
from preregistration report , then select the preregistration report you want to use (usually found in
the Results/Reports project folder). Below the button, a confirmation message appears ensuring that
the report has been correctly loaded and that you can press Process to register all your clouds. After
that you have loaded the preregistration report, you are not allowed anymore to change the
registration roles, since the reference and moving scans are already defined by the report. This
technique will use the minimum number of pairwise ICPs to register your clouds: if you have N
clouds, N – 1 ICPs will be needed, as many as the edges of the minimum spanning tree  that connects
all your clouds. The information about which is the minimum spanning tree is contained in the
preregistration report.
Comparison with Bundle Adjustment. Reconstructor® offers two algorithms to finely register a
set of point cloud starting from a preregistration report: the one usable via this dialog, and Bundle
Adjustment. Which one to use? 
As said, the algorithm available here uses the minimum possible number of ICPs to connect your
clouds to each other. Therefore, if your clouds form closed sequence (e.g. a loop around a building,
or inside a hall), you have no guarantees that the first cloud will be aligned with the last. Bundle
Adjustment, instead, is designed to use as many ICPs as possible, to connect each scan with all its
neighbours in order to globally register all your data. 
In conclusion: if your scans are positioned in a strict sequence, you should use the present method,
because bundle adjustment may try to register together clouds that have no significant overlap with
each other. If, on the other hand, your scans form a loop or a closed sequence, you should definitely
avoid the present method and use a bundle adjustment.

Setting the ICP parameters
ICP stands for Iterative Closest Point. The algorithm finds points on the moving cloud that are close to
the reference clouds. These points are called control points or inliers. The algorithm then iteratively
moves the moving cloud to reduce the distance of the control points to the reference models. After
each step of movement, the control points are recomputed.
Once the reference and moving clouds are set, the user can also tune several parameters of the ICP
algorithm, displayed in the Parameters box on top right of the dialog. The default parameters should
work fine for most cases. However, here a full explanation of the ICP parameters is provided.
ICP parameters are divided in three groups: parameters that define how to search for inliers,
parameters that define the convergence criterion, and parameters that define registration
constraints.

Inliers search parameters
 Max search distance. If the models have a bad pre-registration, try to increase the Max

search distance, but the process will be slower.
 Number of control points. Tune the number of control points to the size of the models.

The model to register (not the reference) is sampled with Number of control points. At the
beginning of ICP, a search distance S is computed. Control points from the moving cloud
are considered only if they are closer to the reference models than S. S is calculated so
that it is betweenMinimum search distance and Maximum search distance, and so that at
least Sufficient control points can be found in the moving cloud to be closer than S to the
reference clouds. If such an S cannot be found, for example because the clouds are too far
away and therefore the control points are too few, ICP stops and an error message is
issued.
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 Sufficient control points. See explanation above.
 Minimum search distance. See explanation above
 Min number of control points. During ICP iterations, the control points are recalculated.

If at a certain iteration they are fewer than this value, ICP stops and an error message is
issued.

 Max normal divergence [deg]. Two points close to each other are considered not
matching if their normals are diverging more than this angle. This is useful to filter out
from the registration noisy data like vegetation, foliage, or moving objects like cars or
people. The assumption is that points belonging to the same object should have also the
same normal direction.

 Min. scan bounding box overlap (%). At the algorithm's beginning, the moving cloud's
bounding box is compared with the bounding box of each one of the reference clouds. If
the overlap between the bounding boxes is lower than this value, the reference cloud is
not considered by the algorithm.

Convergence criterion parameters
 Registration error [m]. Tune this parameter to select the desired registration accuracy.

ICP will stop iterating if the mean registration error goes below this value. The other
parameters that influence ICP's stop criterion are: Registration delta-change and Maximum
number of iterations.

 Registration delta-change (%). ICP stops if the error-delta between three iterations is
smaller than this parameter. Let's call this parameter d. Let's also define e(n) to be the
mean registration error at iteration n. ICP will stop iterating if, at iteration n, [(e(n – 3)
– e(n)) / e(n) ] < d.

 Minimum number of iterations. ICP will execute at least this number of iterations, and
then will start checking the break criterion.

 Maximum number of iterations. ICP will do at most this much of iterations.

ICP constraints
 Vertical is fixed. Set it to true if you know that the moving scan is already set on its

vertical in the current UCS.
 Translation is fixed. Set it to true if you want to constrain the origin of the moving cloud

to be fixed. Ths is useful if you know with great precision (e.g. via total station) the
coordinates of the scan's origin.

When the parameters are set, press the button Process on bottom left. ICP begins, showing log
messages in the right-central Result panel of the dialog. Also, the graph on bottom right displays the
error histogram for each iteration. This is useful to see at a glance whether the algorithm is
converging.

Finishing the registration

After finishing the registration, the dialog pictured above shows you the mean registration error and
offers you three options: to immediately apply the registration to the moving grid, to copy the
registration transform to clipboard to apply it later, or to cancel if you don't accept the error. You
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may want to copy the transform to the clipboard if you want to move more grids according to the
same transform. This is useful for example if you have a group of say 10 grids already registered
among them, to be registered against other 10 already registered among them.
To apply “later” a registration transform stored in the clipboard, select in the project window the
grids you want to apply the transform to, right-click on them and select Registration->matrix
transform from the context menu. Then select Apply registration transform in the Matrix transform
dialog.
 When the registration is finished, the grids are unloaded from the project to free memory. Please
reload them to see them rendered.

See Scan alignment per groups.

Bundle Adjustment

Solving a puzzle of a thousand pieces
To understand bundle adjustment, we can imagine to solve a big puzzle with many pieces. Each



Online Help Reconstructor 4.4

150 / 361

piece matches with four others, sometimes the match is easy, sometimes you have to slightly push
a piece inside another, and sometimes two pieces just don't match. Often, you need to know the
neighboring pieces to decide whether two pieces match correctly or not. And the pieces reach their
final, adjusted positions only when the puzzle is complete. If ICP registration can be seen as finding
the match between two pieces, Bundle Adjustment means completing the whole puzzle by choosing
and refining the good ICPs and discarding the wrong ones.
This algorithm allows to register together many point clouds, distributing evenly the registration
error. The user specifies which point clouds are reference clouds (they are locked during the
registration) and which are moving; the moving clouds will move and align on the reference clouds
and between them during alignment. While the ICP registration works only for one pair of clouds at a
time, this algorithm registers together N clouds at the same time, diffusing and minimizing the global
registration error. The input point clouds must be pre-registered. They do not need to be structured
but they need to have the normals. There is no upper limit to the number of the input clouds.

How does it work
Given a set of N scans, the algorithm will create as many connections among pairs of neighboring
scans as possible. For each connection, a pairwise ICP will be executed, using the Settings accessible
from the Line Up top toolbar. From each ICP, the best matching point pairs between the two scans
will be saved. In the end, a final nonlinear minimization step will be run only among these matching
point pairs of all the connections. The global registration error among these point pairs is minimized,
having as unknown variables the scans'poses.

Parameters
Input point clouds
Just drag the poing clouds you want to finely register from the project view, and drop them on the
Bundle Adjustment dialog. They will appear in the top list. On the right of each cloud, a button
appears that can be toggled among red (reference scan) and green (moving scan). Therefore here
you can decide which scans must remain still during registration and which must be registered.
Preregistration report
If you have previously performed the automatic preregistration of your scans, you can use the
results of your preregistration in the bundle adjustment. Click Start from preregistration report and
load the report of the automatic preregistration, a text file by default saved in the /Exports folder of
your project. The dialog will show in the top list all the clouds that were automatically preregistered,
and will adjust the ICP settings accordingly to the preregistration error contained in the report.
Defining connections among scans
To reach the best global registration possible, this algorithm will use as many connections as possible
among your scans. Knowing the topology of your scans, you can set the Max connections per
scan parameter accordingly. If you scanned the exterior of a building, then it may be that each scan
shares geometry with 3 or 4 neighbors. If, instead, you scanned a room or a hall, then it makes
sense to say that each scan matches with other 5 or 6 scans, therefore all pairwise ICPs between a
given scan and its 5 or 6 neighbors should be launched. However, doing so there is the risk to run
ICP between two scans that have no geometry in common. In this case, the ICP error will be very
high.Therefore, the algorithm will discard bad ICPs and keep the good ones. You can set the Severity
in discarding bad ICPs among three levels as in the dialog. We advice to always select “Strict”, and
only if your data are particularly noisy (e.g. mining data) then select “Coarse”.
Global constraints
You can specify some constraints that must remain valid for all the scans during all the registration.
Below in the dialog, you can flag that all scans have fixed vertical . This is useful for example if you
have imported scans from a scanner with vertical corrector and you trust the vertical to be correct
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below 1°. You can also flag that all scans have fixed origin. This means that you know already the
coordinates of all the scans'origin with a precision higher than the point density (~ expected
registration error), therefore the scans will only be allowed to rotate during bundle adjustment.
Scan-specific constraints
The top of the window shows the list of scans to be registered. On the right of each scan, a button
allows you to switch between whether the scan should be reference or moving. 

When the scan is moving, still you can
define scan-specific constraints via the
Edit constraints button. Clicking this
button, a dialog appears where you can
flag whether the scan has the vertical
fixed or not. Moreover, you can
constrain the scan's origin in three
levels. The origin can be free to move
(not constrained), can be constrained
within a certain horizontal and vertical
interval, and can be held fixed.

Output
Once you have defined the connections among the scans and the additional constraints,
press Start to begin processing. A progress bar appears, and you can also open the log window to
have more detail on what's happening.
At the end, the clouds will be moved to the new positions and their files will be saved. Therefore, you
may want to save the clouds' poses before running bundle adjustment. Moreover, a dialog appears
indicating the number of registered clouds and the global registration error. After you press OK, you
can click on Save PDF report to get a much more detailed PDF report. There also a Save .txt
report option to save a text version of the full report that can be copied to Word or Excel.

Resolution of common problems
I have run bundle adjustment, but scan A didn't match well with scan B
Get the report of the bundle adjustment, and check if the edge between A and B ( or B and A) is
listed in the section “Report by edge, sorted by error”. If it is, most likely the ICP between A and B
has converged bad: you can re-run the ICP only between A and B with different parameters, and
then re-launch the bundle adjustment having A and B among the references.
However, most likely the edge between A and B will be in the “Edges not used” section of the report,
or even not in the report at all. If the edge (A, B) is among the not used, then try to re-launch the
bundle adjustment decreasing Severity in discarding bad ICPs. If the edge (A, B) is not in the report,
then try to increse the Max connections per scan and re-launch the bundle adjustment.
I have run bundle adjustment, but I see that the scans did not converge well, moreover the
global registration error is 4 cm while it should go down to 2 cm.
Press the Settings button of the Line Up top toolbar, and go to the ICP settings. Set the ICP
parameters so that only the very best inliers are selected. You can lower the min search distance to
0,2 m or to 0,1 m, lower the sufficient control points to 3000, and lower the max divergence among
normals to 10° or even down to 3°. Then, re-launch the bundle adjustment. Only the best matching
points among scans will be selected, and the error among them will be minimized, resulting in a
better convergence and tighter error. You can repeat the process to improve the results.

See Bundle Adjustment Report.
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Bundle Adjustment Report

At the end of the bundle adjustment process  you can save a PDF (or txt) report detailing the ICP and
Bundle Adjustment results.
Here are explained all the voices inside this report.

Summary
[N] scans have been finely registered with bundle adjustment.
Num ICPs used: number of ICPs actually used 
Average ICP error [m]: average value of registration errors related to all scan pairs
Average registration error of corresponding points  [m]: global registration error reached
between the most important corresponding points. This error is the main result of the bundle
adjustment.

Input parameters
In this section the parameters that you set before the bundle adjustment are summarized:
Max neighbors for each scan [N]: number of scans (close to the current scan) taken in account
ICP selection severity: Level of severity used in discarding bad ICPs
ICP min search distance [m]: see Inliers Search Parameters in Cloud to Cloud Registration set
parameters
ICP max divergence among point normals  [deg]: see Inliers Search Parameters in Cloud to Cloud
Registration set parameters
List of registered clouds: the well registered point clouds are here listed

Detailed results
ICPs executed: number of ICP processes that have been executed during bundle adjustment.
ICPs used: number of ICP registrations that have been found good enough to contribute to the final
bundle adjustment.
Average ICP error: average value of registration errors related to all pairs of scans
Maximum ICP error allowed  [m]: see Inliers Search Parameters in Cloud to Cloud Registration set
parameters
Total cost before minimization [m]: statistical parameter derived from least squares method,
relative to state before minimization
Total cost after minimization [m]: statistical parameter derived from least squares method,
related to state after minimization
If  Total cost after minimization < Total cost before minimization an error decrease is achieved
Reason of convergence: if the value of |cost_change|/cost is lower than 1.000000e-008 (fixed
upper limit) the function tolerance is reached.
Average registration error of corresponding points [m]: global registration error reached
between the most important corresponding points. This error is the main result of the bundle
adjustment.
N° corresponding points: these are the most important corresponding points among all valid scan
pairs. The final global error minimization is run exactly on all these corresponding points.
N° iterations: number of iterations in the iterative decreasing error process
N° parameters, N° effective parameters: these are the parameters of the error functional to
minimize, and depend on the degrees of freedom of the problem. If bundle adjustment is run
among ten scans for example, keeping one as reference, then the effective parameters are 9
moving scans * 6 degrees of freedom (three for translation and three for rotation) = 54. However, if
you change the registration constraints (e.g. adding more reference scans, imposing fixed vertical
and/or fixed translation) the number of effective parameters changes accordingly.
N° threads used: Bundle adjustment uses as many threads as the logical CUP cores of your PC.
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Therefore, bundle adjustment is very CPU-greedy to offer you the fastest processing time. If you
desire another behavior, you can assign less processor to Reconstructor from the Windows task
manager.
Time taken for final bundle adjustment [mm:ss.msec]
Total elapsed time [mm:ss.msec]

Report by edge, sorted by error
All the analyzed couples of scans (i.e. edge A and B) are sorted regarding the registration errors at
the end of ICP and bundle adjustment phases.
[N]  corresponding points found between scans A and B
ICP error [m]: registration error related to single pair of scans, as they are isolated from others.
Correction after bundle adjustment [m]: by how much the registration error related to the single
scan pair has changed after the global error minimization. 

Edges not used
If all scans are finely registered All edges have been used is written here, otherwise a list of discarded
edges, sorted by error, is shown. If you see among the “edges not used” a scan pair that should be
registered together according to you, then you may want to re-run Bundle Adjustment with coarser
parameters. In the same way, if a scan pair has been registered together that you think it shouldn’t
have, you can re-launch Bundle Adjustment with stricter parameters.

Scan alignment per groups

What you can do if the automatic pre-registration fails?
Here the instance of a set of scans (and/or 3D models) that cannot be aligned because of a low
overlap between some scans. 
If it is possible to detect groups of scans already registered and one scan for group that has a good
overlap each other, a manual pre-registration can be run. 

A group is a cluster of items composing the project.
A Registration role for all the scans inside the group can be set: None, Same as parent, Children move
together. These roles are used to carry out a registration through groups.

The workflow is the following. Letting us help by an example...

1. Find the groups of scans already registered.
There are two possibilities to create groups:

a. Automatically
When you automatically register scans  with the LineUp® tool, groups containing just
registered scans are created by default
b.  Manually
you can manually create a group already registered scans with the specific command.

In the example below, we indentified two groups: A and B.
We want to move all the scans of the Group B onto the scans of the Group A, without losing the
alignment of the scans previously done.  

2. Apply the “Children move together” registration role to the groups that you want to align. If a
single scan is moved in the 3D space, all the other scans move together, as a rigid system.
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3. Find, for each group, a scan with a good overlap with one or more scans in other groups [in the
example Scan2(A) and Scan3(B)].

4. Carry out a manual pre-registration among models to align Scan2(A) and Scan3(B).

Since the “Children move together” registration role of the groups permits a rigid and
common movement of all the scans of the groups, this procedure is enough to align all the
scans.

Target-based Registration

In some cases, especially when the geometry of the environments does not have many features, it
is useful to use the automatic pre-registration or registration with targets.

Reconstructor® can manage:
 Planar Circular Targets;
 Real recognizable Points. 

Manage them in Targets Editor window.
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Target registration

Target registration

This function

automatically

registers a set of

scans by detecting

and matching

targets. The user can

start the automatic

target detection,

otherwise can

manually add, move

and remove targets.

For each selected scan, the number of detected targets is listed. By clicking the eye icon, the user can
open the Target editor dialog for the selected scan.

The Detect Targets button allows the user to perform the target finding stage on the selected scans.
The targets associated with the selected scan are overwritten.
The Register Scans button performs the target registration stage. To register scans using targets, at



Online Help Reconstructor 4.4

156 / 361

least three non-collinear targets are needed for each scan. Two targets per scan are needed if the
Assume scan vertical is known checkbox is checked. 

Via the checkboxes, the user can select wheter to detect circular flat targets. If Detect circular targets
is checked, the user can add one or more diameter values by typing the numeric value and pressing
the “plus” button. An inserted diameter can be removed by selecting it from the list and clicking the
“minus” button.

See Manage control points and Manage circular targets and  for details.

Alignment Options
The user has two matching options to choose from: 
 Automatic: the scan will be registered along the best of all possible matches among the targets
 Match names: the targets with equal labels will be matched together. This option is useful when

the user is sure that same targets in different scans have the same label. 
The user can also select whether the scan vertical in the current UCS must be used as a constraint to
registration (and therefore left unchanged) or whether the system can also move the scans vertical
to get the best registration.

If a fair amount of targets is used and the Automatic Target-based registration process is
successfull, the Bundle Adjustment registration is not mandatory.

Targets Editor 

The targets editor dialog shows a 2D view of the current scan with its associated target points. The
user can manually add, move and remove targets. 
Additionally the user can also start the automatic target detection by clicking the Find circular targets
button to automatically detect planar circular target of given diameters
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Mouse controls
 double click on the model to add a generic target point;
 right click to remove an existing target;
 drag the cursor while pressing the left mouse button to move an existing target.

On the right side of the window the current targets with their 3D coordinates and confidence values
are listed. The zoom window can be centered on a specific target by clicking on a target from the list.
A target's label can be edited by double clicking the respective cell in the targets list. Note that a
target label must be unique among the same point cloud.

You can find targets both in 2D and in 3D view and with different  color layer.

The Clear All button permits to delete all targets previously found in the scan.

It's also possible to Export and Import points to Text files (both in UCS and in Local coordinates)
through the relative buttons.

A customized Target Editor will be open if Manage control points and  Manage
circular targets (in Georeference tool) are selected.

Manage Control Points

This function opens the Targets editor dialog, focused on control points that aren't circular
targets, so common points in the point cloud

The targets editor dialog shows a 2D view of the current scan with its associated target points. The
user can manually add, move and remove targets. 

Mouse controls
 double click on the model to add a generic target point;
 right click to remove an existing target;
 drag the cursor while pressing the left mouse button to move an existing target.

Manage Circular Target
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This function opens the Targets editor dialog, focused on planar circular targets recognition

A circular target is a planar target printed as a white circle against a dark background.
The value of internal diameter of the circle has not limitations.

Automatic detection of circular targets
Reconstructor® supports an easy-to-use and fast automatic circular targets detection algorithm for
tripod scans. It needs only one input parameter (the diameter of the required circle). Several
diameters are searchable at the same time.

Go in Line Up, selecting Georeference Tools and Manage circular targets, and selecting a grid point
cloud. 
A dialog appears showing a 2D view of the structured cloud.

Click Find Circular Targets on the top left. A small dialog appears where you can input the diameters
of the circular targets you are looking for. 

You can add one or more diameter values by typing the numeric value and pressing the “plus”
button. An inserted diameter can be removed by selecting it from the list and clicking the “minus”
button.

 
 After inserting the diameters and clicking OK button, Reconstructor® automatically finds all circular
targets in the given point cloud, and displays the targets list on the right of the dialog, populated with
the found circular targets. Just click on any target on the list and you will see the corresponding one
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in the Zoom View: this is useful to check whether any false positive has been detected.

Mouse controls
 double click on the model to add a generic target point;
 right click to remove an existing target;
 drag the cursor while pressing the left mouse button to move an existing target.

Conditions and limitations
To recognize a circular target, the resolution of the scan should be such that at least 5 points can be
detected on the circumference (on the edge between white and dark areas).

Manage Spherical Targets

This function opens a customized Targets editor dialog, focused on  spherical targets

Automatic detection of spherical targets
To get quality surveys, scanner operators often place spherical targets on the field; these spherical
objects can be automatically detected and used therefore as precise targets for registration.
Reconstructor® supports an easy-to-use and fast automatic spherical targets detection algorithm for
tripod scans. 
It needs only one input parameter (the diameter of the required spheres) and it is robust to errors
such as false positives or missed spherical targets.

It is possible to automatically detect spherical targets by going in Line Up, selecting Target-based
registration tools and Manage spherical targets, and selecting a grid point cloud. 
A dialog appears showing a 2D view of the structured cloud. Click Find Spherical Targets on the top
left. A small dialog appears where you can input the diameter of the spherical targets you are
looking for. The default value is 14.5 cm. After inserting the diameter, Reconstructor® automatically
finds all spherical targets in the given point cloud, and displays a dialog with the number of found
sphere, the average sphere fit error (the average distance of the inlier points to their own sphere)
and the elapsed time. After clicking Ok, the targets list on the right of the dialog gets populated with
the found spherical targets. Just click on any target on the list and you will see the corresponding
sphere in the Zoom View: this is useful to check whether any false positive has been detected.
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Accessibility and workflow
It is also possible to detect the spherical targets for a set of grid point clouds, by selecting them, then
selecting Pose & registration and Targets registration. By doing so, the Target-based registration
dialog appears. Uncheck the Detect circular targets checkbox, leave Detect spherical targets checked,
select the desired spherical targets diameter, and click on Detect targets on bottom left. The
spherical targets will be automatically detected for all the listed clouds, erasing any target previously
belonging to the clouds.
It is also possible to detect the spherical targets as a step in the Line Up Wizard. For example, you
can import a set of tripod scans, pre-process them, detect the spherical targets, and run target-
based preregistration on the clouds: the wizard will perform all these steps automatically for you.
Just open the Line Up Settings  and go to the Preregistration tab to adjust the desired settings for the
steps of sphere detection and targets registration.
Regardless of the way you access the algorithm, after its execution Line Up’s log window shows you
how many spherical targets have been extracted, what is the average fitting error of the inliers to
the found spheres, and what is the elapsed time. The average fitting error is a useful information to
understand the degree of precision that you can expect by running target-based registration
exploiting the found spheres.

Conditions and limitations
To be able to detect a sphere, the algorithm needs at least 30 points lying on the sphere. where each
points has a scale of 13 mm. For example, if a 360° tripod scan has a width of 8000 points, at 18 m
away from the origin there is a point every 13 mm. The closer to the origin the sphere is, the more
points needed to detect it. However, you can still detect spheres with fewer points than required by
using the Find spherical target at a given point button, described in the former section.

Targets Registration Report
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This dialog allows you to refine and exploit the result of a target-based registration.

On top of the dialog, the mean registration error is shown, along with the editable error threshold.

In the central table of the dialog, the matched targets are listed, grouped by scan. Note that each

target can have one or more match with targets from other point clouds. 
You can unflag a matching target pair, by pressing the checkbox on the right, and press Update

registration on the bottom left. The registration will be recomputed without the outlier and the

mean registration error will improve accordingly. 
Please note that the alignment between clouds might be lost when matches are unchecked. In any
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case you can restore the original computed registration by clicking the Reset To Default button in the

bottom part of the dialog. 
Once you are satisfied with the computed alignment, you can apply the registration and choose to
save a PDF report.

You can also unflag multiple matches at the same time by selecting an error threshold and clicking

the Remove Above Threshold button in the top right corner of the dialog.

Georeferencing

Georeferencing means that the internal coordinate system of a cloud of points or a group of them
or in general a group of item in the Reconstructor project can be related to a ground system of
geographic coordinates or a local User Coordinate System.

It is recommended to use at least 4 points to georeference a model (or an entire project), so as to
have redundancy and to avoid coplanarity on three points that could lead to an "upside down"
georeferencing in particular conditions.

This icon menu groups the function written below

Point Cloud Georeferencing

Point List Registration

Point clouds georeferencing

This function allows the geo-referentiation of multiple scans. The workflow is divided in two
steps:

 Reference points selection
 Scans geo-referencing

Reference points selection dialog
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This dialog allows the selection of multiple reference points from the point clouds target and center
points.
Target points can be automatically or manually set using the targets registration dialog or targets
editor dialog tools.

The buttons in the bottom part of the dialog have the following functions:
 Automatically remove duplicate points: if two or more selected points are within a 0.2

meters distance between each other, only the higher confidence point is selected. This
option can be used to pick only one target point if the same target was detected in more
than one point cloud;

 Import selected: use only checked points for the geo-referencing step;
 Import centers: use only the point clouds center points for the geo-referencing step;
 Import targets: use only the point clouds target points for the geo-referencing step;
 Import points: use all the listed points for the geo-referencing step.

Scans georeferencing dialog
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This dialog allows the user to load external reference points for geo-referencing scans using
previous selected target points.
The buttons in the bottom part of the dialog have the following functions:

 Show points selection: opens the reference points selection dialog;
 Load external points: imports external point from a textual point list;
 Load georeferenced centers: imports the georeferenced center point of the point

clouds if present. Georeferenced coordinates for the center point can be set automatically
(depending on the format) or manually when importing the given point cloud;

 Compute registration: automatically finds the best matching points from the right and
left lists and computes the alignment between them. See details in dedicated Compute
Registration page.

Georeferencing from point list
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This dialog allows you to register a list of points, taken from a text file or from the point list window,
against another list of points that you consider as reference. In particular, these last points can
be geo-referenced.

The left half of the dialog regards the moving points. You can load them from a text file with the
button Load moving points; in this case you are invited to select a text file and then the parse point
list dialog appears. Otherwise, you can copy the points listed in the point list window via the
button Copy moving points from point list window. Then, the moving points appear listed in the left
table.
The right half of the dialog regards almost symmetrically the reference points. The button Load
reference points on top right is needed to load the points from a text file, the right table hosts these
points. To start the registration, the left table has to contain as many points as the right table.

When you have loaded the points, press Compute on the bottom right; the Compute Registration
dialog will appear.
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Compute Registration

After pressing the "Compute" button in Georeferencing procedure the following window will appear
with three choices:

You can register points, scans, any items or a complete project by
 Match names: coupling points / targets according to their labels, no combination search is

performed, the points / targets are coupled by name.
 Best fit: tries out all the possible pair combinations to find the best fit. Recommended for a

number less than 10 pairs of points / targets.
 Best fit 2:  tries out some smart combinations to find the best fit. Recommended for a number

greater than 10 pairs of points / targets.

The Best fit adjustment procedure performs an optimization by minimizing the least squares errors
to find the best rigid transformation between the moving and reference point set.
The best set of correspondences between those points is found by evaluating the rigid
transformations between the triangles formed by every combination of three moving points against
similar triangles in reference point set.

The first option is much faster but it assumes that you are sure about how to match your points.
After you have selected either Match names, Best fit or Best fit 2, you can refine and make use of the
results of the registration, in the Registration report dialog.

The Registration Report dialog is shown at the end of the process.

__________
For a general overview of  Reconstructor®'s registration tools, see Registration techniques.
Return to the Georeferencing chapter.

Registration report dialog
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This dialog allows you to refine and exploit the result of a registration. This dialog is used as final step
of the following procedures: single-scan georeferencing, georeferencing from point list, and
platform calibration.

 On top of the dialog, the mean registration error is shown, along with the editable error threshold.
Also errors according the current UCS components are shown.

 In the central table of the dialog, the point pairs are shown along with their associated
registration errors. Errors above the error threshold are displayed in red, and you could consider
the corresponding pair as outlier. If you uncheck an outlier pair, by pressing the checkbox on the
left, and press Update registration on top right, the registration will be recomputed without the
outlier and the mean registration error will improve.

 In the bottom part of the dialog, there are options on how to make use of the obtained
registration. The option Copy transform in clipboard is useful for having a backup of the
registration transform to use on project entities that will be created at a successive time. The
option Make backup of poses of affected project items before applying the transform will save the
poses of the affected project entities in the Exports folder of the project, these poses can be
restored later via the matrix transform tool, to undo the effects of the current registration. To
access this tool, go to the project window, select the entities you want to register, right-click and
choose Registration -> Matrix transform  from the context menu.

 The button Apply transform to all project on the bottom extends the effect of the registration to
all the project entities. All your project items (including annotations) will be moved according to
the roto-translation defined by the registration. The button Apply transform to a project
selection will pop up a dialog to select a subset of the project items. Only those selected items
will be moved.

Targets, annotations and points conversion

It is possible to manage Targets, Annotations and Points  inside the project, in order to change their
role.
The conversion tools are also available in the context menu of the items.
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 Target -> Annotation
 Annotation -> Target
 Target -> Point
 Point -> Target
 Annotation -> Point 
 Point -> Annotation

Here an example of application: you picked a point in the 3D scene and you want to use it as target
coupled with a defined 3D model. Right-click on the Point in the Project Window and select Point ->
Target; a dialog will ask you which cloud you want to match the target. At the end of the process the
Target will be 

 Remember that a Target is not an isolated entity,
it is always combined with a point cloud (grid or
unstructured) or a mesh as its sub-item.
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UCS & positioning
Reconstructor® includes various posing techniques:

 Manual Positioning
 Pose Transform
 Pose Dialog (contextual menu)
 Determine the cloud's vertical direction
 Create/edit UCS
 Create UCS from point list
 Create UCS from this pose (contextual menu)
 Define Project Reference System

Manual positioning (Adjust Pose)

The command is available in the UCS & positioning Top Toolbar tool, in the item's
context menu and by pressing [Ctrl+A] keys.

It is used to manually
change the pose of an
object.

This window is enabled
only if an item in the
Project Window is
selected. Then also the
bounding box of the
current item is
highlighted in bold
yellow. 

Insert the desired
quantity of translation
(meters) and rotation
(degrees) and press the
positive and negative
buttons +/- X,  +/- Y, +/- Z
to apply transformation. 

If Object coordinates is enabled, the rotation is around the origin of the object's coordinate system
and the translation is along the axes of the same system. 

If UCS coordinates is enabled, the rotation is around the current UCS' origin and the translation is
along the axes of the same UCS.
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See also the Pose dialog.

Pose Transform

The command is available in the UCS & positioning Top Toolbar tool and in the item's
context menu.

The Pose
transform comma
nd allows you to
apply to your
project entities
the transforms
coming from
registration
functions.

In pre-
registration, regist
ration, and geo-
referentiation,
you can copy in
the clipboard the
transform that
results from the
computation.

  The Apply registration transform button searches the clipboard for such a transform, if found,
the transform is applied to multiple models.

 The  Apply inverse transform button undoes the effect of the first button. It reads from the
clipboard a registration transform and applies its inverse to the selected project entities. It's
useful if you don't like the results of a registration.

 The Define transform matrix button allows you to manually define a transform matrix, that is
post-multiplied to your project entities. The transform must be defined as referring to
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the current UCS. A common situation in which this function is needed is when you have done
a point list registration and copied the resulting transform to the system clipboard. In this case,
to apply the transform press Define transform matrix, then Paste matrix and Commit. The
selected project entities will be moved according to the registration transform matrix in the
clipboard. 

 The Apply pose from file button allows you to import the .pose files you export with Export pose.
“Export pose” is a command reachable from the context menu of any project item. It is designed
to save the positions of your project items for backup. With Apply pose from file, you can
therefore move your models to positions you saved in backup files.

Note: The pose matrix exported by export pose is different from the pose matrix displayed in
the Pose dialog. The "export pose" function is designed to provide to the user the possibility of
making a backup of the items' positions and to restore them at a later time in case something goes
wrong. Now, if "export pose" would save the pose referred to the current UCS (that you see in
the Pose dialog), what would happen if the user by mistake moves or deletes that UCS? The
possibility of restoring the items' positions would be lost. Therefore, "export pose" exports another
pose referred to an internal, hidden, never-changing Reconstructor global reference system.

Difference between Apply registration transform and Define transform matrix
This dialog has two buttons, Apply registration transform and Define transform matrix, that
apparently do the same thing: getting the data stored in the system clipboard, interpreting them
as a “registration transform” (a description of how move around models) and applying the
transform.
The difference is as follows: 

o Apply registration transform is suited for transforms calculated between
Reconstructor®'s project entities, 

o Define transform matrix is suited for transforms coming from other tools, or transforms
calculated between entities not belonging to Reconstructor®'s project.

That is why you can use Apply registration transform only after pre-registration, registration,
and geo-referentiation. These three tools, in fact, calculate a registration defined on
Reconstructor®'s project entities, and therefore the registration transform is defined in a very
precise and error-resilient way that is internal to Reconstructor. For example, if you do a
registration, change UCS, and use Apply registration transform you will still get the correct result
with all the decimal precision of the registration algorithm, independently of the UCS. On the
other hand, after a point list registration you cannot use Apply registration transform and you
have to use Define transform matrix. This is because point list registration works with any lists of
points, in principle also not coming from Reconstructor®'s models, but from other sources like a
total station or the Internet. In this case, having lost the relation with the current project,
Reconstructor® cannot generate a precise and error-resilient registration transform of the first
type and therefore point list registration returns a generic 4x4 transform matrix whose effect
changes if the current UCS changes.
In conclusion, there are two buttons because there are two types of registration transforms: a
more specific and more precise one, and a more general-purpose one.

See also Pose dialog.

Pose

The command is available in the Data Management > LineUp Top menu and in the item's
context menu Pose&Registration.



Online Help Reconstructor 4.4

172 / 361

In Reconstructor®, the 3D position of each object (except annotations) is described by the pose
matrix (transformation matrix).
                
You can manage different UCS systems (local or global/geo-referenced).
A transformation matrix defines how a project entity is located and oriented with respect to the
current UCS. Therefore, having knowledge about transformation matrices, it is possible to perform
specific and precise translations and rotations on a project entity. 

A transformation matrix is a 4x4 matrix that specifies how an object O is located and oriented with
respect to a global coordinate system. The first, second and third column of the transformation
matrix contain respectively the versors of the X, Y, and Z axes of the system anchored with the
object O. The fourth colum contains the translation vector of O's origin with respect to the UCS'
origin. The fourth row of the translation matrix is always (0 0 0 1).

See also Manual positioning (Adjust Pose).

Restore a Pose
You can restore an object position in case of registration and geo-referencing error once the Pose
file is saved.
To save the Pose you have to export it: 
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The software automatically creates a folder PoseFiles_2013.09.04_16.29.23_304 that contains the Pose
exported. This folder is saved in the Exports folder and the name contains the date (day and time) of
the creation.
Apply the Pose file by selecting the objects desired → right mouse button → Pose&Registration →
Pose transform.

A window appears. Select Apply Pose from file and select the Pose you want to restore. 

 Items must have the same name of the pose file to apply pose.
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Advanced Options
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This dialog is designed for advanced users, since it requires specific knowledge of 3D computer
graphics, in particular knowledge about transformation matrices.
In the dialog there is a central 4x4 table displaying the transformation matrix of the current project
entity. On the sides, the buttons Post-multiply and Pre-multiply are located.
If M is the current matrix, a pre-multiplication by matrix P is defined as

M’ = M ∙ P
If M is the current matrix, a post-multiplication by matrix P is defined as

M’ = P ∙ M
Any number of pre-multiplications or post-multiplications to the current matrix is possible.
Confirm any modification of the matrix by pressing Commit on bottom left of the dialog.
Press Revert to discard any modification. The upper-right Close button (x) has the same effect as
Revert and hides the dialog.
To speed up the definition of the matrix the following operations are available:

 Copy in clipboard: copies the current matrix in the clipboard, useful for export or to paste
it to another model

 Paste from clipboard: pastes the matrix from the clipboard, confirm by pressing Commit
 Euler form: define the transformation as rotation plus translation. The rotation is defined

as a sequence of rotations along the local coordinate frame axis. The Pitch angle is around
X, Heading is around Y, Roll is around Z, in degrees. If the sequence  is YXZ, then first the
rotation around Z(Roll) is applied, then X(Pitch), then Y(Heading). Press OK and the
homogenous transformation matrix is computed.

 Axis-angle form: define the transformation as rotation plus translation. The rotation is
around the desired axis (X,Y,Z) direction by amount Angle, with the right hand curl rule.
Press OK and the homogenous transformation matrix is computed.

 Zero: clears the matrix to zero
 Identity: defines the matrix to be the identity
 Invert: inverts the current matrix
 Transpose: transposes the current matrix

 For example
Rotation around X axis by 90

degrees 
1 0 0 0
0 0 -1 0
0 1 0 0
0 0 0 1

Rotation around Y axis by 90
degrees

0 0 1 0
0 1 0 0
-1 0 0 0
0 0 0 1

 Rotation around Z axis by 90
degrees

0 -1 0 0
1 0 0 0
0 0 1 0
0 0 0 1

 Move objects with the Roto-translation Matrix
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Copy Translation button: To copy the object translation (column 3). 
Use this option to translate an object on these coordinates.
1. Press Copy Translation
2. Open the Pose of the object to move
3. Select Paste translation

To translate an object according to specific coordinates, type the desired coordinates in the
column 3 (first line stands for X, second Y, third Z).
The translation will be made according to the object’s UCS reference system.

Determine the cloud's vertical direction

The command is available in the UCS & positioning Top Toolbar tool.

It defines the vertical direction of the point
cloud by defining a plane that should be
horizontal (e.g. a floor)  - by double clicking
on it - and setting the vertical direction of the
point cloud (z axis) as the normal direction of
this plane, rotating the point cloud.

Create/edit UCS

The command is available in the UCS & positioning Top Toolbar tool.
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The Create/edit
UCS command allows
you to create a new

UCS (by pressing  )
and manage UCS
already present in the
project (by
dragging&dropping it
in the top of the
dialog).

 button allows to
modify the UCS's
name.

 Note that it is not
possible to edit the
Main UCS.
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Fitting Methods
Six methods are available to create and modify an UCS.

From two points
The UCS is here defined by setting 2 points in the 3D space:

o UCS origin
o a point on the X axis

The fitted UCS has origin in the first selected point, its X axis points towards the second point
and its vertical direction is along the current UCS Z axis.

These points can be  selected directly by double clicking on the 3D scene, chosen between the Points
listed in the project or identified by manually entering their coordinates.

From three points
The UCS is here defined by setting 3 points in the 3D space:

o UCS origin
o a point on the X (or Y axis)
o a point on XY plane

These points can be  selected directly by double clicking on the 3D scene, chosen between the Points
listed in the project or identified by manually entering their coordinates.
At the end of the process it is possible to invert the Z direction.

From Current view
The UCS is adapted to current view, with the origin in the point of view's origin, the Z axis oriented
towards your eye and X, Y axes parallel to the 3D window edges.

Fit UCS to faces
The UCS is here created by selecting portions of the point clouds to define both the UCS's XY plane
(horizontal) and the  UCS's XZ plane (side).
To do it the lasso command is used to select the points on a "flat" [suggested] surface.

 This method is particularly useful when you have to create an UCS whose planes are parallel to the
floor and walls, in order to extract orthophoto, cross sections, ....
Check that your points sample is large enough so you don't make any serious mistakes.

From an item's pose
The UCS of the desired item is cloned. Drag&Drop the item in the dialog or double click on it in the
3D scene.

From points registration
The UCS is created from two sets of points.
See Create UCS from point list.

Editing
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By default the UCS's bounding box dimensions
are set between -1 m and +1m, in all the 3 main
directions (X,Y, and Z), but you can easily set
different values, in order to make more visible
the UCS at large distances, for example.

By clicking the buttons below, you can
 Make UCS vertical, setting its Z axis parallel to the Z axis the current UCS
 Make UCS horizontal, setting its XY plane parallel to the XY plane of the current UCS
 Make UCS X axis horizontal, setting the horizontality of the only X axis. 

At the end you can choose to set the just created/modified UCS as current in the project, by pressing
the Set as current UCS button.

Create UCS from point lists

This command creates a new UCS from two sets of points. Switching to the resulting UCS
will show the points of the first set with the coordinates of the second set.

This function is accessible from the Navigation menu, or from the toolbar of the point list window.

Given two lists of points, this function creates a new UCS such that the points having coordinates in
list 1 will assume the coordinates in list 2 after switching to the resulting UCS, except from a
controllable mean-squared error.

Press the buttons Load moving points on top left to load a text file with the first point list, and Load
reference points on top right to load a text file with the “reference” coordinates of the points, the
coordinates that are going to be shown in the new UCS. To parse the text files with the point list, an
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appropriate tool is used. You can use as moving points the points listed in the point list window, via
the appropriate button on top left.

After loading the first and the second list of points, press Compute on the bottom right. A dialog
appears, asking whether you want to register the points by coupling them according to their labels,
or by trying out all the possible pair combinations to find the best. The first option is much faster but
it assumes that you are sure about how to match your points. After you have selected either Match
names or Best fit, you can refine and make use of the results of the registration, in the dialog shown
below.

In the dialog above, it is possible to set the error threshold and to exclude outliers in order to
improve the mean registration error. The way to do that is described here (ICP Registration Dialog).
Once you have refined the mean-squared error (shown on top left), press Create UCS from
transform to create the desired UCS. The resulting UCS will be inserted in the project window.

This procedure uses the same calculations as georeferencing from point list.

Create UCS from point list registration: starts a procedure to create a coordinate system that is
based on the algorithm of the former procedure. It exploits the same concept of registering the
listed points against another point list that is considered as reference. However, the final result does
not consist in moving all the project items, but in creating a new UCS and to place it so that all the
other entities appear as if they were moved according to the found registration. For example, if the
registration implies a translation of (1000, 1000, 1000), then a new UCS is created placed (-1000, -
1000, -1000) away from the current one. Then, this new UCS is set as current. One benefit of this
procedure is that you can easily undo its effects, by simply setting the former UCS back as current.
The drawback is that ambiguities may rise if you work with other users that do not use the same UCS
and assume that you have geo-referenced the data, or ambiguities may rise if you import
Reconstructor models saved in earlier projects that were geo-referenced in the other way.
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Create UCS from this pose
The command is available in the item's context menu.

The context command Create UCS from this pose allows to create a new reference system – UCS
according to any item in the project.

It could be useful to create an UCS according to an object in order to help a particular visualization.

Here an example.
Use a vertical plane fitting a wall to create a point of view (and so an orthocamera, e.g.) in front of
the façade:

o define the plane 
o in the plane's context menu click on Create UCS from this pose : a new UCS is created and

stored in the folder User Coordinate Systems. 
o to set the new UCS as current,  select the new UCS and Set as current (the current UCS

appears in bold).

Define project reference system

This dialog allows you to quickly define a new UCS by just specifying one point's coordinates in the
old and in the new coordinate system.
You can input the coordinates in the “old” system in the left part of the dialog, and the “new”
coordinates in the right part. The button Define reference system will create a new UCS for you as
desired.
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You can simply copy the coordinates of a point (as below written) and paste them with “Paste from
clipboard” button filling the empty spaces.

P25 1511.342 948.368 117.280

For more sophisticated methods of georeferentiation, see also Georeferentiation.

  This tool creates a new UCS, based on the previous one and translated by an offset defined by
the vector having the two points as extremes.
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Selection & editing

This category of tools includes functions able to select portions of point clouds, and manage them.
These tools are grouped in two main families: 

Select points
To  select portion of point clouds, labeling and editing them.

Points selection with polyline
To  select points by using a 3D polyline.

Select points
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In this section you can learn
how to select portions of point
clouds to be:
 labeled
 deleted
 hidden
 copied to a new cloud

Deleting and hiding operations
can be undone.

Selection Tool

Switch between navigation (Selection OFF) and selection mode (Selection ON) by pressing the
spacebar.
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Remember that the navigation in the 3D view (changing of point of view) can only be done in
Selection OFF mode.

The pick mode is the way to interact with the 3D data displayed in the rendering window.
The Selection command helps the user to sample points in the current visible frustum from the
loaded point clouds. Both 3D information and color are sampled. The shape of the region can be
chosen with the selection mode menu.

Rectangle [Ctrl+1]
To make a rectangular selection of the point clouds in the current view.
Press Left Mouse Button (LMB) for the first point and keep it pressed while dragging the
mouse to the second point, then release the LMB.

Polygon [Ctrl+2]
To make a polygonal selection of the point clouds in the current view.
click LMB for each point of the polygon. Close the polygon by double clicking the LMB.

Lasso [Ctrl+3]
To make a free hand selection in the point cloud view.
Press Left Mouse Button (LMB) to start the polyline and drag the mouse to draw, then
release the LMB to close the polyline.

Complex selections can be performed by holding down special keys:
 Union: [Shift]
 Difference: [Alt]
 Intersection: [Shift+Alt]

When starting use the Polygon mode and switching (without closing the perimeter) to the
Rectangle or Lasso mode, a particular selection given by the combination of the two modes is
available.

Handle selection

There are two ways to manage points just selected:

 Edit inside selection

Delete inside [Ctrl+Del]
The points that fall inside the selected region are deleted from the view. They can be
undeleted at a later moment.
Hide inside [Ctrl+H]
The points that fall inside the selected region are hidden from the view. They can be
unhide at a later moment.
Label inside as...
The points that fall inside the selected region are labeled according to the layer selected
on the drop-down list to the right. 

 Edit outside selection
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Delete outside [Ctrl+Shift+Del]
The points that fall outside the selected region are deleted, and can be undeleted at a
later moment.
Hide outside [Ctrl+K]
The points that fall outside the selected region are hidden from the view. They can be
unhide at a later moment.
Label outside as...
The points that fall outside the selected region are labeled according to the layer
selected on the drop-down list to the right.

Manage cloud layers
All the points in the 3D view can have only one label  (included the default one "Not labeled"). 
All the available cloud layers (labels) are listed in the Manage cloud layers box.
By checking/unchecking them, the points related on them, are visible (or not) in the 3D view.

By using the  and  commands it is possible to add a layer to the list or delete a selected
layer from the list, respectively.

This management is useful for displaying only some desired levels  (e.g. if you don't want to
see "People") 

Edit visible clouds labeling
Once the points are selected and labeled, differents operations can be done:

Restore deleted points [Ctrl+Shift+Del]
Restores the points deleted from the visible point clouds.
See also Restore Deleted Points to learn how to undelete points from 2D view.
Restore hidden points [Ctrl+R]
Restores all hidden points in the visible point clouds, setting them as visible.

Toggle visibility [Ctrl+T]
Switches the hidden points back to visible and hides the visible points.

Copy selection to new cloud [Ctrl+Shift+C]
Copies the points that fall in the current video selection to a new point cloud.

Reset labeling [Ctrl+Shift+Del]
Resets the labeling applied to the points, which will be restored to "Not labeled".

During the standard pipeline of importing, preprocessing, registering and
georeferencing of point clouds, you can edit one or more models by performing a
manual removal of points (however a reversible operation) by the Delete inside/outside
command. After cleaning the models, you can use the Hide inside/outside tool to
highlight the regions to be labeled. A Toggle visibility button is also used to invert the
visibility of the selected regions. 

Point selection with polyline
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This is a tool for selecting points using
a 3D shape, in particular a polyline.

Drag the point cloud to be used as
source of your selection on the recipe
window. Then, drag the polyline you
want to use as contour to select points
from your cloud. Then, you need to
specify a planar reference. This can be
the current view or a custom plane.

The procedure works as follows: the
polyline is projected on the planar
reference you chose. If the polyline is
not closed, it is automatically closed by
connecting the last point to the first.
Then, the polyline projected on the
plane delimits a 2D closed region. The
points of your cloud are also projected
on the plane: the ones falling inside
the projected polyline are marked as
selected, the ones falling outside are
marked as not selected.

If no points were selected,
Reconstructor gives a warning
message and stops the procedure. If
any points were selected,
Reconstructor creates a new
unstructured point
cloud called Selection of <input-point-
cloud-name> and stores it as a new
item in the project.
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Cloud Processing

This category of tools includes functions dedicated to work with point clouds.
By applying these functions, other processes and further results are enabled.
Most of these tools work on any point cloud, some of them work only on grid point clouds (tripod
scans).

Pre-process point clouds
Applies a set of standard algorithms to process point cloud data.

Merge clouds into one
Sums together a set of point clouds in one unstructured point cloud. A sampling factor can
be defined.
Merge clouds and level3D density
Clusters together a set of point clouds in one unstructured point cloud. The final cloud
density and sampling strategy can be defined.
Resample
Resamples the point clouds given a user defined subsample factor.

Simplify points (tripod scan only)
Makes an unstructured point cloud from the structured selected cloud and creates an
hyperlink between the output and the original grid.
Extract edges (tripod scan only)
Extracts the edges as polylines from a grid point cloud. The selected point cloud must be
preprocessed running the edge detection filter.
Fill holes (tripod scan only)
Tries to fill small gaps between points
Hide black points
Deletes all the black points (RGB [0, 0, 0]).
Edit 2D (tripod scan only)
Shows a structured point cloud in a 2D view editor.

Remove duplicate points
Removes copies of points with the same coordinates inside a given point cloud.
Invert normals
Inverts the normals direction a selected point cloud.
Restore deleted points
Restores the points deleted from the point cloud.

Restore raw data
Removes any changes resulting from pre-processing or editing from selected point clouds.
The item position will not be changed.

Pre-processing Point Clouds
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During preprocessing Reconstructor® applies a set of algorithms to the range scans, which extract
information that is needed during further processing of the data. Press Load to add an external grid
point cloud or Scan subfolders to find automatically all grids in a folder and its subfolders. 
Press Remove to remove undesired grids. It is possible to process grids present in the current
project by selecting Pre-process from the context menu of the grid item in the Project Window. In
this case, when the processing is finished, the grid in unloaded from the project to free memory.
Please force the reloading to refresh the rendering. Press Start to run the processing. This plug-in
creates a separate thread for each grid so if multiple CPUs are available the processing is sped up
proportionally.
All steps are applied consecutively to the selected grid by pressing the Select All button.
Reconstructor® never overwrites the original data. The first time the pre-processing begins, a
backup of the data is created. By default the pre-processing pipeline starts from the data in its
current state. If Use backup is checked, the pre-processing reads the backup data.

 A step algorithm can be changed by clicking the algorithm name, a combo box of available
algorithm is shown. A step can be skipped by unchecking it.
The drop-down menu appears if clicking the Type item and the arrow on the right:
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Noise Removal
Range & Reflectance Gate
Min/Max range [m]: lower/upper threshold of the range. All pixels outside this range will be filtered.
Min/Max reflectance [0÷1]: all measurements that have an intensity value outside the given interval
will be filtered.
Outlier Removal
Outlier removal is a Noise Removal filter that permits to delete the lonely points outside a detected
surface, following this concept:
every point is investigated, and the N. points (i.e. Neighborhood  Size 24 )  closer to it in the 3D space
are detected. Also these points have N. points closer to them. If some point has neighbors, but
these neighbors haven't it as a neighbor (so there aren't Incoming Edges), it means that this is an
outlier.
The min. outlier likelihood is the probability that a point is an outlier: [1- (N.  of Incoming Edges)/
(Neighborhood Size)]
Lower is this value higher the number of outlier points, starting from isolated points, until groups
and edge points.
Neighborhood size: number of points closest to the current point. The minimum settable value is 11,
while the maximum value is 99.
Min. outlier likelihood [0÷1]: probability that a point is an outlier = [1- (N. of Incoming Edges)/
(Neighborhood size)]
Mixed Point Filter
Useful as a relative depth discontinuity filter. 
Min incident angle [deg]: if the line of sight from the origin of the grid to the point has incident angle
to the local surface less than this value, the point is filtered.
Mask border [pix]: the kernel of the filter is a square mask (of side 2∙border+1) centered at the
current pixel.
Please note that this filter works only on grid point clouds.
Median Filter
Mask border [pix]: the kernel of the filter is a square mask (of side 2∙border+1) centered at the
current pixel.
Please note that this filter works only on grid point clouds.
Mask Filter
Loading a 2D image file (Mask file) in which some points are colored in black (RGB = 0,0,0), the
corresponding points in the 3D point cloud will be deleted.

 The 2D image must derive from the 2D grid (look at Save Image in Edit 2D), then processed in a
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photo editing software.
Range Spikes Removal
This filter attempts to remove range discontinuities by looking at the average range of a
neighborhood of each point. Range discontinuity threshold is set to 200m and can be changed.
Neighborhood size is set to a 10 x 10 square around any given point and can be changed by editing
the "mask size parameter". Please note that this filter works only on grid point clouds.
Statistical outliers remover - SOR 
This filter firstly computes the average distance of each point to its neighbors (where the number of
nearest neighbors is defined by the Neighborhood size). After that it rejects the points that are
farther than the average distance plus a number of times  (Standard deviation threshold) the
standard deviation.

Compute Normals
Local Plane Fitting
Computes the local surface tangent plane for each point, based on the neighborhood of the pixel.
Mask border [pix]: the kernel of the filter is a square mask (of side 2∙border+1) centered at the
current pixel.
Neighborhood size [pix]:  pixels frame close to the current pixel.
Compute also curvature: set TRUE to compute it.
Adjust normals' verse in handheld scans: set TRUE if processing handheld scans.

Edge Detection
Depth & Orientation Discontinuity
Computes geometrically significant line features from the point cloud data. Two types of edges are
extracted:

 Depth discontinuities (or jump edges) that occur where the scanner hits an occlusion and
therefore the measured range jumps from a foreground to a background value.

 Orientation discontinuities (or crease edges) that occur where the object has a sudden
change of its surface orientation.

The extracted edges are stored as a bit flag for each point.
Mask border [pix]: the kernel of the filter is a square mask (of side 2∙border+1) centered at the
current pixel.
Min depth discontinuity to flag [m]: absolute depth discontinuity to filter.
Min orientation discontinuity to flag [deg]: the current point is marked if its normal differs from the
adjacent ones of at least this angle.

Compute Confidence
Weighted Average
Computes a confidence value for each measurement, which is a measure for the reliability of the
given range measurement. The accuracy does not only depend on the type of scanner used, but
amongst others also on the following factors:

 The incident angle between the laser beam and the tangent plane of the target
 The distance to the target
 The material of the object and therefore the intensity of the reflected signal

The confidence value is computed as a weighted sum of the surface normal, the range value and the
reflectance value.
Min/Max range [m]: the range is weighted by normalizing it within this interval.
Scale factor: the confidence value calculated for each pixel is multiplied with this scale. Thus the user
has the possibility to decrease or increase the weight for a given scan manually, for example
because a scanner with higher accuracy has been used during acquisition.
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Weight of range/reflectance/inclination: modify the weight as desired.

Save and Load your custom settings for specific surveys and elaborations.

Point Radius Extraction
The Point Radius Extraction define the amount of surface that every point can represent. The Max.
Radius is the  maximum radius of the aforementioned area (it's suggested to not change this value).
The result we'll be useful to splat rendering. 

Merge Clouds Into One
(Single Point Cloud Clustering dialog)

This dialog allows to lump
together in an unstructured
point cloud an arbitrary set of
point clouds, structured or not.
If you want to cluster clouds
excluding duplicated or
unneeded points, you may
want to take a look at Level 3D
density of clouds.

The selected clouds appear in
the top list of the dialog.
Below, the common color
layers across the clouds are
found. The cloud that results
from the clustering will contain
only the color layers that are
present in all input clouds and
that are chosen. Point normals
will be transformed so that
they will be correct in the
resulting cloud.

Below in the dialog, you can
specify a subsampling step if
you do not wish to include all
points of the input clouds in a
new cloud.

The clustering procedure will
efficiently exploit all CPU cores
of your PC.

Merge clouds and level3D density
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This dialog allows to lump
together in an unstructured
point cloud an arbitrary set of
point clouds, structured or not.
The resulting cloud, however,
will not contain all points from
the input clouds, but only those
needed to guarantee a fixed
3D density of the points.

Regularize the density of your clouds
Laser scanner data can have quite irregular 3D densities. For example, objects very close to the
laser scanner may be sampled at one point each half millimeter, but objects far away from the
scanner may be sampled at one point each 30/40 cm. This tool allows you to regularize the 3D
density of your clouds. The resulting regularized cloud can then be used for meshing or for
exporting in CAD tools for further analyses.

The selected clouds appear in the top list of the dialog. Below, the common color layers across the
clouds are found. The cloud that results from the clustering will contain only the color layers that are
present in all input clouds and that are chosen. Point normals will be transformed so that they will be
correct in the resulting cloud.

Options
In the lower half of the dialog, some options are present. The first is of course the desired 3D
density, expressed in minimum point-to-point distance. Then, you can also select the strategy for
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choosing the representative point of each 3D cell (defined by edges equal to the set 3D density -
center point-to-point distance):
 Randomly: the point will be randomly chosen between the points within each 3D cell volume
 Closest to the cell's centre: the point will be randomly chosen between the points within each 3D

cell volume
 Point with best confidence : the points with higher confidence will be chosen

Resample

This tool allows you to
resample point clouds. It
works on any set of grid
point clouds or
unstructured point
clouds.

On top of the dialog you are asked to input the subsampling factor s. A new point cloud will be
created taking one point each s from the original cloud. If you are resampling grid point clouds, the
resampling operation will take into account the structure of the grid. Therefore, the grid structure
will be divided in cells with size square_root(s) by square_root(s), and one point will be taken for each
cell. To clarify this, in the grid point cloud case the dialog shows you a message with the original and
the resulting grid size, as in the figure above.

Optionally you can hyperlink the subsampled scans with the higher resolution ones. This allows you
to work with a lot of data by doing operation on the light versions of the data.

Simplify Points
Input data: at least one grid point cloud must be selected.
Output: a new unstructured point cloud is created for each structured cloud in input.

This functions takes as input a set of structured point clouds. For each of them, it determines the
most relevant points from a point of view of shape description, and it saves them into the new
unstructured point cloud. These resulting clouds work as compact representations of the original
structured ones. They can be hyperlinked to the original clouds, so that you can open the original
data on demand.

The function works by creating a mesh in background of each input cloud, and by inserting into the
resulting cloud the mesh's vertices.
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Extract Edges

This tool allows you to
extract the edges of a grid
point cloud, in form
of polylines. You can also
activate this function from
the top menu by
clicking Data management
> Cloud processing >
Extract edges (tripod scans),
or by the context menu of
any grid point cloud.

 The selected point cloud must be pre-processed running the Edge Detection filter. 

You can select which discontinuities in the 3D point cloud you want to mark as edges. These can be
the Depth discontinuities (points that are neighboring in the grid structure but far away in 3D
position), the Orientation discontinuities (points that are neighboring in the grid structure, close to
each other in 3D position, but having normals very different), or both.

The parameters Max search distance and Min edge length define the way edges are extracted. Max
search distance is expressed in pixels and refers to distances in the grid's structure (range image).
Max search distance determines how far away in the grid structure two points belonging to the edges
must be connected in the same edge. Min edge length means that all the edges composed by less
points than this parameter will be considered as noise and discarded.

Fill Holes

Input data: exactly one grid point cloud must be selected.

This functions takes as input exactly one grid point cloud, and tries to replace any invalid point in the
cloud with a value averaged from the point's neighborhood in the cloud's structure. After activating
this tool, Reconstructor asks you the mask border M: the search neighborhood of each point is
defined by the (2M + 1) * (2M + 1) points located around the given points in the cloud's structure.

This tool is useful to cover small points in a cloud's structure, in order to get more connected
meshes using the multiresolution mesh.

Hide Black Points

Input data: at least one structured or unstructured point cloud must be selected.

This functions takes as input a set of point clouds, for each of them takes the current color layer and
hides all the points in the cloud that are colored in full black, i.e. RGB components [0 0 0].
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The hidden points can be made visible again with the Restore hidden points [Ctrl+R] command in the
Select points tool.

Edit 2D Grid Window

This window shows a grid point cloud in its 2D representation. Like in a geographic 2D map of the
world, the grid point cloud is represented as an image where, for each point, the x coordinate is the
yaw angle (longitude) and the y coordinate is the pitch angle (latitude) that the laser had while
surveying that point.
In this window you can select, delete and undelete points with several functions.

To interact with the image
 Zoom in/out: Alt + mouse wheel
 Fit the image in the window: Alt + Middle Mouse Button (MMB)
 Reset to original size: Alt + Right Mouse Button (RMB)
 Translate the image: Shift + LMB drag
 Space bar: rotate image 90 degrees
 Show/hide zoom window: Z key
 Move zoom region inside global view: [Ctrl + LMB]
 While keeping pressed ...

o Shift: to perform union of regions
o Alt: to perform subtraction of regions
o Shift+Alt: to perform intersection of regions

Pick mode
 Point: pick a point and save it in a point list if Add to point list button is pressed.
 Rectangle: press Left Mouse Button (LMB) for the first point and keep it pressed while

dragging the mouse to the second point, then release the LMB
 Polygon: click LMB for each point of the polygon. Close the polygon by double clicking the

LMB
 Lasso: press Left Mouse Button (LMB) to start the polyline and drag the mouse to draw,



Online Help Reconstructor 4.4

197 / 361

then release the LMB to close the polyline

Edit operation
 Copy: create a new grid point cloud from the selected region
 Cut: delete the selected region
 Undelete: undelete the points inside the selected region
 Mirror: inverts the grid along the width. Only the ordering of the grid is changed, the 3D

points are untouched
 Flip: inverts the grid along the height. Only the ordering of the grid is changed, the 3D

points are untouched
 Transpose: transposes the grid. Only the ordering of the grid is changed, the 3D points are

untouched.

Point picking
 Color layer: display the grid with the selected color layer. Press the right arrow to show a

menu of available commands for the current color type
 Histogram: press the black arrow to select the histogram tool that allows to optimize the

contrast by histogram stretching (available only if the model is loaded in memory and if the
current color type is 1f or 1d, i.e. a high-dynamic single-channel point color).

 Object/UCS/world coordinates: display the coordinates of the point into the desired
reference system (from object pose, in the current UCS and in the Main UCS).

 Add to point list: add the picked points to the project's point list.
 Save image: save the current image to file.

Remove Duplicate Points

Input data: at least one unstructured point cloud must be selected.
This functions takes as input a set of point clouds and, for each given cloud, it invalidates any point
that has exactly the same coordinates of another point in the cloud.
Since JRC Reconstructor® 3.2, this function is automatically applied to all point clouds while importing
them. Therefore, you should not need to use it. However, you can run it on clouds imported with
previous Reconstructor® versions. After its conclusion, this function prints to the Log window the
number of removed points per cloud.
Once removed, the duplicated points cannot be restored in any way.

Many laser scanners write raw data files with a lot of points in (0, 0, 0) that, if not removed, risk to
undermine further processes like filtering or mesh creation. When importing clouds into Point R3, all
duplicate points must be removed.

Invert Normals

Sometimes unstructured clouds present difficulties in calculating normals.
When the normals have opposite direction to the correct one this filter allows to flip them and solve
the problem.
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To turn on the "hairy view" open the
Display and navigation Options
window and check Render models'
normals.

Normals on the contrary:

Correct normals after the Invert Normals command:
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Restore Deleted Points

Sometimes happens that any point are deleted for mistake. 
In Reconstructor® there's a method to recover deleted points, even in different times, valid for both
Grid and Unstructured point clouds.
Restore Deleted Points (also available in the contextual menu of the point cloud) permits to undelete
all points previously deleted.

If you want to undelete only the points in a defined area, the 2D edit it's the right way. It runs only
for Grid point clouds. 
Select a region containing the portion before occupied by the deleted points using a pick mode and
then click on Undelete command.
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See also Edit 2D Grid.

Restore Raw Data

This functions takes as input a set of point clouds and undoes any operation of preprocessing,
deletion and editing that may have been performed on the clouds.
Its main usefulness is to guarantee that you never lose data: if you are not happy with an editing
operation or with the result of a filter, you can always go back to the clouds' raw data, as if they were
just imported.
At least one point cloud must be selected as input data.

When applying this function:
 Points invalidated by the range and reflectance gate are valid again
 Points invalidated by the outlier remover filter are valid again
 Points invalidated by the mixed point filter are valid again
 The effect of any application of the median filter is undone
 Flags of points as depth or orientation discontinuities are deleted
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If Restore delete/hidden points is flagged all deleted points are reset and all hidden points are visible
again.

If Reset color mappings/color scales to default settings is flagged all the color scales of the selected
point clouds are reset.

 This operation can be used to recover some hard disk space. If necessary, it is then possible
to re-modify the colors mapping settings with little effort.

A list of color layers available for the selected clouds is displayed in the second part of the dialog.
Here it is possible to flag the color layers that you want to delete.

Between them two particular layers need attention:
 Reflectance layer cannot be delete, since it is usually included in the raw data
 Inclination layer can be deleted only if generated by standard Reconstructor's pre-processing.

 The Restore raw data process is non-reversible, so be careful in using it.
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Meshing

This category of tools comprehends functions dedicated to work with meshes:

 Mesh creation includes  tools to extract different type of mesh from point clouds or list of
points

 Mesh manipulation includes tools to edit and manage meshes, and convert them in point
clouds.

Mesh creation

In this section you can first learn how to create triangle meshes. 

Reconstructor® provides many typologies of mesh creation techniques.
Different number and type of point clouds can be used as a basis to create a mesh, depending on
the meshing technique:

On
Grid
Point

Clouds

On
Unstructur

ed Point
Clouds

Suggested for…

Multiresolution Mesh
Fast meshing technique that give back
light meshes that may have holes in
some situations. ü

(one or
more)

To obtain a well
defined and fast
mesh from a
single structured
point cloud, with a
good
quality/computati
onal time ratio

Mesh from predefined view 
Relatively slow meshing technique that
gives back convex meshes without holes.
It’s a view dependent, high defined  mesh
(each point is a vertex)

ü
(one)

ü
(one –

single or
clustered

point
cloud)

Useful for façades
(using
orthocamera) and
tunneling (using
cylindrical
camera)

3D Mesh 
Approximative 3D meshing not view-
dependent and taking as constraints the
points' positions and orientations
(normals)

ü
(one)

ü
(one –

single or
clustered

point
cloud)

Useful for convex
surfaces. 

Topographic Mesh 
The algorithm designed for DTM models.
It gives back a watertight
Fast meshing, light, smoothed mesh
useful for isolines and volumes
calculation.

ü
(one or
more)

ü
(one or
more)

Useful for land
survey and mining

Mesh point list
Two methods to transform a list of point
into a mesh ü ü

To create simple
meshes
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Multiresolution Meshing 

Multiresolution Meshing is possible only with Grid point clouds. If you want to generate a mesh from
an Unstructured point cloud, first transform it in a Grid point cloud by using the Virtual scan tool.

NOTE
Before meshing you need to Preprocess the Grid.
During the meshing the software will use the Edges calculated at the pre-processing stage:

 Angular discontinuity : set the angle [deg]; the higher the angle
value, the higher the detail of the calculated edges. Close to the
angular discontinuity you will have more detailed triangles

 Depth discontinuity: set the minimum distance [m] two points
have to be considered as belonging to two separate objects à no
triangles are created between two far points. The lower the
distance value the more holes are filled.

 
The Multiresolution Mesh tool is accessible from Tools→Meshing→Multiresolution Mesh,
from the corresponding button in the top toolbar, or from the context menu of grid
items in the project window.
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 Press Load to add an external grid point cloud or Scan subfolders to find automatically all
grids in a folder and its subfolders. Press Remove to remove undesired grids. 

It is possible to process grids present in the current project by selecting Meshing from the
context menu of the grid item in the Project Window. In this case, when the processing is
finished, the grid is unloaded from the project to free memory. Please force the reloading to
refresh the rendering. 
 Press Start to run the processing. This plug-in creates a separate thread for each grid so if

multiple CPUs are available the processing is sped up proportionally.
The meshing process is applied consecutively to the selected grid by pressing the Select All
button.
 To modify the meshing parameters press Advanced, then select one or more rows in the

list of models with Ctrl or Shift. The parameters are updated for all the selected models. 
 It is possible to Save the meshing parameter and Load them for other scans or projects or

Reset them to default values.

Triangulation
The triangulation algorithm can be changed by clicking (three times) the algorithm name, so a combo
box of available algorithm is shown.

Uniform
All the 3D valid points are connected with triangle meshes to build the range surface, without
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simplification.
The algorithm checks if 2 points are divided by a depth discontinuity, in that case no “false” triangles
are created.

Save as: check the file name of the resulting mesh.
Color mapped: select the color assigned to the vertexes of the mesh (e.g. Reflectance,
Color, Inclination, Confidence, …)

Multi-resolution
Simplified (lighter) triangle meshes are created in “flat” areas and dense triangle meshes are created
in geometrical complex areas (close to edges or curvatures), satisfying an approximation error
threshold.

Save as: check the file name of the resulting mesh.
Max triangle size [pix power of 2]: 2 [number of points],, it’s the size of initial triangle; the value you
can set is [number of points] you want to skip in the flat area. The higher the value, the
more the mesh gets simplified. As example, a value of 4 means that a triangle will be
created for a square wide 2^4=16 pixels. If the approximation error is too high, the triangle
will be subdivide in smaller pieces.
Color mapped: select the color the color layer you want to map.
Use orientation discontinuity: thepre-processed orientation discontinuity is used to drive
the subdivision process in order to preserve features such as edges. Set to TRUE to have
more triangles around the edges.
Min triangle aspect ratio: minimum accepted triangle aspect ratio. If the triangle is too thin
it will be subdivided in smaller pieces. This test is performed only for the initial triangle.

[Note: Aspect ratio of a triangle is the ratio of the inradius to its circumradius). The aspect
ratio of a triangle lies between 0 and 0.5. For triangles with an angle near to zero, the aspect
ratio is 0; for equilateral triangles, the aspect ratio is 0.5.]

Accuracy [m]: max approximation error of the mesh. The higher the value, the lesser
triangles you have.
Create texture for color mapped : a texture is generated from the selected Color mapped on
the mesh. Set to TRUE if you want the color layer not to lose resolution with the mesh
simplification.

In the images below an example of the use of two different set of parameters is showed.
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See also other Meshing techniques. 

Meshing from predefined view
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This is a meshing technique that provides watertight meshes. It assumes that the desired mesh is
such that each point of it has one and only one projection according to a predefined view. In other
words, it assumes that a perspective, orthographic, cylindrical or spherical projection exists such that
the desired mesh never hides parts of itself if seen from that projection.

In order to create the mesh you need:
1) An ustructured or structured point cloud: drag from the Project window the point cloud you

want to mesh. 
2) A view: you need to indicate also which view should be used to build the mesh. The current

view can be used, otherwise you can use any camera from your project (see below for
some examples).

Create a mesh from an orthographic
view: a façade

Create a mesh from a predefined cylindrical view: a
tunnel
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When the cloud and the viewpoint are selected, press Ok and wait for the end of the meshing.
You can also cancel the meshing while it proceeds. At the end of meshing, a dialog shows you
the new mesh's name and properties.

This algorithm works by projecting all the points of the cloud on a 2D surface: the near plane of the
selected projection. Then, these points in 2D are meshed with a standard 2D meshing algorithm:
Delaunay. The resulting mesh is then projected back into the 3D space.
This meshing technique is interpolative: each point of the input cloud is considered as vertex of the
output mesh. Reconstructor®'s Multiresolution and Topographic meshes are,
instead, approximative meshing techniques: some points can also not be mesh vertices if they don't
significantly modify the surface's shape. For this reason, this interpolative technique is generally
slower than approximative ones, and produces heavier meshes. However, it always produces
watertight meshes. 
Heavy meshes or meshes with wrong shapes can be simplified and edited in the mesh editor.

See also other Meshing techniques. 

3D Meshing (Poisson reconstruction)

This tool allows you to reconstruct a triangle mesh from any point cloud. Unlike uniform or
multiresolution meshing, this technique does not need the input cloud to be structured. Also,
unlike meshing from predefined view and topographic meshing, this technique is not view-
dependent. It reconstructs a connected, watertight surface taking as constraints the points' positions
and orientations (normals).
It’s suggested to reconstruct a convex (closed) surface.

If you need to work with a set of point clouds (structured or not), it’s better to lump them
together in an unstructured point cloud using the Level 3D density of clouds command.

In the 3D Meshing Dialog you can manage some parameters' presets to obtain a best fitted mesh.
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Adding color
In the first parameter box of the dialog, you can select by the flag whether the output mesh should
be colored or not, and which of the input cloud's color layers should be used.
Resulting mesh resolution
While meshing from predefined view is interpolative, this reconstruction technique
is approximative: it creates a triangulation that approximates the surface described by the points. In
the second parameter box, you can specify how many details you want to preserve in the output
mesh. The higher the resolution (from Low to High), the finer the details that will be reconstructed,
and also the heavier the mesh file and rendering time.
Input cloud noise level
In the third parameter box, you can take into account the cloud smoothness, according to the point
cloud noise.

If your cloud represents clean construction data, then select Low. If, however, your cloud
contains noisy territorial data, then select High.
Size of holes to close and islands to remove
In the last parameter box, you can specify the size of the holes that are going to be closed in the
mesh, and the size of the “islands” (small disconnected components that may have been created) to
be removed (or not). The size is computed as ratio between the area of the hole/island and the area
of the whole mesh.

Raw parameters
By clicking the Raw parameters button, a new dialog expliciting all the parameters will appear.
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 Max depth: it is the maximum depth of the tree that will be used for surface reconstruction,
defining the resolution of the final mesh. Running at depth d corresponds to solving on a grid
whose resolution is no larger than 2^d x 2^d x ... Note that since the reconstructor adapts the
octree to the sampling density, the specified reconstruction depth is only an upper bound.

Generally, the bigger is the value, the better is the reconstruction - preserving more details -
but more time is necessary. For almost all uses keep the value between 8 and 12, and not to
increase it more than 20 because it is usefulness and no details are added.

 Resolution: as an alternative to the Max depth parameter, the resolution can be directly set
changing this value defining the density of the initial point cloud.

 Scale: it specifies the ratio between the diameter of the cube used for reconstruction and the
diameter of the samples' bounding cube. The default value is 1.1.

 Samples per node: it defines how to smooth the final mesh. SPN is the minimum number of
sample points that should fall within an octree node as the octree construction is adapted to
sampling density.
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For noise-free samples, small values in the range[1.0-1.5] can be used. For more noisy
samples, larger values in the range [15.0-20.0] may be needed to provide a smoother, noise-
reduced reconstruction.

 Point weight: it defines the capacity of the algorithm to preserve the details.

If you have small disalignments or "double surfaces" in the point clouds, it's suggested to set
small values, from 0 until 4. Otherwise set 4 or larger values.

 Iterations: it specifies the number of Gauss-Seidel relaxations to be performed at each level of
the hiearchy. The default value for this parameter is 8.

 Use confidence: flagging this parameter, the quality of the points (defined by the confidence
value, if present in the initial point cloud) will be used to obtain a better reconstruction. The
normals are here normalized using the confidence values.
Confidence bias: it specifies the exponent to be applied to a point's confidence to bias the
resolution at which the sample contributes to the linear system. Points with lower confidence
are biased to contribute at coarser resolutions. The default value for this parameter is 0.

 Linear fit: enabling this flag has the reconstructor use linear interpolation to estimate the
positions of iso-vertices.

 Boundary type: it specifies the boundary type for the finite elements. choosing between Free
boundary constraints, Dirichlet boundary constraints and Neumann boundary constraints. The
default value for this parameter is Neumann.

 Color pull factor: if the input points have additional data as color, that is to be sampled at the
output vertices, this value specifies the relative importance of finer data over lower data in
performing the extrapolation. The default value for this parameter is 32.

By flagging Trim resulting mesh it is possible to reduce the output mesh extents so as to match as
best the input cloud extents. The triangles with vertices having the lowest density values, that are
the farthest from the input cloud, will be detected and removed.
 Trim value: it specifies the value for mesh trimming. The subset of the mesh with density value

less than the trim value is discarded.
 Island area ratio: it specifies the area ratio that defines a disconnected component as an "island".

Connected components whose area, relative to the total area of the mesh, are smaller than this
value will be merged into the output surface to close small holes, and will be discarded from the
output surface to remove small disconnected components. The default value 0.001.

 Smooth iterations: it values the number of umbrella smoothing operations to perform on the
density cloud before trimming. The default value is 5.

NOTE: the algorithm is based on the Poisson Surface Reconstruction code developed by Misha
Kazhdan et al.

See also other Meshing techniques. 

Topographic meshing
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This function implements topographic meshing of a set of point clouds. This procedure takes a set of
point clouds and creates a DTM regularly sampling the clouds. The resulting mesh is watertight if the
default parameters are used, and it is colored according to the altitudes: points at minimum height
are in red and points at maximum height are in violet, passing through all hues.

The user can also input a polyline to determine the points to be meshed (seen from a nadiral view or
from a user-specified orthocamera). It is strongly recommended to input a polyline in order to help
Reconstructor to concentrate only on the useful points and to speed up the process.

If the user doesn't specify any orthocamera, one is created so that it is nadiral (oriented towards -Z
axis in the current UCS) and it contains the polyline. Once the user inputs the clouds and – optionally
– the polyline, meshing starts by pressing Ok.

The procedure is composed of the following stages:
 Virtual scan is performed from the (nadiral) orthocamera, to uniformly sample the point clouds.
 Then, spikes in the resulting samples are smoothed using a median filter based either on a

neighborhood of given size, or on a window of fixed size.
 Successively, a polynomial interpolation (ordinary gridding) is used to fill holes. This eliminates

holes in the samples and guarantees the result mesh to be watertight.
 Then, a part of the obtained grid point cloud is selected using the polyline and the orthocamera.
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The selection with polyline allows the user to specify the region that he/she wants to be meshed.
 Subsequently, a median is applied to the resulting grid, to smooth it out.
 Finally, the resulting mesh is obtained by multiresolution meshing, filling all holes.

The mesh is saved in the project, under the name Topographic mesh of <n> clouds.
This procedure is relatively fast and useful especially for terrains. It outputs a mesh with nice
properties: watertight, light and smooth (without spikes). The procedure can be customized by
clicking the set parameters button.

Topographic meshing parameters

In this dialog you can set the parameters of the topographic meshing procedure.

This dialog shows from top to bottom the four stages of the topographic meshing procedure. You
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can customize the parameters of each stage, and even decide to skip stages 2 and 3 by unchecking
the respective boxes.

 Stage 1: DTM generation. The terrain sampling step is the fundamental parameter of this
procedure. It is important to pay attention that this step is meaningful in relation to the
dimensions of the desired model. If I want a mesh of a terrain of 20 m², I shouldn't use a
sampling step of 0,5 m, otherwise I'll get too few samples. A small step will produce more
accurate and heavier meshes. A big step will give less accuracy and also less memory occupied
by the final mesh.

 Stage 2: despiking. Despiking is very useful to delete noisy data (e.g. vegetation) and therefore
to have more precise calculations of volumes and isolines on the resulting mesh. Despiking is
done with a median filter running on the grid point cloud obtained in the former step. As the
dialog shows, the median filter can run on the N nearest neighbors of a sample, or on a window of
samples of fixed size, regardless of how many samples are actually in the window.

 Stage 3: hole filling. This is performed by taking, for each missing sample in the grid point cloud,
the <neighborhood size> samples closest. Polynomial interpolation is used to decide the height
position of the missing sample. After the hole filling, another median filter is run on a square of
samples of fixed size. The user can save the grid point cloud obtained till here by checking Save
grid to project before meshing. This can be useful for example to mesh the grid using a color not
related to the altitudes.

 Stage 4: meshing. In the end, the grid point cloud is meshed using one of the two techniques
described here. Since at this stage the grid point cloud should be smooth, regular and without
holes, there is no reason to change these parameters except for very particular cases.

Use the Reset to defaults button on bottom left if you are not sure of what is happening. However,
topographic meshing is so fast that it is worth to try many combinations of parameters and compare
the results.

See also other Meshing techniques.

Mesh point list

This options creates a triangle mesh using as vertices the points listed in a point list.

Reconstructor asks you whether you want to mesh the points projecting them onto the current view
and using a Delaunay 2D meshing algorithm, or whether you want to create a “3D hull”: a convex 3D
polygon containing all the points.

Mesh manipulation

In this section you can first learn how to edit triangle meshes to select and to filter them and so to
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obtain a better result from your data.

Reconstructor®  offers several functions for editing meshes:

Mesh Editor An editing environment to perform advanced
operations such as hole-filling, borders detection,
editing triangles and vertexes, smoothing surfaces,
decimating, crests and toes extraction.

Mesh selection from
current view point

To cut a portion of a mesh using 2D video selection
tools on the current view.

Mesh selection  with 3D
polyline

To cut a portion of a mesh using an input mesh, a 3D
polyline and a viewpoint

Merge meshes into one This dialog allows to lump together in a single mesh an
arbitrary set of triangle meshes

Convert mesh to point
cloud

To create an unstructured point cloud from the
vertexes of the mesh using the color attribute of the
mesh

Get mesh borders as
polyline

To create a new polyline containing the mesh's
borders and add it to the project

From the item's context menu other commands are available:

 Compute mesh normals
To compute or update the triangles' normals for the mesh.
 Invert winding
This command inverts the ordering of the vertexes for each triangle, so the surface is flipped to the
opposite side and also the normals are inverted.
 Compute area
This command returns the mesh area as sum of the areas of all the mesh's triangles.
 Compute volume from Z=0 plane
This command returns the volume resulting from integrating the mesh on the XY plane of the
current UCS. Mesh triangles below the XY plane will result in zero volume. 

Mesh Editor
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This dialog is an environment designed for advanced mesh editing operations. It works on one mesh
at a time. It is accessible from Data management→Meshing→Mesh editor, from the corresponding
button in the top toolbar, or from the context menu of any mesh in the project window.

From top to bottom, the dialog displays the mesh's full path, then a toolbar with groups of buttons,
then a navigable 3D view to show the mesh, and lastly information on triangles and vertices count.

File
This button group provides the Save and Save as options. These are needed because the
edits performed in this dialog are not automatically transferred to the mesh in
Reconstructor®'s project.
In fact, if you close the dialog you are asked if you want to save or discard the changes.

Geometry
This button group allows you to switch between the three visualization possibilities of a mesh: 

only vertices,

only triangle edges (wireframe),

or the triangle's faces (flat).

The button backface allows you to show or hide the triangles' backface.
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Coloring

and

 

The first two buttons allow you to change how to color the mesh: using the colors
associated to the vertices, or using a gray color that changes only according to the triangles'
inclination with respect to the light source. 

The button boundaries highlights in bright red all the boundary edges of the mesh, and it is
particularly useful to quickly spot where the mesh has holes to fill or imperfect boundaries
that should be corrected.

Selection
Here you can use several selection modes. 

When the button None is checked, you can navigate the mesh. 

By clicking Triangles, you start selecting the mesh triangles by drawing a rectangle on the
viewport. Selected triangles are highlighted in yellow. 

The button Invert enables you to invert the current triangles selection. 

The button Boundary turns on another selection mode. In this mode you can select one of
the circular boundaries that the mesh has. Boundaries are polygons formed by those mesh
edges who belong to one and only one triangle. A closed mesh has no boundaries.
Boundaries selected in this mode may delimit a hole that you want to close. After selecting
the hole's boundaries, you can click on Close boundaries in the Editing button group.
By pressing the button Close all the triangles will be deselected.

 When selecting and managing triangles the Flat geometry must be selected in order to
visualize the triangles' surfaces colored in yellow after the selection process.

Editing
Once you have selected some triangles with the command Triangles, you can delete the
selected triangles with Delete triangles. 

By using the Close boundaries button  you can close a mesh hole whose boundaries have
been selected with Boundary command.

This function works best with small and with close-to-planar holes.

Filter
This button group contains four functions:
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The Decimation tool allows you to simplify your mesh substituting small triangles with
bigger ones if the mean-square error introduced in this way is smaller than a user-
customizable threshold.. Simplification is based on conveniently collapsing edges among
triangles.
For each edge shared by two triangles,  Reconstructor® assesses whether collapsing it or
not. Collapsing an edge means assigning the edge's two vertices to coincide in the edge's
middle point, and adjusting all neighboring triangles consequently. If the quadratic error
between the surface before and the surface after the collapsing is below the
parameter Max quadric error  of the dialog, then the edge is collapsed.
The algorithm tries to collapse a percentage of edges as specified by the parameter Edge
collapses, where 0.1 stands for 10%.

This De-noise algorithm allows you to de-noise your mesh, meaning to iteratively eliminate
spikes  from your mesh, without changing the surface's volume.
A smoothing filter is run on the mesh for as many times as the parameter Iterations says.
This filter has anisotropic properties: it eliminates the spikes without changing the surface's
volume. Along the iterations, it distributes the volume from the spike to the neighboring
triangles.

The Triangles remover tool select the triangles that have at least one side greater than the
entered threshold value Triangle side length in meters.

It can be useful to remove stretched triangles in correspondence of areas of 
discontinuity or large triangles at low density on the boundaries.

 The triangles corresponding to this filter will be colored in yellow in the 3D view. You
can remove them by using the command Delete triangles.
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The Trim mesh tool select the triangles along the boundaries of the mesh. These triangle
have at least one side not connected with another triangle.

 The triangles corresponding to this filter will be colored in yellow in the 3D view. You
can remove them by using the command Delete triangles.

If the MINING add-on is activated, also the  Crest and toe command will be included in this section.
You can access it through the dedicated command in the MINING toolbox bar.

Crest and toe is a semi-automatic technique to detect crests (prominent mesh edges) and
toes (reentrant mesh edges). When you open this dialog, the crests and toes are calculated
and drawn in the mesh editor. Crests are drawn as blue polylines, Toes are in red. Crests
and toes can be then saved as polylines.

The idea is that tool shows you an initial extraction of crests and toes, successively you
refine the parameters of extraction and see the effects of your changes in real time. You
can refine the parameters until you are not satisfied, and then save the crests and toes as
polylines in the project. The parameters of crests&toes extraction you can modify regard
the curvature, the horizontality, the length of the edges and the gaps between them. While
you modify the parameters and recompute the crests&toes, you can choose to turn on or
off the visualization of the crests, the toes and the mesh, via the three check-boxes in the
Draw groupbox at the bottom of the dialog.

Curvature filter
The topmost slider of the dialog allows you to modify a threshold on the curvature of the
crests and toes. Crests and toes are edges shared by your mesh's triangles. Each edge has
a curvature associated, depending on the angle between the two associated triangles. A
threshold on the curvature filters out the smoother edges and leaves only the steeper
ones, which normally are the most important. Scroll the slider to see the effect of the
threshold in real time.
Orientation filter
Below the curvature filter, you can also activate a orientation filter. This filter keeps only
the edges whose angle with respect to the horizontal plane is close to the angle you
indicate with the slider. In this way, you can choose to keep only the horizontal edges, or
the vertical ones, or the ones with a given inclination.
Close gaps in edges
Sometimes crests and toes come in many segments with small gaps among them. In the
groupbox Close gaps in edges you find a tool to close those gaps and get the crests and toes
as continuous polylines. You can set the maximum gap distance to close, and press Apply.
Reconstructor will start closing the gaps from the smallest to the biggest, without creating
loops or bifurcations.
Delete short edges
In the Delete short edges a tool comes to filter out polylines whose total length is less that
the specified parameter. Normally you want to discard short edges because they are not
the main ones. The main ones should instead be found by closing the gaps among them.
General procedure
As general procedure, we advice to use the described filters in the order given above, and
to close and open the dialog if the result is not satisfactory. Once the extracted crests and
toes are good enough to describe the important edges of your model, press Save as
polylines at the bottom of the dialog. New polylines with the crests and toes will be added
to your project.
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Make single mesh
This dialog allows to lump together in a single
mesh an arbitrary set of triangle meshes.

To activate this dialog, you can select a set of
triangle meshes from the project window and
select Meshing ->Make single mesh from the
contextual menu or from the Tools menu.

To add more meshes to cluster together, click Add
files on top left to open point mesh files (.rtm).
By clicking Process on bottom left, you start the
clustering. 
A new mesh is created that simply contains all the
triangles of the input meshes.

See also triangle meshes.

Mesh selection  with 3D polyline
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The 3D mesh selection works with an
input mesh, a 3D polyline and a
viewpoint that can be defined by
an orthocamera, by a plane or by the
current view.

The polyline, seen by the input
viewpoint, determines a frustum that
intercepts the mesh defining a portion
of it. This portion is acquired by
doing Virtual scan, and uniformly
meshing the resulting grid point cloud.
The virtual scan is always done with an
orthocamera that Reconstructor®

creates internally.

When selecting the polyline and the
viewpoint, the user doesn't need to
check whether the polyline is
contained in the orthocamera's
frustum, or how the polyline is
positioned with respect to the plane.
Reconstructor, in fact, creates an
orthocamera whose frustum is
automatically enlarged to include all
the polyline. This automatic expansion,
however, does not take into account
the mesh (this is done to fully exploit
the orthocamera's resolution on the
selection region).

The resolution of the internal
orthocamera is calculated
proportionally to the input mesh's
vertices amount, so that the scanning
is precise enough to preserve the
input mesh's features.

If a plane is given as input,
Reconstructor® creates an
orthocamera that points in the plane
+Z direction. If the polyline and the
mesh are in the -Z semispace, they will
be included anyway in the selection
because the orthocamera will have a
negative near plane. However, the
direction of the plane (or of the
orthocamera) influences the winding
direction of the mesh that results from
the selection.
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Convert mesh to point cloud
This recipe window allows the user
to transform a mesh into an
unstructured cloud of points.
Three methods are available:

 Use fast sampling procedure
converts the mesh picking a
point about every sampling
step.

 Enforce better sample spacing
properties converts in a better
way the mesh, respecting more
faithfully the sampling step; it
takes longer than the previous
method and requires more
amount of RAM. Not
recommended for large meshes
or for very high sampling.

 Collect meshes vertices in the
output cloud simply transforms
the vertices of the mesh into
points of the resulting cloud

Get mesh border as polyline

This tool is used to create a new polyline containing the mesh's borders and add it to the project.

Mesh selection from current view point
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This function allows to cut a portion of a mesh using 2D video selection tools on the current view. 
It is accessible through Tools-> Meshing->Mesh selection from current view point. When you activate
this function, the window above appears in the recipy window, and Reconstructor®'s 3D window
goes in Selection mode.
Drag a mesh from the project window and drop it on the window shown above. The mesh must be
loaded for the procedure to work. Use one of the three video selection tools to select the desired
portion of mesh, and press Select. The dialog shown below appears:

The dialog above shows the name of the mesh created from the selection, and information about
area and triangles count. After closing the dialog, you may want to go back to Navigation mode by,
for example, pressing the space bar.
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Geometric Shapes

Points, Segments, Plans, Circles, Cones, Cylinders, Spheres, Polylines: each type of geometric shape
has a special recipe window for its creation, fitting and editing.

Manage Points
To edit and use points lists.

Basic Shapes
To create and edit segments, polylines and planes.

Second Order Shapes
To create and edit second order shapes like circles, spheres, cylinders and cones.

Shapes Interactions
The geometric shapes can be interact between them to extract intersections and
distances.

Manage points

 All the points picked or imported in Reconstructor® can be edited and used to extract shapes.
The below tools can be found into Data management > Geometric Shapes Top menu and in the
Manage points menu in the Top toolbar.

Edit point list

Export point list

Polyline from point list

Fit shape to point list

The point list context menu
In addition of the previous ones, other tools are achievable in the point list's context menu:

 Mesh point list
 Flythrough from point list
 UPC from point list: the selected list of points is saved as an Unstructured Point Cloud

and added to the current project, so it can be exported to other formats.
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Edit point list

The point list window works as a collector of selected points, which can then be used for various
purposes: defining a polyline, a mesh, a video trajectory, creating a plane, calculating distances,
performing point-based georeferentiation, etc.

While navigating the 3D scene, with Alt+left mouse button double click you can select points on your
3D models. The selected points appear annotated in the 3D scene and listed in a group called Picked
points. You can create new groups and move on them some points to create other point lists.

The toolbar of the Edit points window
Once you have collected or imported the points, you can perform several operations on them.
These are accessible through the point list window toolbar. Below, the toolbar buttons are described
from left to right:

 Add a point: adds an empty row in the list, to input manually 3D coordinates.
 Delete selected points: removes the currently selected row in the list. With [Ctrl] or

[Shift] keys multiple rows can be selected, and deleted with the DEL key.
 Go To: move the view next to the point
 Import a list of points: loads a list of points by parsing them from a text file via the parse

point list tool.
 Export points: saves the point list to a text file, writing one row per point in the format

label, x, y, z. See Export point list for file formats.

Export point list

This function exports a list of points ( in *.txt, *.csv, *.tsv formats) including labels and coordinates (in
the current UCS).
It is available in the context menu, in the File > Export menu, in Meshes > Manage points and in the
Edit Point List command.

Only few points can be exported, according to the criteria:
 If a group of points is selected in the Project Window, before to select the Export point list tool,

only the points in this group will be exported
 If the "Picked Points" group is selected in the Project Window, before to select the Export point

list tool, all  the points (in this group) will be exported
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 If few points are selected (by pressing Ctrl button)  in the Project Window, before to select the
Export point list  tool, only these selected points will be exported.

Three formats are available:

 Comma Separated Value (*.csv)
Comma "," is used as separator.
Pt000,-13.9153,-15.7213,11.9317
Pt001,-36.6361,15.7372,6.3014
Pt002,-15.1782,6.6534,8.5348

 Tab Separated Value (*.tsv)
Tab "Space" is used as separator.
Pt000 -13.9153 -15.7213 11.9317
Pt001 -36.6361 15.7372 6.3014
Pt002 -15.1782 6.6534 8.5348

 Text (*.txt)
Tab "Space" is used as separator.
Pt000 -13.9153 -15.7213 11.9317
Pt001 -36.6361 15.7372 6.3014
Pt002 -15.1782 6.6534 8.5348

Polyline from point list

This option will store all the points in a polygon and save it as a polyline in the project. 
Reconstructor® asks you whether you want to create an open or close polyline.

The polyline will be created according to the criteria:
 If the "Picked Points" group is selected in the Project Window, before to select the Polyline from

point list tool, all  the points (in this group) will be used
 If few points are selected (by pressing Ctrl button)  in the Project Window, before to select the

Polyline from point list tool, only these selected points will be used
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 The selected points will be joined in sequence as they appear in the project window; the first and
the last points will be joined when a polygon is closed.

Fit shape to point list

If at least 3 points are defined, a fitting shape can be computed and added to the project.

According to the number of the selected points a plane, a cylinder, a sphere, a cone or a circle can be
fitted.

For each shape, a default set of fitting parameters  can be adopted or modified to interpolate the
points. 

Among the selected points, the RANSAC algorithm randomly selects X points and tries to fit the
geometric shape on them.
The algorithm then iterates this procedure N times keeping the best result that it found among all
attempts. The quality of the fitting is given by how many points (out of the selected ones) are
sufficiently close - and therefore belonging - to the geometric shape (inliers).
The maximum value of X is given by the Maximum points used for fitting [#] parameter.
The RANSAC minimum iterations [#] parameter defines the minimum number of attempts N that the
algorithm must make before considering the geometric shape correctly fitted.
Inliers maximum distance [m]  defines the maximum distance within which a point is considered to
belong to the geometric shape.

A special button allows you to reset to default parameters at any time.

Basic shapes

Create/edit plane

Create/edit segment

Create/edit polyline
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Create/edit plane

This is a toolbox for
creating/editing a plane from
points, axes, objects, UCS
directions, etc.
Start by dragging and dropping in
the editor window the plane you
want to edit. If no plane is
dropped, a new plane will be
created when you activate any of
the functions or when you click

on .

Fitting
Several criteria are defined to fit the plane.

Creating a plane from two points
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This option allows you to create a vertical plane from - or to make your plane pass by - two points. To

define one of these points, just click on  and double click on any point in the 3D scene.
Otherwise, select any point from the point list window by clicking on ... . It is also possible manually
insert the coordinates of the points in the dedicated boxes. When you have defined the points, click
on Fit plane. The plane will be adjusted to pass by the specified points, to be vertical (coplanar to the
Z axis of the current UCS) leaving as much as possible unchanged the other plane's properties.

Creating a plane from video selection
This option allows you to create a plane from a video selection of point clouds. 
Click on Quick selection to use the Lasso tool to make a free hand selection in the point cloud view.
Automatically the plane will be created, fitting the selected points.
Click the Fit plane to all visible points button to create a plane fitting all the points visible on the 3D
view (in the foreground).

Creating a plane from point list
This option allows you to create (or adapt) a plane from the point listed in the project.

Creating a plane from segment and point
This option allows you to create a plane from a segment and a point included in the project.
Select the segment and the point in the Project Window then drag&drop them in the provided
boxes.
Two modalities are available to fit the plane:
 The chosen segment is the normal plane:  the plane will be perpendicular to the segment
 The chosen segment must lie on the plane: the plane will have the segment lying on it and will pass

by the point

After choosing the modality and the segment/point entities, click the Make plane from segment and
point button to create/modify the plane.

Creating a plane from origin and axes
This option allows you to create a plane from - or to make your plane pass by - three points. These
points are the center of the plane (UCS origin), the X (or Y) axis endpoint, and a point on XY plane. To

define one of these points, just click on  and double click on any point in the 3D scene.
Otherwise, select any point from the point list window by clicking on ... . It is also possible manually
insert the coordinates of the points in the dedicated boxes. When you have defined the point(s), click
on Fit plane. The plane will be adjusted to pass by the specified points, leaving as much as possible
unchanged the other plane's properties.

Creating a plane from bounding box
This option allows you to create a plane from the faces of the cumulative bounding box of the
currently selected project items. This is useful for example to immediately create the base plane of
a certain church or cave, to make plants or sections later.
When you create/edit a plane from the bounding box of project item(s) (bottom group box), the
plane's direction is determined by the current UCS: frontal , lateral and base plane mean that the
plane's normal is parallel to the UCS' X, Y and Z axis respectively.

For some modalities, a default set of fitting parameters can be adopted or modified to interpolate
the points. 
Among the selected points, the RANSAC algorithm randomly selects X points and tries to fit the
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geometric shape on them.
The algorithm then iterates this procedure N times keeping the best result that it found among all
attempts. The quality of the fitting is given by how many points (out of the selected ones) are
sufficiently close - and therefore belonging - to the geometric shape (inliers).
The maximum value of X is given by the Maximum points used for fitting [#] parameter.
The RANSAC minimum iterations [#] parameter defines the minimum number of attempts N that the
algorithm must make before considering the geometric shape correctly fitted.
Inliers maximum distance [m]  defines the maximum distance within which a point is considered to
belong to the geometric shape.

Editing
Once the plane is defined, it can be edited by setting the dimensions along X and Y axes.
It can be also oriented according to the vertical horizontal directions (respectively parallel to Z axis
and XY plane), as well as its X axis can be forced to be horizontal.

Duplicate plane as
The selected plane can be duplicated as a
 New plane: a new and identical plane will be added to the project
 New Orthocamera: a new orthocamera in which the projecting plane will be the same plane will

be added to the project.

 This option is useful when you want to extract a cross section and an orthophoto (or X-ray
orthophoto) from the same position: create the cutting plane to generate the cross section,
duplicate it as an orthocamera and use it to generate an orthophoto from the same point of
view.

The functions explained before are more powerful if used in combination. 
For example, first you create a plane from three points of a façade, then you make the
plane vertical, or its X axis horizontal, to create later an orthocamera from it. Note also
that, while you edit your plane, you have the undo/redo buttons on the bottom of the
dialog, to make the editing process easier.
When you are done, just close the window. If you want to start a new plane, click on I'm
done, create a new plane.

Create/edit segment
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This is a toolbox for
creating/editing a
segment from a starting and
an ending points.
Start by dragging and dropping
in the editor window the
segment you want to edit. If
no segment is dropped, a new
segment will be created when

you click on .

Note that a segment could be
created also as intersection
between other shapes (see
Intersect geometric shapes).

To define one of these points, just click on  and double click on any point in the 3D scene.
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Otherwise, select any point from the point list window by clicking on ... . It is also possible manually
insert the coordinates of the points in the dedicated boxes. When you have defined the points, the
segment (with arrows) will appear in the 3d view, as well as its length's value in the dialog. 

By clicking on Extract segment's
three components the
components along X, Y and Z
directions (of the current UCS) will
displayed in the 3D view.

The Save segment to... command allows you to:
 copy to a new segment
 save the segment's information (below illustrated with an example), in .txt, .csv formats and as a

clipboard.

Segment name: Segment 1
Length: 2.6511 m
Along UCS X: 0.3782 m
Along UCS Y: 2.5893 m
Along UCS Z: 0.4256 m
Start point coordinates: 12.0990, 3.1179, 2.0540 m
End point coordinates: 11.7208, 5.7072, 1.6284 m.

Create/edit polyline
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This is a toolbox for
creating/editing a polyline by
managing points in the 3D
view.
Start by dragging and dropping
in the editor window the
polyline you want to edit. If no
polyline is dropped, a new
polyline will be created when

you click on .

In the upper part of the
window the number or
vertices added to the polyline
and its complete length are
listed. 

Editing Tools and Tools Options
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Basic Tools
Add vertices
By clicking on the 3D scene, new vertices are added to the polyline. Doing it, the number of
vertices and the length are automatically updated.

During the picking point process it is possible to include different strings and modify them
in the polyline, by starting from one endpoint.
By selecting Choose string to continue and picking an endpoint in the 3D scene you can
restart to add vertices from this position, whereas by selecting Start new string and picking
points in the 3D scene, these points will be included in a new string.

Check Constrain new vertices on this plane and select a plane in the project to lie the picked
points on it. The vertices added from this point will lie on the plane.
Check Constrain new segments orthogonally to the UCS to orient the new added segments
as parallel to X, Y or Z axis of the current UCS. The segments added from this point will be
only vertical (parallel to Z) or horizontal (parallel to X or parallel to Y).

Edit vertex
To select a vertex of the polyline in the 3D space and edit it by changing its position.

Connect vertices
To connect two vertices with a segment.
The vertices must be endpoints of strings, and can be selected by double clicking on them
in sequence: first the First Vertex and then the Second Vertex.
Remove vertex
To remove a vertex from the polyline, by double clicking on a point close to the vertex.

Remove segment
To remove segments by double clicking on them.

Grouping Tools
Merge polylines into one
To merge the current polyline with another one by double clicking on it in the 3D scene. At
the end only one polyline will stay in the project, the current one.
Explode polyline strings
To explode a polyline string by double clicking on the string of the current polyline to
explode. Any other strings will be moved to separate polylines.
Close polyline
To close a polyline by double clicking on a string of a current polyline to close.

 These tools can be used to redraw the point cloud in order to extract the desired main
features as polylines.

Layout Tools
Set same altitude to all vertices
To set a constant altitude to the polyline's vertices. The altitude can be defined by picking a
point in the 3D scene (Z value) or manually set in the specific box. Once the altitude is
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selected, click on Set Altitude to actualize the process.
Project polyline on plane
To project the polyline on a plane. The plane can be double clicked in the 3D space or
selected from the list. Once the plane is selected, click on Project to actualize the
projection.

Second order shapes

Create/edit circle

Create/edit sphere

Create/edit cylinder

Create/edit cone

Create/edit circle



Online Help Reconstructor 4.4

236 / 361

This is a toolbox for
creating/editing a circle from
samples or point list.
Start by dragging and dropping
in the editor window the circle
you want to edit. If no circle is
dropped, a new circle will be
created when you activate any
of the functions or when you

click on .

Note that a circle could be
created also as intersection
between other shapes (see
Intersect geometric shapes).

In the upper part of the
window the length and the
circumscribed area are listed. 

Editing method
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Several criteria are defined to fit the cylinder.

Fit cylinder to samples
This option allows you to create a cylinder from a video selection of point clouds. 
Click on Quick selection to use the Lasso tool to make a free hand selection in the point cloud view.
Automatically the cylinder will be created/adapted, fitting the selected points.
Click the Fit cylinder button to create a circle fitting all the points in the 3D view.

Fit cylinder to point list
This option allows you to create (or adapt) a circle from the point listed in the project.

A default set of fitting parameters can be adopted or modified to interpolate the points. 
Among the selected points, the RANSAC algorithm randomly selects X points and tries to fit the
geometric shape on them.
The algorithm then iterates this procedure N times keeping the best result that it found among all
attempts. The quality of the fitting is given by how many points (out of the selected ones) are
sufficiently close - and therefore belonging - to the geometric shape (inliers).
The maximum value of X is given by the Maximum points used for fitting [#] parameter.
The RANSAC minimum iterations [#] parameter defines the minimum number of attempts N that the
algorithm must make before considering the geometric shape correctly fitted.
Inliers maximum distance [m]  defines the maximum distance within which a point is considered to
belong to the geometric shape.

Parameters
Once the circle is defined, it can be edited by setting its center's coordinates and radius.

Duplicate circle as
The selected circle can be duplicated as a new circle: a new and identical circle will be added to the
project.

Create/edit sphere
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This is a toolbox for
creating/editing a sphere from
samples, points or circles.
Start by dragging and dropping
in the editor window the
sphere you want to edit. If no
sphere is dropped, a new
sphere will be created when
when you activate any of the
functions or when you click on

.

In the upper part of the
window the Surface and the
circumscribed Volume are
listed. 

Editing method
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Several criteria are defined to fit the sphere.

Fit sphere to samples
This option allows you to create a sphere from a video selection of point clouds. 
Flag the Fitted sphere must have radius and insert a value for the radius of the fitting sphere if you
know it . 
Click on Quick selection to use the Lasso tool to make a free hand selection in the point cloud view.
Automatically the sphere will be created/adapted, fitting the selected points.

The Masking Tools can be used to isolate small areas to look for spheres.
 Turn ON/OFF the Mask tool to select the points with Rectangle or Lasso tools
 Hide or Unhide points in the 3D view to better identify the correct selection
 Check "Apply after selection to update the visualization in the 3D view

Fit sphere to point list
This option allows you to create (or adapt) a sphere from the point listed in the project.

A default set of fitting parameters can be adopted or modified to interpolate the points. 
Among the selected points, the RANSAC algorithm randomly selects X points and tries to fit the
geometric shape on them.
The algorithm then iterates this procedure N times keeping the best result that it found among all
attempts. The quality of the fitting is given by how many points (out of the selected ones) are
sufficiently close - and therefore belonging - to the geometric shape (inliers).
The maximum value of X is given by the Maximum points used for fitting [#] parameter.
The RANSAC minimum iterations [#] parameter defines the minimum number of attempts N that the
algorithm must make before considering the geometric shape correctly fitted.
Inliers maximum distance [m]  defines the maximum distance within which a point is considered to
belong to the geometric shape.

From circle
This option allows you to create (or adapt) a sphere from a circle listed in the project, used as
Equator circle.

Parameters
Once the sphere is defined, it can be edited by setting its center's coordinates and radius.

Duplicate circle as
The selected circle can be duplicated as 
 a new sphere
 a Mesh
 a spherical camera.

Create/edit cylinder
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This is a toolbox for
creating/editing a
cylinder from samples, points,
axis or circles.
Start by dragging and dropping
in the editor window the
cylinder you want to edit. If no
cylinder is dropped, a new
cylinder will be created when
when you activate any of the
functions or when you click on

.

In the upper part of the
window the Surface and the
circumscribed Volume are
listed.

Editing method
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Several criteria are defined to fit the cylinder.

Fit cylinder to samples
This option allows you to create a cylinder from a video selection of point clouds. 
Click on Quick selection to use the Lasso tool to make a free hand selection in the point cloud view.
Automatically the cylinder will be created/adapted, fitting the selected points.
Flag Fit cylinder to fit all the points in the 3D view.

Fit cylinder to point list
This option allows you to create (or adapt) a cylinder from the point listed in the project.

A default set of fitting parameters can be adopted or modified to interpolate the points. 
Among the selected points, the RANSAC algorithm randomly selects X points and tries to fit the
geometric shape on them.
The algorithm then iterates this procedure N times keeping the best result that it found among all
attempts. The quality of the fitting is given by how many points (out of the selected ones) are
sufficiently close - and therefore belonging - to the geometric shape (inliers).
The maximum value of X is given by the Maximum points used for fitting [#] parameter.
The RANSAC minimum iterations [#] parameter defines the minimum number of attempts N that the
algorithm must make before considering the geometric shape correctly fitted.
Inliers maximum distance [m]  defines the maximum distance within which a point is considered to
belong to the geometric shape.

Change axis
This option allows you to create a cylinder by using as axis a segment (also distance) listed in the
project.

Change a base circle
This option allows you to create a cylinder by using as base a circle listed in the project.

Parameters
Once the cylinder is defined, it can be edited by setting its radius and height values.

Duplicate and extract
By flagging Feature extraction and clone commands  some tools are available: 
 Extract cylinder's axis
 Extract cylinder's top circle
 Extract cylinder's bottom circle
 Duplicate cone as a new cylinder
 Duplicate cone as a mesh
 Duplicate cone as a cylindrical camera

Create/edit cone
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This is a toolbox for
creating/editing a cone from
samples, points, axis or circles.
Start by dragging and dropping
in the editor window the cone
you want to edit. If no cone is
dropped, a new cone will be
created when when you
activate any of the functions

or when you click on .

In the upper part of the
window the Base radius, the
Surface and the circumscribed
Volume are listed. 

Editing method
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Several criteria are defined to fit the cone.

Fit cone to samples
This option allows you to create a cone from a video selection of point clouds. 
Click on Quick selection to use the Lasso tool to make a free hand selection in the point cloud view.
Automatically the cone will be created/adapted, fitting the selected points.
Flag Fit cone to fit all the points in the 3D view.

Fit cone to point list
This option allows you to create (or adapt) a cone from the point listed in the project.

A default set of fitting parameters can be adopted or modified to interpolate the points. 
Among the selected points, the RANSAC algorithm randomly selects X points and tries to fit the
geometric shape on them.
The algorithm then iterates this procedure N times keeping the best result that it found among all
attempts. The quality of the fitting is given by how many points (out of the selected ones) are
sufficiently close - and therefore belonging - to the geometric shape (inliers).
The maximum value of X is given by the Maximum points used for fitting [#] parameter.
The RANSAC minimum iterations [#] parameter defines the minimum number of attempts N that the
algorithm must make before considering the geometric shape correctly fitted.
Inliers maximum distance [m]  defines the maximum distance within which a point is considered to
belong to the geometric shape.

Change axis
This option allows you to create a cone by using as axis a segment (also distance) listed in the project.

Change a base circle
This option allows you to create a cone by using as base a circle listed in the project.

Parameters
Once the cone is defined, it can be edited by setting its height and vertex angle values.

Duplicate and extract
By flagging Feature extraction and clone commands  some tools are available: 
 Extract cone's axis
 Extract cone's base circle
 Duplicate cone as a new cone
 Duplicate cone as a mesh
 Duplicate cone as a perspective camera

Shapes interactions

Distance between shapes
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Intersect geometric shapes

These commands are available in the Mesh&Shapes Top Toolbar and in the Data Management >
Geometric shapes Top menu.

By directly selecting two shapes in the Project Window and right-clicking with the
mouse, a context menu allows you to select one of these two tools and obtain the
distance or the intersection between the selected shapes in a fast way.

Distance between shapes

Selected two shapes, the distance among the two shapes' closest point is computed and inserted in
the Distances items in the project.

 If shapes intersect, no distance is computed.

See also Distance tool.

Intersect geometric shapes

Selected two shapes, the intersection among the two shapes is computed and inserted in the
Geometric shapes items in the project.
The extracted geometric shape depends on the starting shapes and on their relative position.
It could be a segment, a circle or a point.
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For example, the intersection between a plane and a sphere is a circle (or a point if they are
tangent):

Photo & Color
Reconstructor® provides several coloring tools to effectively manage the colorization of point

clouds and meshes. 

These tools can be classified according to the objects you want to color and the procedures you need

to apply.

Point clouds' color layers managing
Some color information is item intrinsic of point clouds and saved as a color layer, in addition of the

ones already included in the raw data (i.e. Reflectance, Color, ...) or after pre-processing step (i.e.

Confidence, Inclination, ...).

By using the tools below listed it's possible to create and add new layers of color.

Histogram
To optimize the point clouds color's contrast by histogram stretching. Only single channel
layer can be used (reflectance, gray scale layers...).
This command is available in the Property browser dialog.
Color with altitudes
To add to the selected point cloud(s) an extra color layer, representing the altitude of the
points with respect to one of the tree axes of the current UCS. 
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Inclination from plane
To add to the selected point cloud(s) an extra color layer, representing the inclination of the
points' normals with respect to a given plane that exists in the project.

Use it to classify points for a further vegetation removal.

Color with range
To add a layer coloring the distance from the relative observation point.

Color with ambient light
To add to the selected point cloud(s) an extra color layer, 

Visualization of outdoor large mapped areas can be enhanced with this layer.

Compute 3D reflectance
To add to the selected point cloud(s) a special color layer, named 3D Reflectance, that mixes
LiDAR intensity and point normals (inclination) to enhance both geometrical and surface
characteristics.
Add color layer from image
To apply an image on the point cloud (e.g. a 2Dview after a color editing).

 Pay attention to the dimensions of the images: they must be the same of the point
cloud ones.

Merge or split layers
To combine RGB and scalar layers to obtain a customized new layer of color for point
clouds.

A particular and useful tool is dedicated to manipulation of layers of colors: 
Colors mapping
To manage an artificial colorization for a given color layer of a point cloud. Color information
can be scalar (e.g. reflectance, range, confidence) or vectorial (e.g. inclination). It's also
possible to add layers from external images. The purpose of this command is to manage
and create an artificial colorization for a given color layer of a point cloud.

Camera calibration
Images from external cameras can be calibrated (oriented) on point cloud and meshes to obtain
colored 3d models (see at the Colorization paragraph).

Images & calibration
This tools are used to calibrate images on point clouds and meshes and to determine the
external and intrinsic parameters of a camera:

Camera calibration on a model 

Camera calibration using 3D points 
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Calibrate camera intrinsic 

Manage projectors
Several kind of 3D projectors can be created in Reconstructor® and used to project images on the 3D
scene.

Create projector
This functions creates a projector in four different frustum types: Perspective,
Orthographic, Spherical and Cylindrical projectors. An additional way to create perspective
or spherical projectors is done by a calibration (by importing a Reconstructor® camera
calibration file) using a valid image.

Load projector
To load (light on) the image on the 3D model.

Unload projector
To unload the image from the 3D model.

Colorization
A mapping (on point clouds and meshes) of calibrated images from external cameras is possible, in

order to obtain colored point cloud and meshes.

Texture mapping
To color point clouds and meshes by using external images (and also extracted panoramic
cameras from perspective picture in Reconstructor®)

Color clouds with photos

Create panorama
To create a create panorama (spherical 360° equi-rectangular) images starting
from perspective images acquired with a camera centered on a 3D scanner head
and rotating with them.

When you import .zfs or .fls point clouds a spherical camera (projector) can be
automatically created (see LineUp import Wizard settings).
Create texture map
Opens a tool to texture map a selected mesh, given a texture view (a camera or a
projector) and one or more projectors (calibrated images).

UAV and imaging
This tool is used to Import GeoTIFF as an orthographic camera.
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Import georeferenced tif...
Imports a georeferenced tiff (GeoTIFF) file as an orthographic camera. 

To change the point clouds’ color layers,
select the point cloud from the project
window and set the Color Mapped option in
the Property Browser.

By opening the Colors mapping tool, a
complete overview of the layers of color is
available.

Histogram dialog
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Given a point cloud and one of its scalar
color layers (e.g. Reflectance), the
histogram tool allows to optimize the
color's contrast by histogram stretching.
The histogram shown in the dialog
represents how many points belong to a
given color value.

This tool is available only if the cloud is
loaded in memory and if the current color
type is scalar, therefore it doesn't work
on Inclination for example). 
The two sliders allow you to decide the
start and end of the histogram interval to
be rendered. 
The Auto Cut-off  button allows you to
automatically set the histogram minimum
and maximum bin so that a certain
percentage (2% in the figure above) of the
histogram energy is discarded starting
from zero to the minimum value and
starting from the highest histogram bin
back to the maximum value.

See also Point clouds and Colors mapping
dialog.

Shadow recovery: lightens darker points

Colors mapping

Colors mapping
The purpose of this command is to manage and to create an artificial colorization for a
given color layer of a point cloud.

The user can manage the rest of Reconstructor®'s GUI while keeping this dialog open.

When a point cloud is pre-processed, extra-information is added, and this is organized into color
layers. Information can be scalar (e.g. reflectance, range, confidence, inspection) or vectorial (e.g.
color, inclination).
When a color layer is rendered, a colorization is used to associate the points' color values to a
drawable color. Only scalar information can be mapped with colors through this dialog. The color
layer Inclination is an exception: it represents the normals of the points and it is colored
automatically.

Only one color layer at a time is rendered in the 3D scene.

Layers list
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On the top left of the Colors mapping dialog is a layers list showing which layers are associated to the
current point cloud.
User can use it to switch from one color layer and another as well as can use the relative command
in the property browser.

After selecting a cloud's color layer, the user can remove it by pressing the Remove color layer
command.

Map colors tab

The Colors mapping window has the interface as below if a scalar layer is selected.

Presets
In the Map Color tab there is a set of buttons to apply a pre-defined colorization to the current
selected layer.
Buttons used to map colors are:

o Measure values (continuous) : map the current layer to a continuous Rainbow Matlab style
color.

o Measure values : map the current layer to a discrete Rainbow Matlab style color.
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o Single thresholding: map the current layer to solid red and blue.
o User can set a threshold moving up and down the central value label.
o Double thresholding: map the current layer to solid red and blue.

User can set two thresholds moving up and down the values labels.
o Gray scale: map the current layer to a continuous gray gradient.
o Gray scale (discrete): map the current layer to a discrete gray gradient.

Color scale properties
On the right there is a color scale that shows the selected colors map in combination with labels.
Labels show maximum and minimum (bounding) values and also values between colors. User can
choose among several types of color scales via Presets and by managing the Editing Options. User
can also change and disable colors by clicking on the color check box.

The following scale properties are displayed:
o Max mapped to set the max value and show it in the legend (click on Reset button to reset

to the maximum absolute value)
o Min mapped to set the min value and show it in the legend (click on Reset button to reset

to the maximum absolute value)
o Colors scale interval with that gives information about width of the color intervals
o Unit type that is depending on the type of colorization

Editing options
Colors intervals in the scale can be subdivided by:

o Fixed intervals according to the unit type (measure of unit)
o Fixed bins according to a defined number of equal spaced bins

The scale type can be modified by selecting one of the following options:
o Extended
o Gray scale
o Rainbow
o Rainbow Matlab
o Ironbow

Setting for > Max, < Min and disabled intervals
When out of range, two modalities of points colorization can be chosen:
Color points: all the points out of the (Min,Max) interval are colored with an user defined color or with
a chosen cloud layer of color (e.g. Reflectance, Inclination, ...) 
Hide points: all the points out of the (Min,Max) interval are hidden.
By clicking on the Unhide button all the points previouvsly hidden will be made visible.

Histogram tab 
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A colored histogram shows a statistical distribution with colors chosen by user. In abscissa, the
histogram information about current measure (each color identifies a local radius of the measure)
and in ordinate a measure of how many occurrences of points are mapped to a color. The mean
value is also shown.
Click on Compute Histogram to extract it after creating or modifying it.

Color with altitude

This tool works on any set of point clouds. It allows to add to the selected cloud(s) an extra color
layer, representing the altitude of the points with respect to one of the tree axes of the current UCS.
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Change the color scale in the Color Mapping window.

Inclination from plane
This tool works on any set of point clouds. It allows you to add to the selected cloud(s) an extra color
layer, representing the inclination of the points' normals with respect to a given plane that exists in
the project. The inclination from plane ranges from -1 to 1 and is calculated as the scalar product
between the points' normals and the plane's normal.

It's possible to use this command, e.g., to distinguish points on vegetation to points on soil (with
regular inclination) and remove them is an useful application of vegetation removing.

Color with range

This tool works on any set of point clouds. It allows to add to the selected cloud(s) an extra color
layer, representing the distance of the points with respect to the origin of the point cloud.

By default the layer's colorization is as in the image below, but can be modified with Colors Mapping
tool.
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Example of Color with Range colorization

Color with ambient light

This tool works on any set of point clouds. It allows to add to the selected cloud(s) an extra color
layer, named "AmbientLight", which simulates a light source that doesn't come from a particular
direction. The light effect is so uniform throughout the scene.  

Quality (Low, Medium or High) defines the deepness of the process: higher the quality, better the
definition of the colorization and higher the computation time.

 Visualization of outdoor large mapped areas can be enhanced with this layer.
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Example of Ambient Light colorization

Compute 3D reflectance

This tool works on any set of point clouds. It allows to add to the selected point cloud(s) a special
color layer, named 3D Reflectance, that mixes LiDAR intensity and point normals (inclination) to
enhance both geometrical and surface characteristics.

 Before computing the 3D Reflectance layer make sure that both Reflectance and Inclination
layers are present in the point cloud(s).
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Add color layer from image

This tool works only on structured point clouds (grids) and colors the point cloud by using any
external image that can be projected on it.
Several formats of image are available (png, bmp, jpg, jpeg, tif, tiff) both for perspective and
panoramic images.

This command is particularly used to modify the colorization of a scan by following this workflow:
 Open the contextual Edit 2D grid view
 In the Point picking section select the current color layer you want to manage and modify and

click on Save image to save the current image to file.
 Open the image in a photo editor software and modify it
 Use the Add color layer from image tool to re-apply a new colorization to the scan loading the

changed picture.

 Pay attention to the dimensions of the images: they must be the same of the point cloud ones.

Merge or split layers

This tool works on any set of point clouds. It allows to combine RGB and scalar layers to obtain a
customized new layer of color for point clouds.
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Color layers in Reconstructor can be distinguished in RGB layers and scalar layers. 

RGB data holds the RGB (Red Green Blue) values that define the color of the points (as pixels in an
image). Scalar data, on the other hand, defines properties of the colorization that can be used during
computations. HSV (for hue, saturation, value; also known as HSB, for hue, saturation, brightness)
are alternative representations of the RGB color model. In these models, colors of each hue are
arranged in a radial slice, around a central axis of neutral colors which ranges from black at the
bottom to white at the top.

Examples of RGB layers are Inclination and Color, while examples of scalar layers are Reflectance,
Confidence, Altitude, Inclination respect a plane.

This command allows then to switch between scalar and color channels, customizing them. 

   

Color clouds with photos
Projectors blending dialog
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This dialog allows you to create a color layer for a structured point cloud by blending the images from
selected projectors.
You can load all the projectors available in the current project. The color layer is computed by
projecting on the point cloud and blending all the images coming from the projectors. Different
blending algorithms are applied depending on the selected options.

Blending Result: Shows the image resulting from the blending process.
Projectors to blend: Select the projectors to be blended by checking the items in the list. You must
ensure that the projectors are properly calibrated for the selected point cloud, otherwise the
correctness of result will not be guaranteed.
Apply as color layer: Add the blending result to the structured point cloud as a new color layer.
Upon clicking the button you will be prompted for the name of the layer.
Save as image: Save the current blending result as an image. The image can be loaded at a later
stage as a color layer (see Colors Mapping for further information on this subject).

If the “colors missing points with reflectance” option is checked, points which cannot be colored
using projectors are colored with their reflectance value. If this opiton is left unchecked, the missing
points are blacked out.

See also Texture mapping dialog and Camera calibration dialog.

Create Projector

This functions creates a projector.
Five different modes are available:
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 From calibration: creates a projector (perspective or spherical) by importing a
reconstructor camera calibration file (.cal);

 Perspective: creates a perspective projector;
 Orthographic:  creates an orthographic projector;
 Spherical: creates a spherical projector;
 Cylindrical: creates a cylindrical projector.

Note that a valid image is needed in order to create a projector.

See also Cameras, and Camera Calibration on a Grid.

Edit (projector) image dialog

This dialog is available only for projectors. Here is possible to edit the transparent parts of the image
in order to optimize the blending of projectors.

The editing dialog of an image of a projector is accessible through the contextual menu of the loaded
image (Edit projector image).

Data kindly provided by CLAUSS
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Zoom in/out the grid with Alt+mouse wheel.

Selection mode
 Rectangle: press Left Mouse Button (LMB) for the first point and keep it pressed while

dragging the mouse to the second point, then release the LMB
 Polygon: click LMB for each point of the polygon. Close the polygon by double clicking the

LMB
 Lasso: press Left Mouse Button (LMB) to start the polyline and drag the mouse to draw,

then release the LMB to close the polyline

Edit operation
 Cut: set transparent the selected region by zeroing the alpha channel
 Mirror: inverts the image along the width
 Flip: inverts the image along the height
 Set transparent black: all pixels that are black, i.e. (0,0,0), are set to transparent by

zeroing their alpha channel

Save is enabled only if a modification as been done and it’s necessary otherwise the edits will be
lost.
Save as allows to save a copy of the image to another file.

Camera Calibration on a model

The objective of camera calibration is the registration of photos (perspective or spherical
images) with the 3D data. 
This process creates photo-realistic texture maps for the 3D model.

When you access the command a Camera calibration dialog will appear:

Load a photo to calibrate with Load image, and at least a grid point cloud with Load 3D grid. If
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necessary, change the reference grid from the loaded ones, the image-grid point pairs are stored for
each grid, and are accumulated.
A resizable zoom window appears for both where an independent zoom factor (Alt-mouse wheel)
can be set from the main window, just center the zoom area by moving the mouse on the main
window while pressing [Ctrl] key. To place a marker, double click the left mouse button (LMB) either
on the main window or in the zoom window. To move a marker, click on it with the LMB and keep it
pressed while dragging the marker. To remove the marker, right click the mouse (RMB) on the
marker.

In general, to interact with the images:
 Zoom in/out: mouse wheel
 Fit the image in the window: Alt + Middle Mouse Button (MMB)
 Reset to original size: Alt + Right Mouse Button (RMB)
 Translate the image: Shift + LMB drag
 Space bar: rotate image 90 degrees
 Show/hide zoom window: Z key
 Move zoom region inside global view: [Ctrl + LMB]

The list of points is shown in the table, where every cell is manually editable to force the values. It is
possible to import a list of points from a file by pressing Load points.

For the photo, the format must be
Image_x1 Image_y1 <Point1 Name>
Image_x2 Image_y2 <Point2 Name>
...

For the grid the format must be
X1 Y1 Z1 Image_x1 Image_y1 <Point1 Name>
X2 Y2 Z2 Image_x2 Image_y2 <Point2 Name>
...

 
Try to change the color type of the grid on top of the window to improve the contrast of features.
Press the right arrow to show a menu of available commands for the current color type for better
adjustment.

Choose the right calibration Algorithm, depending on your kind of photos:
 Perspective for perspective images
 Spherical Camera for spherical images
 Fisheye for photo acquired by fisheye lens

After at least 11 marker pairs (for perspective images and at least 4 for spherical images) are found
between the photo and the grid, press Calibrate. The result is shown in the Log panel with the
computed field of view of the photo and relative re-projection error. If successful, the calibration and
the point pairs can be saved to file by pressing Save calibration. A .cal file is created, in XML format,
storing the calibration using calibration parameters. As a test of the calibration, press Make
Reprojection, to save an image of the photo re-projected on the grid.

Point Guessing System
When you select at least 11 correspondences for perspective images (and 4 correspondences for
spherical images), the point guessing system (PGS) will perform a background calibration and will
automatically try to estimate the position on the image of additional points that you place on the
grid.
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The procedure is the following:
 Select a point on the grid (right image).
 The PGS will place the guessed point on the image (on the left). The zoom box will center

on the newly placed point.
 You have to correct the position of the placed point if necessary.
 If the PGS cannot place the point you have to place it manually.

Note: You can also select a point on the image and the PGS will try to place its correspondent on the
grid, but this procedure is not recommended since it is slower and less accurate.

Camera Calibration Settings
By clicking on Settings, a dialog including all the camera model/calibration settings and RANSAC
parameters is opened:

Camera model settings



Online Help Reconstructor 4.4

263 / 361

Here you can select the kind of camera used to take pictures: Perspective, Spherical or Fisheye. For
Perspective and Fisheye cameras it is possible compensate the tilted lens distorsion by flaggin the
relative item.

Calibration settings
Here it is possible to choose if running a Full calibration or only an External calibration, loading the
.cal file of an Internal calibration already done.
If the image is rotate respect to the reference axis of the point cloud with a known value, you can set
it in the Image Pan angle [deg] parameter. In the same way, if the relative position between the
center of the point cloud and the center of a spherical camera is known,  you can fill the X, Y, Z
components of the rototranslation in the Spherical camera position cells. 

RANSAC parameters
The RANSAC algorithm selects randomly the minimum number of points required to determine the
model parameters (in this case the camera calibration), solving for the parameters of the model.
Then determines how many points from the set of all points fit with a predefined Reprojection
tolerance. If the fraction of the number of points over the total number points in the set exceeds a
predefined threshold, re-estimates the model parameters using all the identified inliers and
terminates. Otherwise, repeat the previous steps for Max iteration times.

See also the Point clouds coloring and textured meshes videotutorial.

Camera Calibration Using 3D Points

The objective of camera calibration is the registration of photos (perspective or spherical images)
with the 3D data. 
This process creates photo-realistic texture maps for the 3D model.

This dialog allows the calibration of a perspective image using a list of matches between camera
points and 3D world coordinates points.

https://www.youtube.com/watch?v=aDrWCg9SoNk&list=PL3PJ9b9USDYR0kkBSWne8p1oBeodi4req&index=12
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As first step, the image to be calibrated must be selected by using the Load Image button.
Subsequently image points and 3D points must be loaded using the Load Image Points and Load 3D
Points buttons respectively.
Then click on Calibrate to compute the calibration process. The result is shown in the Log panel with
the computed field of view of the photo and relative re-projection error. If successful, the calibration
and the point pairs can be saved to file by pressing Save calibration. A .cal file is created, in XML
format, storing the calibration using calibration parameters.

Camera Calibration Settings
By clicking on Settings, a dialog including all the camera model/calibration settings and RANSAC
parameters is opened:

Please refer to the camera calibration page for details about the calibration options.

Calibrate Camera Intrinsics
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If you’re using an external perspective camera (not connected to the laser scanner system) to
calibrate high definition photos on grid point clouds, it could be necessary to create a specific
calibration of the camera, save it and use it for future purposes.

Here is showed the procedure to calibrate perspective cameras intrinsic (or internal) parameters
using multiple checkerboard images as calibration samples. 

1. Print the calibration frame
2.  Fixed it on a rigid support
3.  Measure the high and length of the square 
4.  Select the camera and the lens you want to calibrate
5.  Acquire at least 10 images (to have a robust estimate for the calibration parameters) of

the frame changing the camera position, paying attention to include all the frame
squares in the picture, in order to reduce the image without the frame and to avoid glare
effects

6. Create a new Reconstructor® project then enter in the command  Tools → Color tools →
Calibrate Camera Intrinsic

7. Set the square size and the number of internal corners and load the frames images
Chessboard square size: the width and height in millimeters of a single chessboard square;
Chessboard internal corners : the number of corners of the chessboard, the border corners should not

be taken into account;
Camera sensor size: the width and height in millimeters of the camera sensor. Refer to the camera

technical documentations to obtain this data.



Online Help Reconstructor 4.4

266 / 361

In this sample image, a chessboard with 9 by 6 internal corners is shown. Please note that, in order for
the algorithm to work properly, the number of row and column corners must be different.

1. Calibration process starts automatically 
2.  At the end of the calibration process, check the mean re-projection error to verify the

process quality
3.  Press “Save intrinsic” to store the calibration file (Internal-Calibration.cal) usable for all

the other pictures

Once the calibration is complete, a calibration file can be saved. Such file can be used as a starting
point for camera parameters while using the  camera calibration function. Inside the Camera
calibration on a grid dialog, select External and load Internal calibration file just created.

 You can download here the calibration chessboard to calibrate your
camera.

 After selecting the camera and fixing the focal length, the internal
calibration can be done once for several acquisition jobs

 After an intense usage of the camera, we suggest you to verify the
calibration parameters

Create panorama

Create Panorama tool creates and associates a panoramic spherical projector to a point cloud (both
structured and unstructured), by calibrating a series of perspective images on the point cloud.

Some requirements are due: 
 The images must be taken from the same point of view
 only a regular rotation of camera is permitted (i.e. an image every 30° during camera rotation),

but a complete 360° rotation is not mandatory.

http://www.gexcel.homeip.net/Reconstructor/R_Quick_Guide/InternalCalibration-FramePattern8x7.pdf
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1. Start by Dragging & Dropping at least one model from the tree view in the Project Window
2. If the sensor which acquired the scan is not defined (ensor Unknown), select the proper one in

the drop down menu
3. Associate at least one image to each model by selecting it

 

4. Calibrate Camera: select an image (among the imported ones) and proceed with the camera
calibration (as explained in Camera calibration on a grid).

Settings
Calibration settings can be singularly adjusted for each model
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or globally defined for every model (Define Global Settings) in a similar way.

UAV and Imaging

These tool is used to Import GeoTIFF.

Import Georeferenced TIFF

This function imports a geo-referenced TIFF as an orthographic camera. 
The image to be imported must be accompained by a Tiff World File (TFW) indicating the
coordinates of the image. 
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Texture mapping

The command Create texture map allows you to create textures for your mesh model.

Preview resolution
Firstly select a camera to specify a viewpoint from which the texture should be created and
parameterized. The resolution of the camera can be changed here.

Update preview: creates a preview of the texture from the selected view point and projection. This
is a simplified image and does not represent the full quality of the final texture

Projectors to blend
You can load simultaneously more projectors that project photographic color on the same mesh. 

 The maximum number of simultaneous projectors supported depends on your  graphic card.
Check at Help > Hardware info | GPU and graphic functionalities what is its value.

Successively, you can create a texture. 

A texture is a particular image that, mapped on your mesh, gives to it the color. The texture is
calculated by blending together all the color coming from the projectors.

Create single texture map: create the texture by blending the checked projectors. An image of
png format is created, plus a 2f file that stores the computed texture coordinates for the mesh
vertexes, which is listed in the Mappings. Check if shadows must be computed.

Mappings
 Remove: remove the selected mapping from the list
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 Remove all: clears the list

Re-cluster: create a new triangle meshes model where the listed mappings are used to re-arrange
the triangles in a new set of submeshes that map the desired textures. Each triangle is mapped with
the best texture quality available by computing the best texture projection among all. The model is
automatically added to the project.

 In the contextual menu of meshes the command Sample texture as vertexes is available.
It assigns to the vertices of the mesh a color obtained from the corresponding pixel of the texture.
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Results & Analyses
This menu contains many functions to extract results from the project's data and models. These
functions are organized in the following submenus:

 Measures & notes
 Elevations & plans
 Cross sections
 Areas & Volumes
 Inspection
 Drawing tools
 Video record
 Save snapshot
 Manage Units of Measure
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Measures & Notes

In Reconstructor® some basic measure feature are available:

Readout window
The readout window allows you to see the 3D coordinates of the points you are hovering
the mouse on in the 3D rendering window.
Annotation
This function allows you to create annotation of 3D points of models in your project.

Distance
This button allows you to measure a distance between any two points in the 3D scene

Angle Tool
This button enables you to to measure an angle identified by three points directly picked in
the 3D window.
Open Angle Tool
This button enables you to measure an angle between different geometric shapes.

See also Areas & Volumes to learn about areas and volume measurements in Reconstructor®.

Readout window
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This window shows in real time
the current coordinates and color
of the models you see in 3D
rendering window below the
mouse pointer.
To obtain the accurate
coordinates, double left mouse
click and stay in position.

The coordinates of the corresponding 3D point are expressed in the Global Coordinate System
(MAIN UCS) and in the Current UCS.

 Pixel column, row:  refers to the mouse position inside the 3D window, in pixels (0, 0 is the top-
left corner) 

 Pixel color RGB: the three components of the point's RGB are shown
 Depth to point: distance between selected point and current view point is displayed

Values of the current layer can also be displayed after the double click.

You can copy all the values to the clipboard by Ctrl+c.

From the Change units of measure button the Select Units of Measure window will appear, permitting
the change of displayed units of measures (SI, imperial or U.S. customary units).

The readout window appears docked by default in the right area of the GUI.

Example

Current Coordinate System: LOCALE 

Global coordinates system:
x: -0.12699 m
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y: -0.04696 m
z: -18.04474 m

Current User Coordinates System:
x: -0.12699 m
y: -0.04696 m
z: -18.04474 m

Pixel Coordinates:
Pixel column,row:    511, 448
Pixel color RGB: 224, 255, 0
Depth to point:  1.50784 m

Altitudes on Z axis: -18.0447

Annotation

This function allows you to create
Annotations of 3D points of
models in your project.

After activating this button,
double-click with the left mouse
button on a valid 3D point to place
an annotation. The annotation
gets displayed in 3D with a label
and it also appears in the
"Annotations" group of items in
the Project Window.

In the Annotation list all the picked
annotations are listed, including
their Labels and X, Y, Z
coordinates in the current UCS.

By clicking on GoTo button the 3D
view is focused on the annotation
point.

You can edit the annotation's
comment and set an associated
hyperlink (by default it is the
model on which you pick the
point).

From the Property browser, you
can change the color ID, edit the
displayed comment, define a
hyperlink for an annotation and
choose whether to draw the
annotation or not.

Export to file
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Using this function, you can Export annotations and import them in spreadsheets or text editor third
party software for further processing.

Annotations can be converted to Points or Targets items through the contextual menu, after
selecting them in the Project Window. It is also possible to do the reverse.

Distance
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This function allows you to
measure a distance between any
two points in the 3D scene or to
edit a previous one.

Start by dragging and dropping in
the editor window the distance
you want to edit. If no distance is
dropped, a new distance will be

created when you click on .

To define the starting and ending points, just click on  and double click on any point in the 3D
scene. Otherwise, select any point from the point list window by clicking on ... . It is also possible
manually insert the coordinates of the points in the dedicated boxes. When you have defined the
points, a segment (with arrows) will appear in the 3d view, as well as its length's value in the dialog. 
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By dragging&dropping two shapes in the apposite boxes in the dialog it is possible to compute the
distance between them.
See also Distance between shapes.

By clicking on Extract distance's three components the components along X, Y and Z directions (of the
current UCS) will displayed in the 3D view.

The Save distance to... command allows you to:
 save distance's extremes a s points in the project
 save the distance's information (below illustrated with an example), in .txt, .csv formats and as a

clipboard.

Distance name: Distance 2
Length: 2.6562 m
Along UCS X: 0.0273 m
Along UCS Y: 0.0115 m
Along UCS Z: 2.6561 m
Start point coordinates: 0.4548, 0.6176, 5.4918 m
End point coordinates: 0.4821, 0.6061, 2.8357 m.
Annotation: Distance between windows

In the last box of the dialog, annotations (notes) can be associated to the distance.

 Angle Tool

This function allows you to measure an angle identified by three points directly picked in the
3D window:

The result is an angle measure that you can store in your project session, 
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visualize in the 3D window, meanwhile a new Angle annotation will be inserted in the Survey tools list.

Open Angle Tool

This function allows
you to measure an
angle between three
points, two segments,
a segment and a plane
and between two
planes.

Drag and drop the
objects mentioned
above in the recipe
window, then click on
Measure button to
take the
measurement and
automatically store it
in the Survey tools list
as a new Angle
annotation including
angle measure (e.g.
49.08 ° angle).
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Elevations & Plans
This sub-menu contains all the commands and features to create precise, high-resolution elevations
and plans of your models:

Create Orthophoto
Creates an Orthophoto and defines its position, size and field of view based on different
parameters and methods.
Create X-Ray Orthophoto
Creates an X Ray Orthophoto from a set of selected point clouds. Main edges and borders
are emphasized and displayed in the final Ortho view.
Orthophoto viewer
Opens an orthophoto in the viewer to measure distances, angles and areas.
From the viewer, the orthographic image can be exported in AutoCAD.
Create Camera
Creates four types of camera (perspective, ortho.

Place here survey point
Creates a perspective camera placed in the current view point.

Virtual scan
Computes a Virtual Scan of the models in the 3D scene from a selected camera. The virtual
scan can be saved as a 2D image, or as a grid point cloud, and exported to AutoCAD as a
scaled Orthophoto.

Create Orthophoto

With this tool you can create an orthocamera from samples, points, axes, UCS directions,
etc., edit it and extract an orthophoto.

An orthophoto is an orthorectified 2D image such the scale is uniform across the entire
image.

The recipe window is splitted in two panels:
 Position
 Dimensions and corrections

Position



Online Help Reconstructor 4.4

280 / 361

First of all press the Create new 
button.

The panel of the dialog allows you to
create an orthocamera from selected
samples and a Quick selection (as in
Selection tools) or from a Point list. By
pressing Fit Orthophoto button an
orthophoto is created in 3D window and
in the project tree.
Then it's possible to edit the camera,
aligning it to UCS views, making it
horizontal or vertical,...

At the end of this process press Set
camera dimension button to switch in the
Dimension and Corrections panel.

 The Orthophoto will be generated
from all the visible models (loaded and
flagged in the Project Window).

Dimensions and corrections
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Here you can set the properties of the
camera:
 dimensions
 resolution
 near and far plane distance.

The position of the camera can be
changed through translations and
rotations  in the space, as you can directly
see in the 3D window.

Depth
By selecting the Depth tool, the distance between a point on the orthophoto (1 point = 1 pixel) and a
reference level (depth origin plane) is added in the properties of the orthophoto. The main purpose
is to create a spot height map.
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The difference between Depth and Elevation options lies in the sign; setting zero on the depth origin
plane:
 in altitude mode, all values above the depth origin plane (e.g. between depth origin plane and

projection plane) are positive and all values below are negative;
 in depth mode, all values below the depth origin plane are positive and values above are

negative.

The image below can better show you the relationship between all the geometric components of the
orthophoto structure.

The Preview button allows you to visualize in the 3D window a preview of the orthophoto, setting the
same point of view and visualizing the loaded and checked 3D models. It helps you to find the right
position of the camera, by showing you a preview of the final result.

At the end of this process press Snap button to create the orthophoto then open the result in the
Orthophoto Viewer pressing the Open in viewer button.

Create X-Ray Orthophoto
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With this tool you can create an orthocamera from samples, points, axes, UCS directions,
etc., edit it and extract an X-Ray Orthophoto.
X-Ray Orthophoto can enhance important features of a 3D object such as edges, corners,
walls... It emphasize points aligned in one direction of view.
Only point clouds can be included in an X-Ray Orthophoto snap.

The recipe window is splitted in two panels:
 Position
 Dimensions and corrections

Position
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First of all, press the Create new 
button.
The panel of the dialog allows you to
create an orthocamera from selected
samples and a Quick selection (as in
Selection tools) or from a Point list. By
pressing Fit Orthophoto button an
orthophoto is created in 3D window and
in the project tree.
Then it's possible to edit the camera,
aligning it to UCS views, making it
horizontal or vertical...

At the end of this process press Set
camera dimension button to switch in the
Dimension and Corrections panel.

 The X-Ray Orthophoto can be
generated from:
 all the clouds in the project
 only the currently checked clouds
 only the currently loaded and

checked clouds
 a custom selection of point clouds

Dimensions and corrections
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Here you can set the properties of the
camera:
 dimensions
 resolution
 near and far plane distance.

The position of the camera can be
changed through translations and
rotations  in the space, as you can directly
see in the 3D window.

Depth
By selecting the Depth tool, the distance between a point on the orthophoto (1 point = 1 pixel) and a
reference level (depth origin plane) is added in the properties of the orthophoto. The main purpose
is to create a spot height map.
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The difference between Depth and Elevation options lies in the sign; setting zero on the depth origin
plane:
 in altitude mode, all values above the depth origin plane (e.g. between depth origin plane and

projection plane) are positive and all values below are negative;
 in depth mode, all values below the depth origin plane are positive and values above are

negative.

X-Ray Orthophoto settings
Select the desired contrast enhancement
algorithm during the X-Ray Orthophoto
generation.
For the majority of cases the default
(Logarithmic Transform) works well, feel free
to try others too, specific for your needs.

Press OK and wait a while.

The Preview button allows you to visualize in the 3D window a preview of the orthophoto, setting the
same point of view and visualizing the loaded and checked 3D models. It helps you to find the right
position of the camera, by showing you a preview of the final result.

At the end of this process press Snap button to create the orthophoto then open the result in the
Orthophoto Viewer pressing the Open in viewer button.

Orthophoto Viewer

To open a 2D viewer to visualize and dimension 2D maps created in Reconstructor
(both x-ray orthophotos and standard orthophotos).
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All the functionalities are below explained.

Navigation Mode

Navigation [Alt+1]
Pan the view by clicking the  left mouse button and releasing it when the desired view is
achieved.

Zoom out
To decrease the orthophoto zoom level.

Zoom in
To increase the orthophoto zoom level.

Zoom to Fit
To zoom to fit the entire orthophoto.

Zoom 1:1
To zoom to the orthophoto pixel size.

Selection [Alt+2]
Click on a item (e.g. a dimension) to add it to a multiple selection. Click on it once again
to unselect it.

Click a point to start a selection rectangle, drag out a box then click to another point to
complete the selection.
A different selection is due to a different direction by creating the rectangle:
 Left to Right: to select fully enclosed items
 Right to Left: to select partly enclosed items
Press Esc to cancel the rectangle
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Double click or press Esc to deselect all items.
Press Del (Canc) or the command Delete to delete the selection.

Measure Mode

Linear [Alt+3]
To add a linear dimension, X or Y aligned.
Click to pick the measure starting point.
Move the cursor to seek the desired position of the dimension and then click when you
found it.
Hold the Alt key to axis-align the measure during the point selection.

Aligned [Alt+4]
To add a linear dimension, aligned to the distance between the ending points.
Click to pick the measure starting point and then click to the end point. Move the cursor
to seek the desired position of the dimension and then click when you found it.
Hold the Alt key to axis-align the measure.

Angle [Alt+5]
To add a measure angle First click to pick the vertex of the angle measure, then click to
pick the first side (a half-line will appear) and finally click to pick the second side. Move
the cursor to seek the desired position of the dimension and then click when you found
it.

Area [Alt+6]
To define a perimeter on the map and compute the area inside it.
Click to pick the first vertex.
Click to add polygon vertices until you complete your perimeter and then click  the first
vertex again to close the area (that will be colored in red).
Move the cursor to seek the desired position of area's value annotation and then click
when you found it.
During the picking point press Esc to delete the latest point.

Volume  [Alt+7]
Drawing a planar area on the orthophoto with a guided polyline selection, the volume
identified by projecting this area along a user-defined depth is computed.

Depth 
If the Depth computation is performed during orthophoto creation, a labeled point is
added to the orthophoto's measures by clicking on a chosen pixel in the image. The
label indicates the value of the depth (or altitude) referred to the pixel position.

Depth Grid 
If the Depth computation is performed during orthophoto creation, a labeled grid is
added to the orthophoto's measures: the Grid spacing, the Sampling method ("Which
point you want to extract from the 2D image?" "The lowest in altitude to create a DTM",
for example) and the Sampling area radius (the average value is computed within the
circle defined by a range of influence around the node) are set in the Depth Grid
Parameters dialog
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while the position of the grid is defined by clicking on a chosen pixel in the image.
The labels on the nodes of the grid indicate the values of the depth (or altitude)
according to their position.

Continue
If pressed after the Linear/Aligned/Angle commands, permits to add other dimensions,
aligned to the latest one.

After inserting the dimensions, they will be also listed in the Project Window as items related to the
orthophoto.

Delete
To delete the selection of objects made by the Selection tool.

Settings

Settings
To set the viewer settings and the properties of the 2D image.

Viewer Settings
Check/uncheck Show tools instructions to show/hide tips on how to use commands use and on
orthophoto properties.
Check/uncheck Draw grid to show/hide the grid.  Here you can also choose the grid colorization.
Note that the grid unit is depending on the zoom level.
By clicking on the Change units... button it's possible to change the current units of measure. Few
preset are available, but different units of measure for lengths, areas and angles can be set, as well
as the number of decimal digits. 

Orthophoto (X-Ray) properties
Here the background (and foreground if you are managing a X-ray orthophoto) colors can be
changed.
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Also the color (RGB and alpha channel), the arrow size and the text size of the dimensions can be
changed as you please.
The image resolution is displayed, as well as the total photo (image) size in pixels.
If the resolution is here changed, it's necessary to recreate (snap again) the orthophoto in order to
save the changes.

Recreate
To regenerate the orthophoto with the currently visible point clouds. In case of X-Ray
orthophotos, the system will ask you which clouds you want to include in the
regeneration.

Origin
To set a new origin of the orthophoto by double clicking on an orthophoto's pixel to set
the axes and depth origin. Double right click to reset axes and depth origin.

Export

Export
To export the orthophoto (including all the customized dimensions) in different formats:

1. Image file
A *.png file is exported, keeping the same dimension and resolution of the original orthophoto.

2. AutoCAD Script
Several options are available to export your orthophoto to AutoCAD, in the settings dialog.
See Exporting orthophotos to AutoCAD for more details.

Note
If changes are applied from the last time you open the orthophoto viewer, you are asked to redo the
snap.

 The Logarithmic Transform is suggested as contrast enhancement algorithm: the greater is the
point cloud density in the view direction, the greater is the contrast (according to a logarithmic
function).

Create Camera
This sub-menu contains functions to create 

Perspective

Orthographic

Cylindrical
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Spherical

cameras with origin in the current point of view (the center of the 3D rendering window in your
monitor).

Note: Perspective Camera
A perspective camera can be used to
model a common photographic camera
(e.g. a reflex camera), which follows the
rules of perspective projection.
This type of virtual camera can be used to
acquire a virtual scan or to define a point of
view in the scene, which can be fixed by
right clicking on the camera item inside the
project tree and selecting the apply
projection command.

This camera can be converted into a
perspective projector by setting an image
using the set projector image command.
Note that the image to be applied needs to
be undistorted.

This camera can be also used ti fit
Orthophotos or X-Ray Orthophotos.

See Cameras for more informations regarding perspective cameras properties and associated
functions.

Place Here Survey Point

perspective
This tool creates a camera  with origin in the current point view and current View
Parameters settings.

Virtual Scan
This function is called Virtual Scan because you can imagine it like a scanning of the loaded models in
the 3D window with a virtual laser scanner (a virtual camera).
In addition you can set up the near view plane (from which to start viewing the objects) and the far
one.
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This function is used to resample the 3D dataset on a 2D grid from a defined position in 3D space
and with a defined projection (orthogonal, perspective, cylindrical, spherical). Checks the models that
must be scanned in the Project Items Window, and the depth range of the scan (near and far clip
planes) of the current camera. Can create snapshots, cube maps or grid point clouds.

Parameters:
 Update preview: creates a preview of the scan from the selected view point and

projection. Select the resolution and background color first.

Pick mode:
 Distance: press Left Mouse Button (LMB) for the first point and keep it pressed while

dragging the mouse to the second point, then release the LMB. Both endpoints must be
valid 3D points!

 Point: double click LMB to pick a list of 3D points from the virtual scan. If the AutoCAD link
is enabled, the points are sent to AutoCAD. Check Global Coordinates for reading
global/local coordinates.

Save cube map: (orthographic camera only) use this view point to construct a cube map of the
scene, i.e. 6 square images (the faces of the cube) of size Width with perspective projection  (90
degrees vertical field of view) are generated around the centre of projection and saved to file.
Save image: save the current virtual scanned image to file.
Save grid point cloud: create a grid point cloud from the current virtual scanned color and depth.
The model is automatically added to the project.
The bottom row of the dialog shows the unit scale (depends on the type of projection) of the image
and the computed volume between the plane of projection and the visible 3D data. For best results
use triangle meshes, so no holes are found on the surfaces. Otherwise, try to increase the point size
of the cloud of points in the Property Editor.

Orthophotos
A virtual scan of a plane/ortho camera or projector will be an orthogonal projection and thus an
orthophoto. If the image is saved with Save image, a text file is created along with the image file
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which exports registration information of the ortho image in the scene. 
Simultaneously with saving the image a script for AutoCAD® is generated. It allows, by simply
drag&dropping in the AutoCAD® window, to load the orthophotos in the correct position and scale,
(in a blue layer with the same name dedicated to image). It also creates a UCS having XY drawing
plane coincident with the image plane and positioned in the lower left side of the orthophoto, in
order to facilitate the user in redrawing of vectorial draw.
Press the Export to AutoCAD settings button to choose the options.
Remember that the DWG file (template acadiso) must be saved in the same folder and the script
files (* .scr).

Gridding: this process computes the optimal estimation for missing points in a grid of size MxN,
given K valid initial points. The algorithms available are: simple kriging (user has to specify the global
mean), ordinary kriging (the mean is computed automatically), kriging with trend (the mean varies
smoothly). Gridding is a demanding process, the time complexity is O(K²MN), so use as few as
possible initial points.

Export 3D position and orientation of orthophoto to AutoCAD: to choose whether you want to
export to AutoCAD the plain 2D image, or whether also the 3D position and orientation that the
image has in Reconstructor®'s current UCS should be exported to AutoCAD. 
Create new layer in AutoCAD containing the orthophoto: to choose whether to export the
orthophoto in a new AutoCAD layer or in the current layer. Depending on the number of layers in
the AutoCAD project, you may want to add a new layer or not. 
Create new UCS in AutoCAD with same position and orientation of orthophoto: to choose
whether you also want to create in AutoCAD a new UCS with the same position and orientation of
the image, or not. If you selected to export the 3D position and orientation as well, then this
checkbox is enabled. 
Suggested steps for orthophoto export to AutoCAD

 Click on Save Orthophoto button: an image (.png suggested) and a script file (.scr) will be
created. 

 Create and Save a .dwg file in the same folder of the exported orthophoto (acadISO format
suggested) 

 Drag&Drop the script file in AutoCAD dwg file just created: the orthophoto will be
automatically positioned in the 3D space if you flagged Export 3D position... in Export to
AutoCAD settings, otherwide you need to define the origin of the orthophoto in the XY plane
of the current UCS. 

 If you need to reset the orthophoto, you have to "Detach" it, save the AutoCAD project and
drag&drop the script file another time. 

See also Create Orthophoto.

Exporting orthophotos to AutoCAD
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1. Image file
A *.png file is exported, keeping the same dimension and resolution of the original orthophoto.

2. AutoCAD Script
Several options are available to export your orthophoto to AutoCAD, in the settings dialog.

Export 3D position and orientation of orthophoto to AutoCAD: to choose whether you want to
export to AutoCAD the plain 2D image, or whether also the 3D position and orientation that the
image has in Reconstructor®'s current UCS should be exported to AutoCAD. Exporting the image's
3D pose to AutoCAD is useful if other items (e.g. polylines) related to the same model are exported
to AutoCAD.
If you selected to export the 3D position and orientation as well, then the second checkbox is
enabled.
Create new UCS in AutoCAD with same position and orientation of orthophoto: to choose
whether you also want to create in AutoCAD a new UCS with the same position and orientation of
the image, or not. If you selected to export the 3D position and orientation as well, then this
checkbox is enabled. 
Create new layer in AutoCAD containing the orthophoto: to choose whether to export the
orthophoto in a new AutoCAD layer or in the current layer. Depending on the number of layers in
the AutoCAD project, you may want to add a new layer or not. 
Export dimension style: to give choice about whether to export also the dimension style (AutoCAD
compatible) or not. 

 Check this option only for the first import in AutoCAD.
Please, note that the dimensions are saved in a separated dimension style in AutoCAD called
Reconstructor.
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 If  two first options are flagged, at the end of the import process in AutoCAD the view is focused on
the origin of local orthophoto's UCS, to fastly localize the orthophoto.
To visualize a georeferenced orthophoto in the correct global reference system (according to global
coordinates), set the World UCS in AutoCAD.

Click on Export button to automatically save an image (*.png format) within together a script file
(.scr). 

Suggested steps for orthophoto export to AutoCAD
1. Click on Save Orthophoto button: an image (.png) and a script file (.scr) will be created. 
2. Create and Save a .dwg file in the same folder of the exported orthophoto (acadISO

format suggested) 
3. Drag&Drop the script file in AutoCAD .dwg file just created: the orthophoto will be

automatically positioned in the 3D space if you flagged Export 3D position and
orientation of orthophoto to AutoCAD in Export to AutoCAD settings, otherwise you
need to define the origin of the orthophoto in the XY plane of the current UCS. 

If you need to reset the orthophoto, you have to "Detach" it, save the AutoCAD project and
drag&drop the script file another time. 

To set a transparent background set the alpha channel to 0 (zero) in Orthophoto Viewer
Background color options. 
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Cross Sections 
This submenu contains commands and features to create cross sections and isolines of point clouds
(grid or unstructured) and meshes, starting from cutting planes and other constraints:

 Create/edit plane
 Cross sections
 Contours
 Quick profile
 Cross sections from planes
 Section from plane
 Tunnel cross sections

 Note that only 3D models (point clouds or meshes) loaded and displayed in the 3D window will
be considered in the sectioning processes.

Advanced cross sections structure overview

Section from plane, Contours, Quick profile and Tunnel cross sections tools give as output a special
Survey item composed by one orthophoto, one cross section polyline and one slice of point cloud (

if required and if sectioning point clouds) for each extracted section. 

These items are merged in groups named 
 Cross Section for ...
 Orthophotos
 Slices

Note that when sectioning more than one 3D model, one group per each model
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will be created including the polylines sections concerning that model. Only one
group will be indeed created both for Orthophotos and Slices items. In particular,
to create any single Slices item a merging of different point cloud portions is
done.

Several features are common in Section from plane, Contours, Quick profile and Tunnel cross sections
tools. They are explained below.

Navigation across sections

During cross section  display a preview of the final cross sections, any navigation modalities are
available in the recipe window. 

Map view
This navigation mode places the view so that all the selected items can be seen from a top

view.

Default view
This navigation mode allows the user change the current view so that all the selected items

are completely visible in the 3D scene.

Section view
This navigation mode automatically switches the view to orthographic mode and aligns it to
the cross section view.
Left and right arrows
The arrows can used to switch from a cross section preview to another.

Section Survey Settings

By clicking  button the settings parameters can be changed to manage the orthophotos'
resolution and quality of extracted polylines.
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Orthophoto settings
The resolution is automatically
computed according to
orthophoto's dimensions, but it is
possible to manually change it.
The resulting dimension ( in
megapixels) will be computed and
displayed.

Section from unstructured point
cloud settings
When sectioning unstructured
point clouds further settings can
be used to extract more detailed 
cross sections polylines.
Level of detail of cross section: you
can specify how many vertices
you want to use for your output
polyline. The more the vertices,
the finer the details that will be
reconstructed.
Cloud smoothness: if your cloud
represents clean construction
data, then select Smooth. If,
however, your cloud contains
noisy data, then select Noisy.
Close holes and remove isolated
parts: you can here specify the
size of the holes that are going to
be closed in the polyline, and the
size of the “islands”, small
disconnected components that
may have been created. The size
is computed as ratio between the
length of the hole/island and the
length of the whole polyline.

Polyline settings
The cross sections polylines are
computed interpolating the slice
of point cloud at the turn of the
cutting planes.
By selecting one of the following
options you can define the degree
of extraction of cross sections
polylines to be included into the
final section survey.
These settings must be mainly
managed in tunnels sectioning.
Extract all polylines : to keep all the
edges obtained from the
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intersection between cutting
plane and model's slices.
Extract main polylines only: to
delete short edges from polyline.
Extract external border only: to
close holes in main borders,
keeping only most external
borders. Be careful when more
tunnels or hollows are intersecting
in the same section.

Compute
After managing cutting planes and parameters click on Compute to extract the sectioning

outputs.

After creating a Section Survey, it will appear in the Project Window items list.

You can access the results at any time by the Survey's context menu, clicking on View cross sections
command: the Orthophoto viewer also displaying polylines and slices will be opened.

Export Section Survey

All the created items can be exported individually through the traditional export commands.
In the Survey's context menu another possibility is available: through the Export section survey
command you can export all the objects in a single step.
To do it, flag and define the exportation options, according to your purposes.

Export orthophotos as
Image only: to export only an
image file, not scaled and not
georeferenced
Image + AutoCAD script: to export
an image file within a script file to
import scaled and georeferenced
images in AutoCAD (see also
Exporting orthophotos to
AutoCAD)

Export cross sections as
Single dxf: to export cross sections
as polylines where any group of
polylines will be included in a
single .dxf file
Multiple dxf: to export all the cross
sections as polylines in a single
.dxf file 
Multiple Shape files: to export all
the cross sections in a single .shp
file
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Export section slices as
E57/LAS: to export the slices as
point clouds in E57 or LAS format.

Cross section

To create a cross section of your models you can access the relative command in the
top toolbar or from the planes' context menu.

You can make cross sections of grid point clouds and meshes. However, it is not possible to make
cross sections of unstructured point clouds.

Cross sections are defined with respect to a plane. 
With the default settings, the section is defined as a polyline created by cutting all loaded models
with the plane. However, it is also possible to have multiple cross sections by defining more slices or
additional cutting planes, all parallel to the original plane and lying at a certain distance from it.

In the top left spinbox you can specify how many slices you want, the default is one. The top right
spinbox allows you to specify the default inter-slice distance. By editing these two parameters, you
will notice that the values in the panel on the right in the dialog are changing. These are the list of the
slices' distances from the plane. By double-clicking on a single distance, it is possible to edit
individually each distance. Furthermore, it is possible to add (green “plus” button) and remove (red
“minus” button) the currently selected slice. There are also two buttons to Save the
distances and Load the distances: these are useful when you have to use the same distances set for
many cross sections.

Distances are defined on the plane's Z axis, therefore 0 means “slice lying on the plane”, and the
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positive direction is given by the direction of the plane's Z axis. You can invert the plane's direction
with the appropriate command in the plane's context menu. It is also possible to have negative
distances, by double-clicking on them and writing a negative number.

Towards the bottom of the dialog there is the Group polylines by panel, with the option to either
group the output cross sections by Slice or by Model. With the first option, one cross section will be
created for each slice, regardless of how many models the slice crossed. With the second option,
only one cross section will be created for each model crossed, regardless of how many slices
crossed that model and where. 

It is possible to use this last modality to create isolines (contour lines).
When you press Ok, the specified cross sections are computed and added to the project under
the Cross sections items group. Cross sections can be exported in DXF for AutoCAD.

Contours

To create isolines (contour lines) of your models (grid or unstructured point clouds and
meshes) you can access the relative command in the Mining top toolbar.

According to the frustum of the loaded models in the project, several horizontal cutting planes
(parallel to X and Y axes of current UCS) will be created; it's possible to define starting and ending
altitudes and the interval between planes. These planes will be automatically used to intersect the
models and extract the contour lines.

Flag Extract point slice  to extract also slices of point cloud in correspondences of the each isoline. The
thickness of the slice is defined by the slice depth value.

It is really suggested to use this tool on continuous and without opened boundaries surfaces.

See more details about the sectioning tools and export modalities at Cross sections introduction.

Quick profile

To create vertical cross sections of your models (grid or unstructured point clouds and
meshes) by simply picking two points in the 3D window you can access the relative
command in the top toolbars.

After clicking the Pick profile button, double click on two points in the 3D scene define start and end

points of the section line; select  to accept the choice. A cutting plane is created based on this
profile, but its width and height can be changed later.

Flag Repeat profile to create more profiles, setting intervals and number of sections parallel to the
main one.

Flag Extract point slice  to extract also slices of point cloud in correspondences of the each profile. The
thickness of the slice is defined by the slice depth value.

See more details about the sectioning tools and export modalities at Cross sections introduction.



Online Help Reconstructor 4.4

303 / 361

Cross sections from planes
This command creates a list of cross sections starting from a sequence of planes.

To extract multiple cross sections from different planes in a single step:
1. In the Project Windows, select the planes you want to use to cut the 3D models loaded in the

project
2. Open the context menu by clicking the RMB
3. Select the Cross Sections > Cross sections from planes command

Section from plane

To create cross sections of your models (grid or unstructured point clouds and meshes)
by selecting a cutting plane you can access the relative command in the CAD Output top
toolbar, below the Cross sections tools. 

After creating a plane you can select it through the Select plane button. You can here set its width
and height dimensions, independently from the original ones.

Flag Repeat profile to create more profiles, setting intervals, number of sections parallel to the main
one and direction of generation of cutting planes parallel to the main one (above, below or on both
sides of this plane).

Flag Extract point slice to extract also slices of point cloud in correspondences of the each cross
section. The thickness of the slice is defined by the slice depth value.

It is really suggested to use this tool on continuous and without opened boundaries surfaces.

See more details about the sectioning tools and export modalities at Cross sections introduction.

Tunnel cross sections

To create cross sections of your models (grid or unstructured point clouds and meshes)
following a trajectory you can access the relative command in the Mining top toolbar,
below the Tunnel Survey tools. 

The path used to extract multiple cross sections can be defined by points directly picked in the 3D
scene, or by polyline and trajectory already available between the project's items.

After clicking the Points button, double click on several points in the 3D scene to define the
trajectory of the the axial section line.
Select the undo button to delete the last picked point.

After clicking Polyline or Trajectory a list of available project items appears to invite to select the
desired one.

Select  to accept the choice or  to deny it.
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Several cutting plane are created based on this profile, but its width and height can be changed
later.Flag Repeat profile to create more profiles, setting intervals and number of sections parallel to
the main one.

Flag Extract point slice to extract also slices of point cloud in correspondences of the each section.
The thickness of the slice is defined by the slice depth value.

See more details about the sectioning tools and export modalities at Cross sections introduction.

DEM points

This function allows you to extract simplified models of your models (grid or
unstructured point clouds and meshes) you can access the relative command in the
Mining top toolbar.
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Areas & Volumes
These tools compute area and volume of point clouds and meshes portions.

Area
To compute the area of portions of point cloud and meshes surfaces.

Volume from plane
To compute volume of space included between a mesh surface and a plane.

Cut&fill volumes
To compute cut and fills volumes by comparing two meshes.

Area

Reconstructor® provides different ways of computing areas. 

When you press the Area button you can choose if you want to compute an area defined by a mesh
(1) or by a point cloud (2).

1. Area of a mesh portion
By using the Sampling tool you can perform a selection of a mesh's portion A new mesh is created
using only the geometry visible from the current view point.

2. Area of a point cloud portion

 Selected with Sampling tools
You can select the point cloud portion by using Sampling tools on the 3D window. This selection can
span across multiple point clouds.

 Selected with 3D polyline
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You can select the point cloud portion by using the Point selection with polyline command.

Volume from plane

This procedure enables you to calculate volumes by integrating meshes, or portions of meshes on a
custom plane. You can activate this tool via Outputs->Area & Volume Volume in the main menu, or via
the same button in the top toolbar. On activation, the window above appears in the Recipe window.

You define the mesh, the plane and optionally the polyline to use with the usual drag-and-drop
mechanism. Reconstructor® will calculate the volume of the mesh integrated onto the plane,
regardless of the triangles' normal directions. It should be noted that only the portion of mesh lying
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in the positive semispace of the plane will contribute to the volume. Parts of mesh lying below the
plane will result in zero volume.

Optionally, you can also provide a polyline. The polyline, projected on the plane, defines a closed
polygon on it. If you provide a polyline, only the mesh portion whose projection falls inside that
polygon will count for the volume. It is like if you would cut the mesh with the polyline before
computing its volume.

You have three ways to define the reference plane: either using the current view, or dragging a
custom plane, or using the horizontal plane with a given Altitude on the current UCS.

You can Compute the volume above the plane (and under the mesh) or Compute volume below the
plane (and above the mesh).

If you check Preview volume region, then Reconstructor® will show a preview of the 3D region of
which the volume will be computed. This preview refreshes if you change any of the parameters
from inside the recipe window. It may not refresh if you change something from outside the recipe
window, for example if you move the plane or the mesh with e.g. Adjust pose.

Once you have set all the parameters, press Ok. Reconstructor® displays a progress bar showing the
calculation's progress, and at the end visualizes a short report on the volume measure. You have the
options to copy this short report on the clipboard, or to access another window that enables you to
produce an elaborated PDF report, via the option Get PDF report.

Volume PDF Report
This dialog enables you to create a detailed PDF report about your volume calculation.

The dialog allows you to fill in a series of fields with the information you want to appear in the report.
The fields you uncheck or you left blank will not be included in the report.

On top left of the dialog you can fill the fields Site name and Company name. If filled, they will appear
as title/subtitle of your report. Below, check Survey information if you want to include in the report
information about survery operator and survey date. The checkable panel Processing information,
below, works in the same way.

On the top right of the dialog, you can also select whether you want the current 3D view to appear as
screenshot in your report. Finally, on the bottom right you can type additional notes to be included in
the report.

The data you insert are saved also in Windows' registry, therefore the next time you use this dialog
you will be able to reuse the data you filled in before.
When you have inserted the data of your report, click on Save PDF report and select a filename. The
PDF file you specified will be generated.

If a cross section survey is found for current mesh model, an Insert cross sections survey tool is
available.
If flagged, the cross sections related to a selected survey will be included in the PDF report, as
orthophotos reproduction.
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Contents

 Survey and processing information, as Survey date, Survey operator name, Processing date and
Processing operator name, ...

 Reference plane:plane used as reference surface to compute volume
 Surface integrated: mesh model used to compute volume above or below the plane

The volume is ....  m³ (computed volume between mesh model and reference surface) 

A screenshot of the current view of the models is also included.

Surface information
 Triangles count: number of triangles of the mesh model
 Vertices count: : number of vertices of the mesh model
 Area : area of the mesh model's triangles
 Center coordinates: coordinates of the center position of the mesh model
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Cross sections information
 Cross section survey name
 Distance between sections
 Cross sections views: list of 2D orthophotos displaying the extracted cross sections  

Cut&fill volumes

This
procedure
implemen
ts
calculation
of cut and 
fill volume
s. Given
two mesh
es repres
enting the
same
object
(e.g. the
same
terrain) at
different
instants in
time,
the cut vol
ume is the
volume
that the
objectlost 
between
instant 1
and 2,
the fill vol
ume is the
volume
that the
object gai
ned betwe
en the
two
instants.

The simplest way to use this procedure is to drag in the recipe window one mesh representing the
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surface at time 1, another mesh representing the surface at time 2, and click OK. Reconstructor will
return the volume of surface 1 integrated on the Z=0 plane of the current UCS, the volume of
surface 2 integrated in the same way, the cut volume (by how much the surface was excavated
between time 1 and time 2), and the fill volume (by how much the surface was filled (has gained
volume) between time 1 and time 2).

Given two surfaces S1 and S2, and a plane P,
and assuming that the projections
of S1 and S2 on P share a support C in
common, a third surface Smin can be defined.
Since each point in C, is the projection on P of
(at least) one point of S1 and one of S2, the
one of these points that is closest to P is
defined as belonging to Smin. Let V1 be the
integral of S1 on C, V2 the integral of S2 on C,
andVmin the integral of Smin on C. Then the
cut volume Vcut is given by V1 - Vmin, and the
fill volume Vfill is V2 – Vmin.

The user can specify several optional parameters, to satisfy special requirements. A set of altitudes
can be optionally defined, Reconstructor will calculate the contributions to cut and fill volumes for
each bench among two neighboring altitudes. The altitudes can be added and edited manually. Add
an altitude by clicking the plus button, the minus button removes the selected altitude. Double-click
on an altitude to change its value. Otherwise, the altitudes can be generated automatically by
specifying a starting altitude and a fixed bench height. Check automatic creation of regular
benches to do that.

These altitudes are by default referred to the Z axis of the current UCS. However, the user can
change this, by dragging and dropping a plane that fills the field Reference plane
(optional) and becomes the reference of all cut and fill calculation and of all altitudes.

The last optional parameter is a polyline that the user can specify to delimit the support C on which
the surfaces are integrated. The closed polyline is projected on the horizontal plane Z=0 of the
reference system and the support C in common between S1 and S2 is intersected with the area
delimited by the projected polyline. Therefore, the volumes are calculated only inside the frustum
defined by the polyline and the horizontal plane.

Once you have set all the parameters, press Ok and the computation starts, monitored by a progress
bar and by messages in the log window.

See also Cut&Fill report.
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Cut and fill by altitude report 

This dialog provides you a report of the results of a cut and fill calculation, along with options for
managing and exporting the results.
From top to bottom, the names of the surfaces “before” and “after” are reported, then the volume
of the surface “before” and then “after”, then the cut and fill volumes, then the number of benches
considered for the calculation. Lastly, a table comes with the result displayed for each bench. In fact,
you can define benches (intervals among altitudes) and see how the cut and fill volumes behave for
each bench.
On bottom right, four buttons offer you options for exporting the results. You can copy the results in
text form to the system clipboard, you can save the result to an XML file, or you can create a PDF
report with the result. This report can be integrated with more data on company and site name,
survey information and processing information. The button Generate PDF report opens the Volume
PDF report dialog.
You can also Change units of measure displayed in the report.

Inspection

Inspection is a procedure to compare two different shapes and to measure their
differences in geometry.
It is accessible from Measures tools in the top toolbar.

It is normally used to compare two models of the same objects surveyed at different moments in
time. For example, it is used for monitoring barrels of nuclear waste to immediately detect possible
deformations. 

The result of the inspection is a new color layer that will be assigned to the point cloud to inspect.
This color layer carries, for each point, its measured distance from the reference model. After
performing Inspection tool it is possible to use the Colors mapping dialog function to map these
measures with colors chosen by user and to see the corresponding color scale and histogram.

Two different processes are performed depending on the type of models to be compared: clouds
and clouds/meshes.

1. Cloud to Mesh
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Input models
As inputs, user must provide a model to inspect and one or more reference models. The model to
inspect must be a point cloud. The reference models must be triangle meshes.
The desired models can be inserted simply by dragging and dropping them. Press Remove selected to
deselect undesired models from your import.

Parameters
 Inspection name: to define a name for the layer that will be that will be generated
 Maximum search distance: every point of the model to inspect will be compared with

the reference model only inside a sphere with a radius defined by this parameter.
 Cloud subsampling: allows to balance speed versus precision. 

There are two cases:
o Inspect an unstructured point cloud: the cloud will be divided in s sets of points and only

one point in each set will be inspected. The other s – 1 points will be assigned the same
distance value measured for that point.

o Inspect a grid point cloud: the procedure will scan the points according to their structure.
The grid's structure will be divided in cells of dimension s by s. Only one point per cell will
be inspected and the other points will get the same inspection value measured for the
first.
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 Inspection types: to select the Inspection type to be performed by clicking " Change"
button.

Complete inspection
The distances between inspected and reference
models (meshes) are in accordance with reference
meshes' normals.
Inspection along one direction

o Cloud's origin direction: is much faster, but
on the other hand less accurate than the
former two. For each point in the input
cloud, is cast a ray from the cloud's origin
and is computed where the ray intersects
the reference surface. Finally, is calculated
the distance from the point along the ray.
Since this procedure only looks in one
direction, it can measure infinite distance
for a given point while the reference
surface may be very close to the point
along another direction.

o Axis direction: takes each point of the cloud
and computes its distance from the
reference model along a specific axis. User
can choose one of the three axes of the
current UCS. This inspection type is faster,
is usable with a great Max search
distances(e.g. 50m) and it provides signed
distance values (signs are calculated using
the normals of the reference mesh's
triangles).

Distances as signed values: distances will be
computed with positive sign when measure
direction is oriented in accordance with the normal
at the point to inspect, negative otherwise.
Distances in absolute values: distances will be
computed in absolute value absolute values.

2. Cloud to Cloud
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Input models
As inputs, user must provide a model to inspect and one reference model. Both models must be
a point cloud (structured or unstructured).
The desired models can be inserted simply by dragging and dropping them. Press Remove selected to
deselect undesired models from your import.

The result will be saved in a new color layer of the inspected cloud which represents the minimum
distance values of each point with respect to a respective triangle built on the neighborhood of
points of the reference cloud.

Parameters
 Inspection name: to define a name for the layer that will be generated
 Colorize between +/- displacement value: threshold (absolute) value used to define the

limits of the scale colorization.

This inspection tool always provides a distance value for each visible point of the inspecting
cloud, unlike the mesh-to-cloud inspection, where the maximum search distance constrains the
maximum range of measurable distance values.

The sign of the displacement measure is conditioned by the point cloud origin; be careful if the
model to be inspected is an unstructured point cloud.
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After defining the inspecton modalities, press  Compute to start the inspection process.
The resulting layer is appended to the color type list of the inspected point cloud, with the
desired Inspection name. 

Press Compute histogram button to calculate and plot (as well as to update) the histogram showing
the statistics of the data distribution, after defining the number of bins you want to plot.

Use Colors mapping tool (linked in the bottom of the dialog) to optimize the colorization and the
color legend.

Press Save report to collect all the information (histogram, statistics, picture with color legend, ...) in
a PDF report.
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Drawing tools

Constrain picking to a plane

To contrain points picked on 3D points or drawn polylines to a user defined plane.
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Video Record

In   Reconstructor® the creation of a video of your 3D model is possible, by using the Video Record
commands:

Flythrough Editor [Ctrl+F]
To define and edit a trajectory that the “virtual eye” of the 3D world can go through

Flythrough from point list
To create a flythrough from a point list in the project

Play
To start showing a preview of your video inside the 3D window

Edit
To manage the key points and the output videos's parameters

Make movie
To extract a video

Flythrough Editor

This window allows to define and
edit a trajectory that the “virtual
eye” of the 3D world can go
through, to generate a flythrough
video. You can input a sequence of
key points that you want the virtual
camera to pass through, to
generate impressive flythrough
videos of your models.
A trajectory is made up of a
sequence of view points (called
Keys) which are then interpolated. 

The dialog allows to
 Add key: appends the current view point to the list
 Insert key before: inserts the current view point before the selected key in the list
 Delete key: deletes the selected key
 Reset list: clears the list
 Update trajectory: if at least 2 keys are defined, a temporary trajectory is computed for

the checked keys (uncheck to skip the key) that can be simulated (Play from) or added to
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the project (Add to project)
 Play from: if a valid trajectory exists, an animation of the trajectory rendered, starting

from the selected key, using the desired speed
 Stop: stops the current simulation
 Movie: the Movie dialog is shown to select the parameters to create a movie from the

flythrough
 Add to project: adds the current trajectory to the current Reconstructor® project
 Close: hides the window

Double click with the left mouse button on a Key to jump to the view point.
If a flythrough exists in the project tree, by selecting Edit in its context menu the Flythrough Window
is shown with the Keys that make the trajectory.

See also flythroughs and Movie dialog.

Make movie

This dialog is accessible by Flythrough Editor and it allows you to create a movie out of a video
trajectory in your 3D scene.

To create the video, Reconstructor® uses the video codecs founded in Windows OS for current
machine, H.264 and H.265 basically.
For each encoder there is a list of presets concerning Resolution (in pixels), the Bitrate (in Mb per
second) and the Framerate (in frames per second).
You can select a desired preset according to your needs and your workstation capabilities. The
following presets are available: SD, HD, Full HD, 4K, including a Custom(izable) one. Once the dialog is
closed, the Custom's parameters are saved into Reconstructor® settings and they will be available
the next time you open the dialog.

After pressing Create, the video encoding starts and a .mp4 video is created.

See also flythroughs and Flythrough Editor.

Flythrough (trajectory) from point list

This command (contextual from point list or under Video record button) creates a flythrough.
It is useful to create videos and to generate orthogonal planes to it.



Online Help Reconstructor 4.4

319 / 361

See also Edit point list, Flythrough and Flythrough editor.

Save snapshot

Save snapshot
This function allows you to capture a snapshot of the main viewport with its rendered
models. You can save the captured snapshot in a variety of image formats, including
Bitmap, Jpeg and PNG.
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Manage units of measures
This dialog allows you to set
the preferred units of
measure for lengths, angles,
areas and volumes; and to
set how many decimal digits
should appear in
Reconstructor®. 

All available decimal places
are used for calculations.

Presets
On the top of the above dialog, you can activate some presets:

 SI (International system of units) will set meters as length unit, square meters as area unit
and cubic meters as volume unit.

 Imperial system of units will set inches, square inches and cubic inches as length, area, and
volume unit respectively. This button features a popup menu that gives you other two
options: to use feet and to use yards as basic measure unit for length, area and volume.

 U.S. customary units will set the U.S. survey feet as predefined length unit, the U.S. square
survey feet as area unit, and the U.S. liquid gallons as volume unit.

Selecting the units of measure
In the middle box of the dialog, you find three controls to select the length unit, the area unit, and
the volume unit to be used across all Reconstructor dialogs, visualized data and outputs.
You can select among a long list of measure units, belonging to the international system of units, to
the british Imperial system, and to the United States customary units, used for survey. Please see
below the complete table of the units of measure supported by Reconstructor.

Selecting the data's decimal precision
The last option in the dialog allows you to select how many decimals to visualize after the comma for
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each output value in Reconstructor®. This gives you a lot of flexibility to format your output reports
according to the precision you desire, but also it asks from you that you know the precision
limitations of your sensor in the particular dataset you are working on.

Units of measure supported by Reconstructor® 

Lenght units
Name Suffix Amount in meters

Meters m 1

Centimeters cm 0.01

Millimeters mm 0.001

Kilometers km 1000

Thousandths of an inch th 0.0000254

Inches in 0.0254

Feet ft 0.3048

Yards yd 0.9144

Chains ch 20.1168

Furlongs fur 201.168

U.S. links li 0.2012

U.S. survey feet US ft 0.30480061

U.S. rods rd 5.02921

U.S. chains US ch 20.11684

U.S. furlongs US fur 201.1684

Area units
Name Suffix Amount in square meters

Square meters m² 1

Square centimeters cm² 0.0001

Hectares ha 10000

Square kilometers km² 1000000

Square inches in² 0.00064516

Square feet ft² 0.09290304

Square yards yd² 0.83612736

Acres acres 4046.8564224

U.S. square survey feet US ft² 0.09290341

U.S. acres US acres 4046.873
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Volume units
Name Suffix Amount in cubic meters

Cubic meters m³ 1

Cubic centimeters cm³ 0.000001

Cubic millimeters mm³ 0.000000001

Liters l 0.001

Cubic inches in³ 0.000016387064

Cubic feet ft³ 0.028316846592

Cubic yards yd³ 0.764554857984

Gallons gal 0.00454609

U.S. cubic feet US ft³ 0.02831685

U.S cubic yards US yd³ 0.764554857984

U.S. acre feet US acre feet 1233.482

U.S. liquid gallons US fl gal 0.003785411784

U.S. liquid barrels US fl bbl 0.119240471196

U.S. dry gallons US dry gal 0.004404884

Angular units
Name Suffix Amount in decimal degree

Decimal degree ° 1

Radians rad 180 / 
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Special Tools
These tools are related to special environment and capabilities to interaction with other platforms.
The presence of these tools/commands is subordinated to the licensed add-ons.

Tunnel Survey

3DF Zephyr
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Tunnel survey

The tunnel survey tools are used to automatically generate cross sections along a trajectory and
extract a cylindrical develop of the tunnel as a scaled orthophoto.

Cylinder virtual scan
The virtual scanning can here be done in cylindrical projection using a cylindrical projector
as a virtual scanner.
This function will enable you to virtually scan your 3D scene by looking at it from a
cylindrical camera whose “backbone” is a selected flythrough. More concretely,
Reconstructor® will split your trajectory in many segments, each segment running from
point T(t) to point T(t + 1), where T(t) indicates the point on trajectory T at time t. Out of
each one of those segments, a cylindrical camera will be created having as main axis the
segment. Reconstructor® will pop up as many virtual scan dialogs as the segments are, to
allow you to do a virtual scan.
Tunnel cross sections
To generate a series of cross sections with a defined spacing; all of them are disposed
along a selected trajectory or polyline or series of points that describes the elongation of a
tunnel. The sections are perpendicular to the trajectory and constrained to be parallel
between them.
See more details at Tunnel cross sections page.
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Windows menu
The Windows manu in the Menu bar shows the permanents windows in the application.
All the dockable windows can be opened by right-clicking on the Top toolbar and upon.
 
 Project window
 Property window
 Readout window
 Point list window
 Log window
 Manual positioning (Adjust Pose)
 Flythrough window
 Recipe Window
 GUI options: opens a dialog to change GUI settings.

Project Window
All the item are listed in the Project Window.
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This window provides a tree view of the
current project items.

The Project window lists the items present in
the project, organized in a tree structure,
where each data type is grouped in a separate
folder.

Note: the  is a temp file
used to lock the project and prevent it from
being opened in another Reconstructor
session.
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By hovering the mouse over the item name, a
tool tip pop ups with some information about
the item, like file path, file size, etc.

To enable the rendering of an item, click the checkbox  on the left of the item. The checkbox of a
folder enables/disables all its sub-items.
Uncheck-check process permits you to load a model.

Items such as point clouds or triangle meshes are models. Models can be loaded or unloaded; loaded
models are listed in bold in the project window. 

Load model
Selecting a model (cloud of points or mesh) from the project window tree and pressing this
button, the model will be loaded in PC RAM and if it is also checked , it will appear in the
3D  viewport.
Unload model
It unloads from the RAM and from the main window the selected item(s).

Unload all models
It unloads from the RAM and from the main window all the models (point clouds and
meshes).

Load projector
It loads (light on) the image of a projector on the 3D model.

Unload projector
It unloads the image of a projector from the 3D model.

Unload all projectors
It uunloads from the RAM an from the main window all the projectors.



Online Help Reconstructor 4.4

328 / 361

Search project item
It searches through the items of the project.

Furthermore, by right-clicking on an item in the project window, a context menu is displayed where
only the commands that apply to the given item type are shown. Commands can therefore also be
issued from that context menu: this is useful in particular to load/unload a model, to set an hyperlink
to an item or to open the hyperlink, to move the item to another group in the project.

Each item has properties that can be viewed and edited in the Property window when the item is
highlighted.

To rename a model, right-click on it and select rename. To rename all other items, double click on the
item's name and edit the name.
If an item needs to be saved it appears in red color or red bold color if loaded.

To remove one or more items from the current project,  select the item(s) in the Project
window and select Remove from the contextual menu or press CANC key. The files are not lost, they
are simply moved to the project's Trash folder inside the project directory, so they can be recovered
(cut away from the trash to an other project folder and Load item... from the File menu).
A specific behaviour is dedicated to removing groups or group's items (see more details at Groups
entry).

Multi-selection of items is possible by using [Shift] and [Ctrl] keys. Then it’s possible to:
 delete the selection with CANC key
 set the common properties in the Property window
 open the context menu (right click on the selection) to display the commands that are

applicable to the selection.

Quick model distinction can be made by pressing the “Color by ID”  button on the Project window
toolbar. Each model is colored by its color ID set in the Properties window. This color is randomly
computed when the model is inserted in the project. See Screen settings.
 
See also dockable windows, and project items.

Recently used items dialog
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This dialog allows you to quickly select
for a certain operation some of the
project items you used most recently.

Many important Reconstructor®

functions need to have project items
as input. For example, the function
“Registration” needs two grid point
clouds as input. You can start these
functions by taking care of selecting
the input items first, in the project
window. However, this dialog offers
you an alternative and in some cases
more efficient way of starting your
functions.

If you start a function that needs items
of a certain type as input, and none of
these items is selected, then the
dialog pictured above pops up to help
you. The peculiar feature of this dialog
is that it shows you the candidate
items for your function, listing
them from the most recently used to
the least. If you are working
repeatedly around few items, using
this dialog might be more efficient
than scrolling each time the project
window that may easily contain
hundreds of items.

See also project items, and project
window.

Property Window
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This dockable window is situated by
default on the left side of
Reconstructor®'s GUI. It allows to
read and edit the properties of the
current selected item(s) in
the project window.

In Reconstructor® each project item
has properties.
There are general properties,
owned by all project items, and
there are specific properties that
are peculiar to each type of project
items.

General properties
These properties are common to all Reconstructor® project items, and always displayed in the
property editor:

 Hyperlink: each project item can be linked to any URL: other project items, files on the PC,
web addresses.

 Color ID: each project item has a specific color to identify it from other items. You can edit
the color ID by clicking on the       value field of the color ID property. To render the items
with their color IDs, select Navigation->Color by ID.

 Comment: this comment will appear in the item's annotation if the above property is true.
 Draw annotation: a boolean property. Each project item has an annotation, that is

rendered in the 3D scene if this property is true.
 Draw coordinate frame: this property is not owned by annotations. All other project items

have an object coordinate system. If this boolean property is true, Reconstructor will render
an axes triplet to show where the object coordinate system is. This is useful for examples
to know in which direction a plane's normal is oriented.

Log Window

By pressing the Open Log Window button, at the bottom left screen corner, you will see the last
twenty lines of the log.
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Button clicks, status of algorithms, errors and warnings, result of procedures... everything that
happens inside  Reconstructor® is logged and shown in the text panel displayed in this window. Log
messages can be of four types: information, warning, critical and fatal. Log messages appear always
with their type and the time instant.

Information window

The information dialog includes general properties, points statistics, color and geometrical
properties of the Reconstructor's items.
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GUI Options dialog
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This dialog allows the user to
change some GUI settings.

The first two check boxes
control how freely the
dockable widgets can be
moved around and detached.
A reset button resets widgets'
positions to a default setting.

The software's language is managed by a drop-down menu.
After selecting on of the available languages (English, Italian, Russian and Chinese), click
on Apply. 
Restart Reconstructor® for the language update to take effect.

Custom toolbox

In the Toolbox bar all the main tools are organized in different tabs of default, as you seen in the
previous paragraphs.
If you are used to using so me commands often, it can be useful to create a customized bar that
includes these commands, available under "Custom Toolbox".
As for example...

The Windows > Custom toolbox tool opens a dialog to define the toolbar, available also by clicking on

 in the Toolbox bar.
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Three main boxes include all the tools available in Reconstructor®, subdivided into Top Menu
Commands, Context Menu Commands and Toolboxes Commands, according to their position in the
software.

To add one of these commands to the Custom toolbox you need to select and drag&drop it to the
area at the bottom of the dialog. You can also double-click on any command to add it to the Custom
toolbox.
To remove one of the commands from the Custom toolbox select it in the area at the bottom of the
dialog and click on the Remove selected button.

By flagging Enable custom toolbox it will be available on the Toolbox bar.
Click on Ok to confirm and close the dialog.
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Add-ons

Reconstructor includes all the functionalities to import, process, automatic aligned and measure 3D
clouds. It's easy to add the Mining add-on for mining and terrains application or the Color add-on to
integrate 3D models with external images. 

Full functions in trial version: during the trial period you can test all the add-on and verify what you
need.

By clicking on Add-ons > Manage Add-ons command a selectable list of the add-ons will appear, giving
you the possibility to activate or deactivate the add-ons.

Note: the access of each add-on is due to the available licenses!

As an example, if an user has to carry out a task with mining data, he or she can adjust the interface
for a Mining workflow, through this menu. In this way, top toolbar and dockable windows are
reorganized by showing only the functions useful for mining tasks, and in a meaningful order and
place. 

If you uncheck all the buttons, Reconstructor runs in Viewer mode.

 Reconstructor Viewer
 CONSTRUCTION add-on
 MINING add-on
 COLOR MAPPING add-on

Reconstructor (free) Viewer
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The Reconstructor Viewer's toolbar has only a few available functions.
All Reconstructor navigation and display functions are included.

Annotation
This function allows you to create annotation of 3D points of models in your project.

Distance
This button allows you to measure a distance between any two points in the 3D scene

Open Angle Tool
This button enables you to measure and angle between three points in your 3D scene.

Play
Plays an animated flythrough of the 3D scene, according to a given trajectory.

Orthophoto Viewer
To open a 2D viewer to visualize and dimension 2D maps created in Reconstructor (both x-
ray orthophotos and standard orthophotos).

CONSTRUCTION add-on

Dedicated functions for BIM, Architecture and Construction.

MINING add-on

Dedicated functions for territorial data analysis.
 
Expand your Reconstructor commands with the MINING add-on functions: advanced calculation of



Online Help Reconstructor 4.4

337 / 361

volume/cut&fill volume, topographic mesh, extraction of sections from plans and much more. This
package of functions is particularly suitable for those working on spatial data, quarries or open pit
mines to optimize the development of a site and make work progress decisions based on detailed
information.

COLOR MAPPING add-on

Dedicated features for images management.
 
Expand your Reconstructor commands with the COLOR MAPPING add-on features. You will get at
your disposal the creation of meshes with photographic textures, the use of panoramic images, the
management of the projectors and much more. This set of functions is particularly suitable for those
who want to work with high-resolution images to integrate with their 3D models and obtain high-
level results such as technical tables with photographic details. 
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Help

Through this menu you can access Reconstructor® Online Help system, diagnostic information,
useful when asking for support.
You can also enter Reconstructor® license manger, to browse the license features activated and
activate new ones.

In detail see links down here:

 Online Help
 Offline PDF Manual
 License Manager
 Show Commands Dashboard
 Memory Usage Report
 Hardware Info
 About Reconstructor
 Check For Updates
 Open Log Folder
 Crash report

Online Help

This menu voice opens the present online help (which can be invoked also by pressing F1 key). 
You can open the contextual online help about the current window by just pressing F1 if the button

 is present.

The last update date is written in the Introduction page; this online help is more frequently updated
than Offline PDF Manual.
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Offline PDF Manual

This manual is updated when a new version of Reconstructor is installed. It doesn't need an Internet
connection.
We recommend using Online Help because it is more frequently updated and better formatted.
Use it only if you do not have an Internet connection available.

License Manager
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Here you can check your current license or activate / update a new one.

Generate license activation request (C2V) (Client to Vendor)

The software checks your licenses and offers you only the possible choices.

Apply license activation file (V2C) (Vendor to Client)
Browse for the *.v2c file.

See Licensing chapter for license details, request and activation.

Commands Dashboard

The Command Dashboard (Ctrl+d) supports the user to find the location and the meaning of all the
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Reconstructor commands.
It shows also the commands short cuts when available.
There is a very useful search bar, use it!

Return to the Getting Started where the main commands are briefly explained.

Memory Usage Report

Some information about the status of memory (RAM and GPU memory).

Hardware info
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About Reconstructor®
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This menu option
opens the About
Reconstructor®

window. This window
displays
Reconstructor®'s
complete version
number and other
diagnostic
information. When
asking for support
from Stonex, you
may be asked to
produce a screenshot
of this dialog, or to
report some
information from this
window.

This Reconstructor
version uses the
following third party
libraries.

Third Party Libraries

Library link

assimp http://www.assimp.org/index.php/license

ceres-solver http://ceres-solver.org/license.html

eigen3
http://eigen.tuxfamily.org/index.php?
title=Main_Page#License

IfcOpenShell http://www.ifcopenshell.org/

lib3ds https://github.com/hoopoe/lib3ds

libcurl https://curl.haxx.se/docs/copyright.html

http://www.assimp.org/index.php/license
http://ceres-solver.org/license.html
http://eigen.tuxfamily.org/index.php?title=Main_Page#License
http://eigen.tuxfamily.org/index.php?title=Main_Page#License
http://www.ifcopenshell.org/
https://github.com/hoopoe/lib3ds
https://curl.haxx.se/docs/copyright.html
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libraw https://www.libraw.org/docs

loki http://loki-lib.sourceforge.net/index.php?n=Main.License

marble https://marble.kde.org/index.php

OpenCASCADE https://www.opencascade.com/content/licensing

opencv https://opencv.org/license.html

OpenMesh https://www.openmesh.org/license/

openvrml http://www.openvrml.org/doc/lgpl.html

Poisson Reconstruction
http://www.cs.jhu.edu/~misha/Code/PoissonRecon/Version
10.07/

proj4 https://proj4.org/about.html#license

QuaZip https://sourceforge.net/projects/quazip/

Qwt https://qwt.sourceforge.io/qwtlicense.html

Snappy https://github.com/google/snappy/blob/master/COPYING

Xerces https://xerces.apache.org/xerces-c/

LASlib LASlib

 

LASlib
--------------------------------------------------------------------------

  LICENSE AGREEMENT:

  This software is distributed WITHOUT ANY WARRANTY and without even the
  implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.

--------------------------------------------------------------------------

  There are TWO parts to LAStools. One part is OPEN source (LGPL 2.1). The
  other part is CLOSED source and requires licensing for most commercial
  or government use. If you're unsure please email 'martin@rapidlasso.com'
  before using LAStools. For education and evaluation purposes you can use
  and test LAStools as much as you need to ... (-:

  Personal note: The creator of LAStools and LASzip is currently not able
  to attend LiDAR conferences or other scientific meetings in the US over

https://www.libraw.org/docs
http://loki-lib.sourceforge.net/index.php?n=Main.License
https://marble.kde.org/index.php
https://www.opencascade.com/content/licensing
https://opencv.org/license.html
https://www.openmesh.org/license/
http://www.openvrml.org/doc/lgpl.html
http://www.cs.jhu.edu/~misha/Code/PoissonRecon/Version10.07/
http://www.cs.jhu.edu/~misha/Code/PoissonRecon/Version10.07/
https://proj4.org/about.html#license
https://sourceforge.net/projects/quazip/
https://qwt.sourceforge.io/qwtlicense.html
https://github.com/google/snappy/blob/master/COPYING
https://xerces.apache.org/xerces-c/
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  a somewhat unfortunate, kind of silly, and in many ways absurdly funny
  incident involving "laser chickens" and a US Nuclear Weapons Lab. If you
  have enough "pull" to rectify this ridiculous situation we would like to
  hear from you ... (-;

--------------------------------------------------------------------------

  This part of LAStools is "free" open-source LGPL (see COPYING.txt). To
  purchase a different licensing model contact 'license@rapidlasso.com'.

    * laszip
    * lasindex
    * lasvalidate
    * lasliberate
    * lasinfo
    * las2las
    * lasdiff
    * lasmerge
    * las2txt & txt2las
    * lasprecision
    * LASzip (with static linking exception)
    * LASlib (with LASzip) - the API used by LAStools.

  These two are also "free" to use but not available in open source.

    * lasview
    * laspublish
    * lasoptimize

--------------------------------------------------------------------------

  The following LAStools require licensing for any commercial, government,
  or production use. However, they may be used "freely" for all non-profit
  personal, non-military educational, or non-profit humanitarian purposes.
  Note that the output of the unlicensed version can be slightly distorted
  after certain point limits are exceeded. Control output in the console
  (aka "the black window") informs the user whenever this happens.

    * blast2dem
    * blast2iso

    * lasground & lasground_new
    * lasheight & lastrack
    * lasclassify
    * lasgrid & lascanopy
    * lasboundary
    * lascontrol
    * lasoverlap
    * lasoverage
    * lasduplicate
    * lassplit
    * lasreturn
    * las2tin
    * las2iso
    * las2dem
    * lasthin & lasnoise
    * lassort
    * lastile
    * lasplanes
    * lascolor
    * lasclip
    * las2shp & shp2las.

--------------------------------------------------------------------------

  If you want to use LAStools please contact us for licensing. You can
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  (a) license the existing executables for production
  (b) license the existing executables for inclusion in your software 
 
  You can also contract with rapidlasso GmbH to create LAStools tailored
  to your particular needs.
  
--------------------------------------------------------------------------

  COPYRIGHT:
  
  (c) 2007-2017, rapidlasso GmbH, GERMANY - fast tools to catch reality

--------------------------------------------------------------------------

Check for Updates

Reconstructor® automatically checks new updates when available.

It is also possible to set an automatic check of update frequency: daily, weekly and monthly.

After downloading, follow the instructions to update the version.

Open Log Folder

This button opens the Gexcel log folders at the address C:
\Users\<username>\AppData\Roaming\Gexcel\Reconstructor  .
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Crash report

In the event of a crash, the Reconstructor application closes and a dialog is shown that invites to
send a crash report and  (optionally) allows you to send a feedback message to attach to the report.

Optionally providing your email address you can be contacted to directly support you. you accept
that your data will be internally managed by Stonex and only used by Stonex to provide support and
to improve the performances of Stonex’s software and products. Your email address will be
accessible to Stonex’s Technical and Administration teams and will not be used for commercial or
marketing actions.

The crash report dialog then allows you to restart the application or exit.



Online Help Reconstructor 4.4

348 / 361

Glossary
In this section you can find all the main definitions that you can encounter during the usage of
Reconstructor®.

Annotations

An annotation is a project item that defines a 3D point annotation complemented by different
properties below explained.

 Annotation ID: code to exactly identify the item in the project
 Annotation Name
 X, Y, Z coordinates of the annotation position in the current UCS
 Color mapped layer: current mapped color layer name
 Value: value of the color mapped layer (one value for scalar color layers, 3 RGB components for

not scalar layers)
 Comment: notes at the point
 Hyperlink:  hyperlink set to a local files or another project's item (interesting feature to add meta-

information to your 3D scene from e.g. the web)
 Color ID: color ID of the item annotation

Annotations are stored in form of point collections. Therefore, they don't have a pose matrix like all
the other project entities and cannot be moved or rotated through Manual positioning or the Pose
dialog.

Annotations can be converted to Points or Targets items through the contextual menu, after
selecting them in the Project Window. It is also possible to do the reverse.

Learn how to insert an annotation at Annotation and how to export it at Export annotations.

Cameras

A camera is a project entity that defines a viewpoint in your virtual 3D world. A camera has
a pose (like all project entities) that defines the camera's position and orientation. A camera has also
a projection that defines how the camera sees the world.
There are four types of cameras, according to their different projections:

 Perspective cameras
 Orthographic cameras
 Cylindrical cameras
 Spherical cameras

The editable properties of the cameras are:
 Comment: user comment
 Draw coordinate frame: draw the local coordinate frame of the frustum
 Clip far plane: distance of far clipping plane in meters. Specifies the maximum rendered
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depth. Must be greater than Min depth
 Clip near plane: distance of near clipping plane in meters. Specifies the minimum rendered

depth. For perspective cameras, only values greater than zero are allowed
 Image size (Width, Height): size of the image in pixels (used only as a place holder for

repetitive virtual scanning)
 Shadow depth bias: This parameter concerns shadows calculation for a projector.

Sometimes, during shadow calculation, there can be some noise while assessing which
object is in foreground and which is in shadow. If you increase this parameter, the effect of
noise is reduced, however the shadows risk to be not realistic anymore. If you decrease it,
you will get more precise shadows, but you risk to get salt and pepper effects: as if the
color projected fell also on the object in shadow in small grains.

Furthermore, there are specific properties for each of the camera projection types:
 Perspective cameras:

o Vertical field of view (degrees)
 Orthographic cameras:

o Extent on X [m]
o Extent on Y [m]
o Keep aspect ratio for image size

 Cylindrical cameras:
o Length [m]
o Radius [m]
o Longitude begin [deg]
o Longitude end [deg]
o Slices

 Spherical cameras:
o Radius [m]
o Longitude begin [deg]
o Longitude end [deg]
o Latitude begin [deg]
o Latitude end [deg]
o Slices
o Stacks

These particular properties, that change with the camera type, define the frustum of the camera,
together with the near and far plane. The frustum of a camera is the 3D region of space that the
camera sees. It is a pyramid for perspective cameras, a 3D rectangle for orthocameras, a cylinder
and a sphere respectively for a cylindrical and spherical camera.

From the contextual menu of any camera, you can activate also the following commands:
 Go to: to jump to the camera view point.
 Invert direction: to invert the direction of the view of the camera
 Apply projection: to jump to the camera view point and apply the camera projection as

the current rendering projection (if perspective or orthographic)
 Duplicate as: to create a new camera copying the transformation of the current one
 Fitting

o Set optimal depth range: to automatically compute  the tightest near and far
clip plane positions

o Select projectors in this frustum controls which cameras meet these two
conditions:

a) have a focal axis that forms an angle with the focal axis of the selected chamber lower
than "Maximum incident angle"
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b) have a frustum that intersects the frustum of the selected camera
The projectors/cameras are so checked in the project window

o Select models in this frustum finds (and checks) the meshes intersecting the
selected camera (useful for texture mapping)

 Analyze -> Virtual scan: uses the camera frustum to resample the scene and generate a
new grid point cloud or an image.

Warning: to optimize the depth accuracy of the virtual scanner, try to keep the clip near and
far planes as close as possible to the desired scene depth range.

Example of spherical camera frustums:

Flythrough (video trajectory)
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A flythrough , or video trajectory, is a trajectory
that runs in your 3D scene, defining how a
video camera will move around in your scene
to capture a movie. A flythrough is the
“backbone” of the movie you're creating of
your 3D scene.
In the picture above, the red curve line is the
trajectory that the video camera does. The
yellow segments are the optical axes of the
video camera for each video frame.

Flythrough creation
The easiest way to create a flythrough is by using the flythrough editor: you can define keys, or
important positions you want your video to pass through, and then interpolate the remaining
frames. You can also create a flythrough from point list. The difference is that with the point list
window you can only use points that belong to existing models to define your trajectory, meanwhile
with the flythrough editor you can choose your keys freely.

Operations on flythroughs
If you right-click on any flythrough, you have access to some useful operations. You can play the
flythrough, to see a preview of the video associated with it. You can edit the flythrough, and then the
flythrough editor will appear to allow you to add or delete keys to your trajectory. You can make
movie, and then the movie dialog will enable you to specify the video encoding parameters to
produce the final video. 

 Cylinder virtual scan. This function will enable you to virtually scan your 3D scene by looking at
it from a cylindrical camera whose “backbone” is the flythrough. More concretely,
Reconstructor® will split your trajectory in many segments, each segment running from point T(t)
to point T(t + 1), where T(t) indicates the point on trajectory T at time t. Out of each one of those
segments, a cylindrical camera will be created having as main axis the segment. Reconstructor®

will pop up as many virtual scan dialogs as the segments are, to allow you to do a virtual scan.

 Generate cross sections. This function provides you with a way to create cross sections of
your models along the trajectory. If you select this function, Reconstructor® asks you the spacing
between different cross sections along the trajectory. When the spacing is set, Reconstructor®
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creates several planes, with the normal placed along the trajectory and placed according to the
spacing selected. These planes are added to the project and named Flythrough section n(N). It is
left to you to actually select one of these planes and calculate the desired cross section.

You can also convert the flythroughs into polylines by using the Convert to polyline command in the
contextual menu.

Groups

A group is a cluster of items composing the project.
You can create and manage the groups from the context menu.

To create a group you only have to open the
context menu of a data type folder by right-clicking
on it and select the New group… command.

To populate a group you have:
 to move a selection of items from a previous position (to a new one) with Move command

from the context menu of the selection
 to paste the selection of items in the new group, with Paste in group command from the

context menu of the new group.

A potential hyperlink is visible in the Property Browser of a group. 
Here is also possible to set a Registration role for all the scans inside the group:

 None
 Same as parent: to set as registration role the same role of a higher level group
 Children move together: if a single scan is moved in the 3D space, all the other scans in the

group move together, as a rigid system
These roles are used to make a scans registration through groups.
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You can also create a group made up of different data type objects.
As is seen in the picture at its side this possibility is useful to put
together all the items of a single sub-project, for example. 

 To move out by a group an object, the Ungroup command from the context menu of the object is
the way.

To delete a Group you have two ways:
 open the contextual menu of the group (click on RMB) and select Remove Group command
 starting from a selection of (also) several objects click [Canc] on keyboard. According to the

selection, a different

When deleting a not empty group with Canc, it is asked if you want to delete the objects inside or
not.

 Don't remove a not empty group if included in a heterogeneous multi-selection.

Planes
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Reconstructor® allows you to define planes in your project. 
A plane has a width and a height that can be specified in the property editor window under Extent on
X and Extent on Y. A plane has also all the properties of a project entity: Color ID, comment, hyperlink,
Draw annotation, Draw coordinate frame. To enable the last one is particularly useful in order to
visualize the plane's normal direction.

From the contextual menu of a plane item, you can also start the following commands:
 Cross section: use this plane to compute a cross section of the models activated in the scene. The

result is a polyline
 Invert direction: inverts the plane's coordinate frame Z axis direction. The positive direction

determined by the plane has an influence for instance in cross sections, volume and cut and fill
calculations.

 Meshing->Create mesh from a plane: to create a mesh starting from the plane object. Useful for
example for inspection tool. 

 Set costrained draw: to pick points in the 3D scene and draw them as a projection on the plane.

See also Project items and Plane creator/editor.

Point Clouds

There are two different kinds of point clouds in Reconstructor®: 
 Structured point clouds (also called grid point clouds, or range images, or scans): scan-based

clouds, "fixed-origin" or tripod scans. They include row/column info and the origin scan’s
position. 

 Unstructured point clouds 

Operations available for both unstructured and grid point clouds are:
 Recompute bounding box: useful sometimes when the bounding box is not updated

(available only if the model is loaded in memory)
 Histogram: the histogram tool allows to optimize the contrast by histogram stretching

(available only if the model is loaded in memory and if the current color type is 1f or 1d, i.e.
a high-dynamic single-channel point color)

 Colors mapping: point colors can be remapped to a pseudo colored scale to improve the
dynamic range, if the histogram stretching is not sufficient (available only if the model is
loaded in memory and if the current color type is 1f or 1d, i.e. a high-dynamic single-
channel point color). This tool can be also used for range segmentation and inspection.

 Inclination from plane: if the Inclination color type is available (the model must be pre-
processed) the dialog allows to select a plane whose normal is projected to the normals of
the model (dot product). The result is added as a 1f color type.

Operations available only for grid point clouds are:
 Edit 2D: edit the grid
 Extract edges: create a polyline from the computed orientation and depth discontinuity

during the pre-processing phase. The polylines are as contiguous as possible, adjust the
max search distance and minimum edge length to optimize the outcome.

 Cross Sections
 Multiresolution Mesh
 Simplify Points:  to determine the most relevant points from a point of view of shape

description, saving them into a new unstructured point cloud. 
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The editable properties - for both of them - are:
 Color ID: you can edit the color ID by

clicking on the value field of the color
ID property. To render the items with

their color IDs, select Navigation-
>Color by ID.

 Draw coordinate frame: if true, draw
the local coordinate frame 

 Point size: size of drawn points
 Subsampling: subsampling rate of

rendering of the cloud of points
 Color mapped: select the color type to

render the point cloud

Advanced notes
A Grid point cloud of point can be viewed as “image” where the number of pixels (pix) are equal to
the number of point the scanner has acquired (valid and invalid). 

Point clouds data storage
Data is stored in an XML description file + pure binary vector files. The file extension of the binary

data specifies the format, where data.NT: N=num of components (1,2,3,4…), T=data type (byte,

short, word, half, float, double).

For point colors, a special 3bc (c stands for compressed dynamic range) file is created for rendering

only, for instance after histogram equalization.

For example, the unstructured point clouds myUnstruct will be saved in the following files in the

project folder:

 Unstructs/myUnstruct.rup, an XML file containing the cloud's properties

 Unstructs/myUnstruct_rup/points.3f

 Unstructs/myUnstruct_rup/status.1i
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 Unstructs/myUnstruct_rup/Reflectance.1f

 Unstructs/myUnstruct_rup/Reflectance.3bc

 …

The grid point cloud myGrid will be saved in a similar way in the folder Grids inside the project folder.

Grid point cloud files have extension “.rgp”

An unstructured point cloud, instead, is like an unorganized list of points.

Polylines

Polylines are sets of open or closed polygons that appear in your 3D scene. You can create polylines
in several ways:

 From the points you have collected in the point list window.
 From the cross sections tool (the polylines created by this tool are saved in your project in

the Cross sections group).
 From the command Data management→Meshing→Get mesh borders as polylines, belonging

to the context menu of the triangle meshes.
 From the Mesh Crest and Toe tool.
 From the edge extractor of grid point clouds, available via Data management→Cloud

processing→Extract edges


The most important context command for polylines is the Export command, that allows you to
export the polyline in the DXF format, readable by AutoCAD®.
It is often useful to define polylines in order to delimit the region in which you want to
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calculate volume, or cut and fill volume. Polylines can be also used to select points or to cut meshes.

Projectors
A projector is a camera view plus an image to project on the scene. It can colorize whatever
geometry is “lighted” by the projector allowing also to see occlusions if shadow mapping is
supported.

The specific commands are:
Load projector: to load (light on) the image on the 3D model.
Set projector image: to set the desired image to project
Edit projector image: edit the projector’s image to set the transparent pixels in order to produce
better blending among the projectors

The specific editable properties are:
Activate: the image is loaded and projected on the scene

Shadow mapping
This technique works only for triangle meshes. To compute the occlusions from the view point of the
projector, a depth buffer of the scene is created. Unfortunately the accuracy of the shadows
depends on the sampling of this depth buffer, thus its width and height and depth range. Ideally the
size should be infinite, but this cannot fit in the memory so the resolution must be tuned. It's
recommended to use at least the width and height of the projected image and to keep the clip near
and far planes as close as possible to the desired scene depth range. Because of this coarse
resolution, the resulting depth buffer is affected by quantization noise. To compensate for this, an
epsilon term is used as a tolerance for the depth comparisons. For each depth point, the epsilon
formula (known as polygon offset) is: ShadowScale∙Depth + ShadowBias. If some random black
points are visible when casting the shadows, try to increase the scale and bias, but pay attention that
excessive values produce less shadows.
Shadow bias: additive term for polygon offset during the depth buffer generation (default is 16)
Shadow scale: multiplicative factor for polygon offset during the depth buffer generation (default is
2.5)
Shadow width/height: size of depth buffer used to compute the occlusions from the view point of
the projector. It's recommended to use at least the same size of the projected image, displayed in
the tooltip of the projector.

Triangle Meshes
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A triangle mesh is a 3D model represented by a set of triangles connected by common edges and
common vertices. If a point cloud includes a set of points, a mesh includes more information
because it stores how the points are connected.
A triangle mesh therefore defines a surface in the 3D space. The mesh's edges that are owned by
only one triangle are called mesh borders. A mesh is called closed if there are no borders. A mesh is
called manifold if all its edges are shared by at most two triangles, and a mesh is called non-
manifold if there are edges that belong to three or more triangles. A mesh is called watertight if it
has no holes, or if its borders are only one closed outer polygon.
To each vertex of the mesh, a color can be associated. Each mesh's triangle is rendered with a
gradient of the three colors of its vertices. The rendering color may depend also on the triangle's
inclination with respect to the light source.
Reconstructor® has various techniques for generating and editing meshes. Each triangle mesh item
can contain more than one submesh.

Actions available from meshes' context menu
 Meshing->Compute normals: computes or updates the triangles' normals for the mesh.
 Meshing->Invert winding: inverts the ordering of the vertexes for each triangle, so the

surface is flipped to the opposite side and also the normals are inverted.
 Meshing->Compute area: r eturns the mesh area as sum of the areas of all the mesh's

triangles.
 Meshing->Compute volume from Z=0 plane: returns the volume resulting from

integrating the mesh on the XY plane of the current UCS. Mesh triangles below the XY
plane will result in zero volume.

 Meshing->Get mesh borders as polyline: creates a new polyline containing the mesh's
borders, and adds it to the project. 

 Meshing->Make single mesh: to cluster in a single mesh an arbitrary set of triangle
meshes.

 Meshing->Convert to point cloud: create an unstructured point cloud from the vertexes
of the mesh using the color attribute of the mesh.
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 Meshing->Mesh editor: opens the mesh editor dialog.
 Photo&Color->Sample texture at vertexes: sample the color of texture (if available) at

the vertexes of the mesh and store as the color attribute of the mesh.
 Photo&Color->Create texture map: compute a blended texture map for the mesh from

the projectors.

Meshes' editable properties

 Color ID: False color that you can activate with Screen settings -> Color by ID command
 Draw coordinate frame: if true, draw the local coordinate frame
 Point size: if draw geometry is set to points, they are draw with this size
 Draw texture: if available, the texture is loaded and rendered
 Draw light: if the normals are valid, the triangles are rendered with smooth shading
 Cull face: if true, the triangles are rendered only if the normal faces the view direction, and

backface triangles are hidden. If False both sides of the mesh are visible
 Draw geometry: select flat, wireframe (only edges), or only  vertexes (points) to display

them

Advanced Options
Triangle meshes data storage
Data is stored in an XML description file + pure binary vector files subdivided in folders for each
submesh. The file extension of the binary data specifies the format, where data.NT: N=num of
components (1,2,3,4…), T=data type (byte, short, word, half, float, double). If a mesh is called
myMesh, a typical way of storing it will use the following files in the project folder:

 Meshes/myMesh.rtm
 Meshes/myMesh_rtm/submesh/vertexes.3f
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 Meshes/myMesh_rtm/submesh/triangles.3i
 Meshes/myMesh_rtm/submesh/...


See also Meshing techniques and Mesh editing.

User Coordinate System (UCS)
User coordinate systems are a central concept in Reconstructor®. In the same project, many
coordinate systems can exist. An empty project contains at least a default UCS, called Main. 

To create a new UCS, you can click on any project item and select Create UCS from this pose. The new
UCS is added to the User Coordinate Systems group in the project window.

The current UCS
The Figures 1, 2 and 3 below show the same scene with three different UCS's set as current. The
current UCS is visible from the long coordinate axes (the red is the X axis, green is the Y, blue is the Z
axis).

Figure 1 Figure 2 Figure3

There is always one and only one current UCS. This is the UCS displayed in bold in the User
Coordinate Systems group in the project window. To change the current UCS, right-click on another
UCS and select set as current.
The current UCS is the current coordinate system for all the operations in Reconstructor®.
 Point coordinates in the Readout Window are displayed in the current UCS.
 Model position in the Adjust Pose window is displayed in the current UCS.
 Points in the Point List Window are displayed, imported and exported in the current UCS.
 All project data (point clouds, meshes, polylines, etc.) are imported interpreting their position in

the current UCS, and exported saving their position as in the current UCS.
 The pose matrix shown in the Pose Dialog is referred to the current UCS.
 The navigation system will perform “human” rotation movements assuming that the horizontal

plane is the XY plane of the current UCS (see the option Enable human movements while rotating
in Navigation Options for more information).

 Many Reconstructor® functions require a vertical direction and altitudes to be defined in your 3D
scene. Cut and fill calculation is an example of these functions. The general assumption in
Reconstructor® is that the current UCS's Z axis defines the vertical direction, and the altitudes
are the distances of project items from the Z=0 plane of the current UCS.

 The Create/Edit Plane command allows to make a plane horizontal or vertical. Horizontal and
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Vertical directions, again, are always defined by the current UCS.
 Etc.

Therefore, if the user changes the current UCS, all the above-mentioned windows and functions will
be affected in the way they visualize the coordinates or compute the models' positions.

UCS can be also created from the registration between two point lists.

You can change UCS dimension, open Display and navigation options -> Object reference frame size
[m] and insert the desired size.
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